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1 | introduction 

Congratulations on purchasing the Hewlett-Packard Jornada 920 series 
wireless digital assistant. The hp Jornada 920 series integrates the 
convenience of a phone and built-in wireless connectivity with the power of 
a Microsoft® Windows® powered PDA, providing everything you need to 
stay informed and in touch while you are on the go. 

PDA functions let you keep your most important business and personal 
information current and close at hand. Your hp Jornada includes Microsoft 
Pocket PC Software 2002 with phone, which includes the latest version of 
Microsoft Pocket Outlook®, so you can read and write e-mail while on the 
road and manage your appointments and contacts. You will find that your 
hp Jornada is also the perfect companion to your desktop or notebook PC, 
allowing you to take vital business data and documents with you and easily 
upload updated information upon returning to your desk.  

hp Jornada offers you the highest quality in performance and power 
management as well as rich programs and utilities designed by Hewlett-
Packard, making hp Jornada your powerful, reliable, mobile business 
partner. 

This chapter includes four sections: 

• welcome lists the hp Jornada package contents and provides an 
overview of this user’s guide with pointers to other sources of helpful 
information. 

• getting to know your hp Jornada introduces the preinstalled 
programs and the hardware features and lists some tips for caring for 
your hp Jornada.  

• using your hp Jornada for the first time provides instructions 
for setting up your hp Jornada, including installing a SIM card, 
installing the removable battery, and turning on the power. 

• managing power tells how to run your hp Jornada using batteries 
or ac power, tells how to charge the batteries, and offers tips for 
getting the longest use out of your batteries between charges.  
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welcome 
This section lists the contents of your hp Jornada package and provides an 
overview of this user’s guide with pointers to other sources of information, 
including online Help. 

what’s in the box 
Your hp Jornada package includes the following items:  

• hp Jornada 920 series wireless digital assistant (includes auto cover, 
stylus, and embedded battery) 

• removable battery 
• ac adapter  
• USB sync cradle for connecting your hp Jornada to your desktop PC 
• stereo headset with built-in microphone for hands-free use of the phone 
• hp Jornada Quick Start Card—a graphic guide to the features and set 

up of your hp Jornada 
• hp documentation pack—includes this user’s guide, a Regulatory 

Information Leaflet, and the hp Jornada Accessories Guide 
• Pocket PC Companion CD—includes Microsoft ActiveSync® and 

Microsoft Outlook for your desktop PC, as well as programs and 
utilities that add functionality to your hp Jornada  

 

using this guide 
This user’s guide is designed to help you get started using your hp Jornada 
quickly and easily. Although great care has been taken to ensure the 
accuracy of procedures and artwork, some of the screens displayed on 
your hp Jornada may be different from the ones that appear in this user’s 
guide.  

Detailed, step-by-step instructions for using the programs on your hp 
Jornada are also included in online Help, so you will always have access to 
them, and you do not have to carry this guide when you travel. (For more 
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information about using online Help, see “where to find information” later 
in this chapter.) 

This user’s guide includes certain visual cues that will help you find the 
information you want easily.  

 

A shortcut, another way to do something, or expanded information 
about the topic 

 

Caution or warning information about the topic. This is important 
information that should be observed to prevent loss of data or 
damage to your hp Jornada. 

 
Helpful information related to the topic 

 

where to find information 
The following table is a guide to additional information to help you use 
your hp Jornada.  
 
For information on See this source 

Programs on your hp Jornada This user’s guide or online Help. To 
view Help, tap Help on the Start 
menu. 

Additional programs that can 
be installed on your hp 
Jornada 

The Pocket PC Companion CD and the 
hp Web site at www.hp.com. 

Connecting to and synchro-
nizing with a desktop PC 

ActiveSync Help on your desktop PC.  
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For information on See this source 

GSM service or service 
providers 

www.gsmworld.com or your 
GSM/GPRS service provider's 
website. 

Last-minute updates and 
detailed technical information 

The Read Me files in the Microsoft 
ActiveSync folder on your desktop 
PC or the Pocket PC Companion CD, 
and the hp Jornada Web site at 
www.hp.com. 

Troubleshooting connections 

 

The ActiveSync Troubleshooter on your 
desktop PC. On the ActiveSync File 
menu, click Connection Settings, 
and then click Help.  

The latest on Windows–
Powered Pocket PCs  

The Microsoft Mobile Devices Web 
site: 
www.microsoft.com/mobile/pocketpc 

 

You can get help for specific programs and for Microsoft Pocket PC 
software by tapping Help on the Start menu. Help is displayed for the 
active program. To display a menu of all Help files available on your hp 
Jornada, tap the View menu, and then tap All Installed Help, or simply 
tap Help while the Today screen is active.  

Navigate in Help just as you navigate in Microsoft Internet Explorer: by 
tapping links or tapping the  button. When you have finished viewing 
Help, tap  to return to the program you were using. 

 

 

The complete text of this user’s guide is also available on the hp Web site at 
www.hp.com. You can download the user’s guide to your desktop PC and view 
it using the Adobe® Acrobat® Reader, available from the Adobe Web site at 
www.adobe.com. 
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getting to know your hp Jornada 
This section introduces the preinstalled programs and hardware features 
that are included with your hp Jornada. Wireless phone and Internet 
features require separately purchased service contracts; connect-time 
charges may apply. Check with the service provider for availability in your 
area. Some Web site content may be unavailable.  

programs 
Your hp Jornada already includes the full suite of software you need to 
function as a mobile professional. These programs are introduced below. 
Detailed information can be found in online Help or in later chapters.  
 

 The programs listed below are preinstalled in flash ROM. These preinstalled 
programs will not be deleted if your hp Jornada loses power.  
 

hp applications  
 hp backup. Protect your valuable data even when you are away from 

your office by backing up your personal information manager (PIM) 
databases (Contacts, Calendar, and Tasks) or your entire hp Jornada to 
an optional CompactFlash card. 

 

 hp display profile. Use a pop-up menu to apply one of four profiles 
for screen brightness and backlight options.  

 hp home menu. Quickly launch your favorite programs or open 
frequently used documents. Assign each of the buttons on the hp home 
menu to a different document or program. 

 

 hp image viewer. View individual images or run a slideshow on the 
screen of your hp Jornada.   

 hp month view. View, edit, or add appointments and events in a 
monthly calendar. You can also use hp month view to view a list of all 
recurring events, and to calculate the number of days between two dates. 
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hp pocket camera. 1 Use the optional hp pocket camera to snap 
pictures with your hp Jornada.     

 

 

hp pocket keyboard.1 The hp pocket keyboard application allows 
you to set options for using an optional hp pocket keyboard accessory. 

 

 

hp quick menu. Use a pop-up menu to turn the display off, change the 
phone usage settings mode, or start the Align Screen program. 

 

 
hp task switcher. Switch between open programs and documents, or 
close any program from a pop-up menu. 

 

 

hp alert profile. Use a pop-up menu to apply one of four profiles for 
speaker volume, system sounds, and phone ringing options. 

 

 

hp MicroChaiVM.  An embedded virtual machine for intelligent 
devices, hp MicroChaiVM enables your hp Jornada to download and run 
MIDP Java applications (MIDlets), such as games and messaging 
utilities offered by your GSM/GPRS service provider. 

 

 

hp profiles. Use this convenient application to set all options for power 
management, PDA volume and alerts, phone ringing, and display 
brightness. Apply one of the preset profiles, or configure the profiles to 
suit your work environment.  

 

W 

phone display. Use hp phone display to set options for displaying 
information on the phone display when the phone is not in use. 

 

 

GPRS.2 If you subscribe to GPRS (general packet radio service) through 
your GSM/GPRS service provider, use the hp GPRS program to view 
usage statistics and to set options for how your device attaches to the 
GPRS network. 

 

                                                      
1 For more information, see the hp Jornada Accessory Guide. 
2 Wireless phone and internet features require separately purchased service 
contracts; connect-time charges may apply. Check with the service provider for 
availability in your area. Some web site content may be unavailable.  



chapter 1 | introduction | 7 
 

 

 Cell Broadcast.1 If you subscribe to a cell broadcast service through 
your GSM/GPRS service provide, use the Cell Broadcast application to 
receive text-based information, such as news, stock updates, and weather 
reports over your phone network. 

 

microsoft pocket pc software 
 ActiveSync. Synchronize information between your device and desktop 

computer.   

 Calendar. Keep track of your appointments and create meeting 
requests.  

 Contacts. Keep track of your friends and colleagues. 
 

 Inbox. Send and receive e-mail messages from your hp Jornada. 
 

 Notes. Create handwritten or typed notes, drawings, and recordings. 
 

 Pocket Excel. Create new workbooks or view and edit Excel 
workbooks created on your desktop PC.  

 Pocket Word. Create new documents or view and edit Word 
documents created on your desktop PC.  

 Tasks. Keep track of your to-do list. 
 

 Microsoft Pocket Internet Explorer.1 Browse the Web and view 
channels and subscription content.  

 MSN Messenger.1 Send and receive instant messages with your 
MSN® Messenger contacts.  

                                                      
1 Wireless phone and internet features require separately purchased service 
contracts; connect-time charges may apply. Check with the service provider for 
availability in your area. Some web site content may be unavailable.  



8 | hp Jornada 920 series wireless digital assistant user’s guide  
 

 

 Microsoft Windows Media Player for Pocket PC.1 Play audio 
and video clips on your hp Jornada. Windows Media™ Player lets you 
play songs and video files that have been recorded in the MP3, WMV, 
or WMA formats. 

 

 Microsoft Reader. Read electronic books on your hp Jornada.  

 

third-party software 
 

 

EZOS EzWAP 2.1. 2 Use the EzWAP browser to view internet sites that 
have been optimized for viewing on mobile devices using WML (wireless 
markup language) and WAP (wireless access protocol). 

 

 

Fonix Voice Dial. Use a voice-activated interface to access your 
contacts list and call your contacts using the phone features of your hp 
Jornada.  

 

 

Developer One CodeWallet Pro.  Store, organize, and retrieve 
personal information, such as passwords, credit card numbers, favorite 
URLs, and emergency phone numbers. 

 

 
 

The Pocket PC Companion CD included with your hp Jornada has 
additional programs for both your desktop PC and your hp Jornada.  
 

 
You can also install programs from a variety of sources, including the Internet. 
For more information, see “adding and removing programs,” in chapter 4.  

 

                                                      
1 Check the Microsoft Mobile Devices Web site for updates to Windows Media 
Player, including details on support for video file formats and streaming audio and 
video capabilities. 
2 Wireless phone and internet features require separately purchased service 
contracts; connect-time charges may apply. Check with the service provider for 
availability in your area. Some web site content may be unavailable.  



chapter 1 | introduction | 9 
 

 

hardware features 
The illustrations below introduce you to the various buttons, connectors, 
ports, and other features of your hp Jornada. 
 

1. Stereo headset jack. Connect a pair of 
stereo headphones or the hands-free 
phone headset. 

2. Infrared port. Beam files to other mobile 
devices. 

3. Earpiece. Functions as the phone 
earpiece when you are not using the 
headset.  

4. Antenna. Lift the antenna if necessary to 
improve phone reception. 

5. LED. Notifies you of scheduled 
appointments, alarms, and reminders, 
and indicates power status while 
recharging. 

6. Send button. Press to dial a call. Press 
and hold to start Fonix Voice Dial.   

7. Phone display. Displays the status of the 
phone, phone call, and SMS-related 
features.  

8. End button. Press and hold to turn phone 
functions on or off. When phone is on, 
press to end a call or to apply an alert 
profile. 

 
 

9. Ambient light sensor. Enables you to create a display profile that automatically turns the 
backlight on or off.  

10. Volume/scroll control. Adjust the talk volume while a call is connected, or scroll the 
phone display. 

11. Record button. Press and hold to record voice notes. Release to stop recording. 
12. Touch screen. Tap on-screen controls or buttons to select menu commands or input text. 
13. Navigation pad. Press to navigate through documents or select on-screen buttons and 

controls. 
14. hp hot keys. Press to launch an application or programmed function. 
15. Power button. Press to turn your hp Jornada on or off. Press and hold to turn the backlight 

on or off. 
16. Action button. Press to open the selected item. 
17. Speaker. Listen to music, or use your hp Jornada as a speakerphone. 
 

�
�
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18. Stylus. Use the stylus to 
navigate on the touch 
screen.  

19. Reset button. Press the 
reset button and restart 
your hp Jornada. 

20. CompactFlash Type I 
extended card slot. Add 
functionality with optional 
CompactFlash Type I or 
Type I extended 
accessories. 

21. Connector for external 
antenna 

22. Removable battery. 
Remove the battery to 
access the SIM card slot. 

 
23. Battery compartment door. Remove the door to remove or install the removable battery or 

a SIM card. 
24. Battery lock. Slide to lock , or unlock  to remove the battery.   
25. SIM card slot. Install an optional GSM SIM card to activate phone functions. 
26. DC jack. Connect to ac power to recharge the batteries. 
27. USB connector. Connect to your desktop PC using the supplied cradle, or an optional 

sync cable. 
28. Microphone. Record voice notes. 
 
 
The hardware buttons on your hp Jornada (that is, the buttons on the device 
itself, rather than buttons or icons that appear on the display) can each be 
used to perform several functions, such as turning on your hp Jornada or 
starting a particular program.  

The features associated with each button are described below. In addition, 
most buttons can be reassigned or configured to start a program that you 
designate. For more information, see “configuring hardware buttons” in 
chapter 4. 

 

�	
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LED 
The color and state (blinking or steady) of the LED have different meanings, 
depending on whether you are using the phone or PDA, and whether your 
hp Jornada is connected to ac power.  
 
• steady amber LED indicates that the PDA is recording a voice note, or 

that batteries are charging (when connected to ac power) 
• steady blue LED indicates that batteries are fully charged (when 

connected to ac power) 
• blinking blue LED indicates a PDA alarm or reminder. Blinking blue LED 

can also indicate a missed phone call, that the phone is in auto-
roaming mode, or that an SMS message has been received.  

 

Send button 
Press the Send button to  

• start to the Microsoft Phone application 
• answer an incoming call 
• dial the selected number 
 
When the auto cover is closed, you can also use the Send button to dial a 
number from your speed dial list or to review the lists of incoming and 
outgoing calls. For more information, see “making a call” in chapter 2. 
 

End button 
• press the End button to end a call. 
• press and hold the End button to turn the phone on or off.  
• you can also use the End button to apply a profile while the auto cover 

is closed and the phone is on. For more information, see “display and 
alert profiles” in chapter 4. 
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volume/scroll control 
• while in a call, press the volume/scroll control to adjust the phone 

volume.  
• while not in a call, if a list is shown in the phone display, press the 

volume/scroll control to scroll the list. 
 

record button 
• press and release the record button to launch Fonix Voice Dial. 
• press and hold the record button to turn on your hp Jornada and begin 

recording a voice note. If the speaker is not muted, a beep indicates 
that recording has started. 

• release the record button to stop recording. If the speaker is not muted, 
a double beep indicates that recording has stopped. 

 

 

If your hp Jornada is off, pressing the record button will turn it on. To avoid 
inadvertently turning on your hp Jornada, you can disable this feature. For more 
information, see “managing power” later in this chapter. 

 

 

hp hot keys 
The hp hot keys can be reprogrammed to perform different functions or to 
launch any program or document you want. The descriptions below refer to 
the default functions. For more information, see “configuring hardware 
buttons” in chapter 4. 
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  hp home menu hot key 
• press the hp home menu hot key to launch the hp home menu 

application. 
• press the hp home menu hot key a second time to display the next 

page of home menu buttons. 
• press and hold the hp home menu hot key to launch the hp quick 

menu pop-up menu. Use the hp quick menu to turn off the display, 
launch the Align Screen control panel, or to change the phone usage 
settings mode.  

 

  contacts hot key 
• press the Contacts hot key to launch the Pocket Outlook Contacts 

application. 
• press and hold the Contacts hot key to display the hp alert profile 

pop-up menu.  
• when working in Pocket Outlook Contacts, press the Contacts hot key 

to filter the contact list on category.  
 

  calendar hot key 
• press the Calendar hot key to launch the Pocket Outlook Calendar 

application. 
• when working in Pocket Outlook Calendar, press the Calendar hot key 

to change views (for example, to switch from Day view to Week view). 
• press and hold the Calendar hot key to display the hp display 

profile pop-up menu.  
 

  inbox hot key 
• press the Inbox hot key to launch the Pocket Outlook Inbox application. 
• press and hold the Inbox hot key to launch hp task switcher.  
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power button 
• press the power button to turn your hp Jornada on or off. 
• press and hold the power button to turn the backlight on or off. 
• if the display is off, press the power button to turn on the display.  
 

navigation pad and action button  
• press the navigation pad to scroll through a document or to highlight 

the next item in a list. 
• press the action button to select the highlighted item. The actions vary 

depending on the active program and the item selected. 

removing and replacing the auto cover 
You can remove the auto cover from your hp Jornada. 

To remove the auto cover 

1. Open the auto cover to the fully open position (about 120°) 
2. Gently pull one side away from the hp Jornada until it pops free. 
3. Pull the other side free. 

 

To replace the auto cover 

1. Align the auto cover with the hinges on the hp Jornada. Note that 
the T-shaped extrusions on the cover must align with the T-shaped 
impression on the hinges, as shown in the diagram below. 

2. Fit one side of the cover into the hinge, and then fit the other side. 
  

 

If you have trouble aligning the cover properly, check to be sure that both 
hinges are aligned properly. The small arrow on each hinge should align with 
the small dot on the body of the hp Jornada. If the hinges are not aligned, use a 
blunt object, such as a small screwdriver to align the hinges. 
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If you frequently remove the auto cover, you may want to disable the auto cover 
functions that turn your hp Jornada on and off or switch between speakerphone 
and handheld mode. For more information, see Auto Cover Help on your hp 
Jornada. 
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caring for your hp Jornada 
When treated properly, your hp Jornada will be a reliable wireless digital 
assistant. Follow these tips to ensure long and trouble-free use of your hp 
Jornada: 

• protect the screen. Pressing too hard on the touch screen may 
damage the screen. To avoid scratching or damaging to the screen, 
use only the stylus to tap the hp Jornada screen, and replace the stylus 
if it becomes dull. To clean the screen, use a small amount of 
commercial glass cleaner sprayed on a soft, lint-free cloth. Avoid 
spraying the screen directly.  

 

 
You can purchase additional styli and screen protectors as optional accessories. 
For more information, see the hp Jornada Accessories Guide. 

 

 
• do not drop your hp Jornada. Dropping your hp Jornada can 

cause damage to delicate components such as the display. Accidental 
damage is not covered under the warranty.  

• do not extend the antenna beyond 90 degrees. 
• avoid radiated interference. Radiated interference from other 

electronic equipment may affect the appearance of the display of your 
hp Jornada. Removing the source of the interference will return the 
display to normal. 

• avoid high temperatures. Your hp Jornada is designed to operate 
at temperatures between 0 to 40 ºC (32 to 104 ºF). Subjecting the 
device to temperatures outside this range may damage the unit or result 
in loss of data. Be especially careful not to leave your hp Jornada in 
direct sunlight or in a car where temperatures can rise to harmful 
levels. 

• Register your hp Jornada. To receive updates on exclusive 
promotions, exciting new products, and accessories, register your hp 
Jornada at www.hp.com. 
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using your hp Jornada  
for the first time 
 

Follow these steps to begin using your hp Jornada: 
 
1. Install a SIM card. If you have an account with a GSM/GPRS 

service provider and you want to use the phone functions of your hp 
Jornada, install the SIM card (provided by your service provider), as 
shown in the diagram.  

 

�
�

�

 
 

1. Slide the lock on the SIM card slot to the left. 

2. Lift the SIM card slot. 

3. Insert the SIM card into the SIM card slot. 

4. Fold the SIM card slot down, and then slide the lock to the right. 
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2. Install the removable battery.  

 
 

1. Align the removable battery with the hp logo facing upwards. 
Hold the battery at a 30º degree angle relative to the connectors, 
and slide the battery into the battery compartment.  

2. Hold the battery compartment door at a 45º angle relative to the 
device, and slide the door into the bottom clasp before placing the 
door over the removable battery.  

3. Slide the battery lock to the locked position.   
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3. Connect to ac power. Connect the ac adapter to a wall socket, 
and then connect the other end to the dc jack on your hp Jornada.  

 
 

4.  Complete the Welcome Wizard. The first time you start your hp 
Jornada, the hp invent screen appears. Then, after a few moments, 
the Welcome Wizard begins. The Welcome Wizard presents a brief 
orientation to Microsoft Windows for Pocket PC, helps you align the 
touch screen, and prompts you to select your city and time zone.  
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managing power  
Because the data and files you save on your hp Jornada are stored in RAM 
(random access memory), maintaining a continuous power supply to the hp 
Jornada at all times is extremely important. If your hp Jornada runs out of 
power, all information stored in RAM is lost. The preinstalled programs will 
not be deleted even if your hp Jornada suffers a loss of power; however, 
any custom settings and programs you have added will be erased. 

This section describes  

• how to run your hp Jornada using the batteries or an ac power supply 
• how to turn the phone and PDA functions on and off 
• how to manage power to ensure you get the longest use of your hp 

Jornada between charges 
  

batteries 
Your hp Jornada includes two rechargeable lithium-polymer batteries. The 
removable battery can be removed to allow access to the SIM card slot. 
The embedded battery cannot be removed; it provides power when the 
removable battery is not present. 

How long you can operate your hp Jornada without recharging the 
batteries depends on the features and functions you use. If you use only the 
PDA functions (no phone functions, and without using the backlight), the 
batteries included with your hp Jornada will provide approximately 
12 hours of use. If you use your hp Jornada only as a phone, the batteries 
will provide approximately 150–210 minutes of talk time or 120 hours of 
standby time. Note that some functions, such as listening to music, using the 
backlight, or using phone functions, use considerable power and may 
reduce this time significantly. In addition, factors such as your distance from 
the transmitter and the configuration used by your GSM/GPRS service 
provider may affect battery life when you are using the phone. 
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battery status messages and warnings  
When your hp Jornada displays a dialog box warning of low power, you 
should respond as soon as possible by recharging the batteries. If you 
continue to use your hp Jornada until power reaches a critical low 
condition, a “Battery very low” message appears, and the hp Jornada shuts 
down automatically. You will be unable to use your hp Jornada until you 
connect to external power for charging.  

The following table lists all battery-related warning messages, and 
associated status icons. 
 
Message Meaning Icon 
Main Battery Low  To prevent possible data loss, replace or 

recharge the batteries. 
 

Battery Very Low Battery very low. Please close all applications 
and recharge your batteries immediately. 

 

Main Battery  
Very Low 

To prevent possible data loss, replace or 
recharge your batteries. (Your hp Jornada will 
shut down due to low battery power.) 

 

Embedded Battery 
Very Low 

Embedded battery very low. You may lose data 
if phone functions are turned on. 

 

Embedded Battery 
Empty 

Embedded battery empty. Please recharge 
immediately. To prevent data loss, do not take 
out the removable battery until the embedded 
battery is fully charged. 

 

Removable Battery 
Removed 

Phone functions disabled. Cannot detect 
removable battery in your hp Jornada. 

 

Removable Battery 
Empty 

Removable battery empty. Change to a charged 
battery if available. 

 

  

charging the batteries 

The batteries are charged whenever your hp Jornada is connected to an ac 
power source—either the ac adapter or the sync cradle. Connect your hp 
Jornada to ac power or place it in the cradle when it is not in use, to ensure 
that the batteries are fully charged when you need to take it with you. 
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Charging the batteries takes approximately three hours. When the batteries 
are fully charged, charging stops automatically; the batteries will not 
overcharge if left connected to ac power. 

ac power 
To avoid running out of battery power, you can operate your hp Jornada 
on ac power using the supplied ac adapter. The ac adapter accepts input 
voltages from 100 V to 240 V, enabling you to connect to ac power 
anywhere in the world. If you travel, you may need adapters to 
accommodate different electrical outlets, but the hp Jornada ac adapter will 
safely convert ac line voltage to the dc voltage required by your hp 
Jornada.  

While your hp Jornada is connected to ac power, the batteries are charged 
automatically. The color of the LED indicates the status of the batteries: 
amber indicates that the batteries are charging, and blue indicates that the 
batteries are fully charged. 
 

 

If you will not be using your hp Jornada for an extended period of time, be sure 
to charge the batteries fully (or connect to ac power) before you store your hp 
Jornada.  

 

 

turning your hp Jornada on and off 
The PDA and phone functions of your hp Jornada are powered separately. 
That is, you can turn on only the phone or the PDA, or both at the same 
time. 

turning on the pda  
One of the most convenient features of hp Jornada is “instant on.” With 
instant on, there is no waiting for your hp Jornada to start up or shut down; 
you can start working immediately simply by pressing the power button.  
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You can also turn on your hp Jornada by pressing one of the hp hot keys or 
opening the auto cover. Use the hp auto cover application or the Power 
preferences page of the hp profiles application to set these options.  

 

turning off the pda 
When you are finished working, turn off your hp Jornada by pressing the 
power button. You can use the Power preferences page of the hp profiles 
application to change these settings.  

Turning off the PDA does not turn off the phone. 

turning on phone functions 
You must turn on the phone before you can send or receive phone calls. In 
addition, you must have a subscription with a GSM/GPRS service provider, 
and you must install the SIM card provided by your service provider. For 
more information, see chapter 2. 

To turn on the phone  

• Press and hold the End (red) button.  
–or– 
In the Command bar, tap , and then tap Turn phone on. 

 

 

You may be required to enter a personal identification number (PIN) to unlock 
your SIM before you can turn on the phone. If your SIM is locked, you will see a 
message on the phone display indicating “SIM Locked,” and the touch screen 
will display a keypad. Tap the numbers on the touch screen to enter your PIN 
and unlock the SIM. 

 

 

turning off the phone  
You can turn off the phone and wireless data functions to conserve battery 
power; however, you will be unable to receive incoming phone calls or 
browse the Web when the phone is off.  
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To turn off phone functions 

• Press and hold the End (red) button.  
–or– 
 In the Command bar, tap , and then tap Turn phone off. 

  

managing power  
Use the hp profiles to set power options. Use the Power control panel to 
check the status of the batteries and the current power source.  

To check battery power 

1. On the Start menu, tap Settings.  
2. On the System tab, tap the Power icon.  

 
The remaining power is displayed on a status bar in the Power control 
panel. If you are running on battery power, the status bar shows the 
combined (average) state of the removable and embedded batteries. If the 
batteries are charging, the status bar indicates that the batteries are 
charging. The entries below the status bar indicate the status of the 
individual batteries, as a percentage of full power.  
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Under certain conditions, the Power Status icon is displayed on the Command 
bar in the Today screen. Simply tap the Power Status icon to launch the Power 
control panel.  

 

setting power preferences  
Use the Power preferences page of the hp profiles application to set options 
for turning your hp Jornada on and off, both for convenience and to 
conserve battery power. You can set your hp Jornada to turn on whenever 
you tap the touch screen or open the auto cover. Disabling the record 
button and the hp hot keys while the hp Jornada is off prevents you from 
inadvertently turning on your hp Jornada by pressing one of these buttons.  
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power management tips 
Follow these tips to ensure the longest use of your hp Jornada between 
charges: 

• turn off the backlight. Press and hold the power button to turn off 
the backlight, or use the Backlight control panel to set the backlight to 
turn off automatically after a short period of inactivity. 

• turn off the display manually. If you are playing music or using 
other functions that do not require the display, turn off the display. 
Press and hold the hp home menu hot key to display the hp quick 
menu, and then tap Turn display off. (Turn on the display by 
pressing the power button.)  
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• suspend frequently. Use the Power control panel to shorten the 
length of continuous idle time before your hp Jornada auto-suspends. 
Press the power button to turn off your hp Jornada when it is not in use, 
even for a short time. 

• always use ac power when connecting your hp Jornada to 
your desktop PC. Note that your hp Jornada will not auto-suspend 
while it is connected. 

• turn off sounds. Use the hp profiles application to mute the speaker, 
or use the Sounds & Notifications control panel to turn off all but the 
most necessary system sounds.  

• avoid using CompactFlash accessories while on battery 
power. Some CompactFlash accessories use considerable power and 
will quickly drain your batteries.  

• do not “listen” for infrared transfers. Although you can set 
your hp Jornada to constantly monitor the infrared port for files sent 
from other devices, doing so will quickly drain your batteries. 

 

 
Use the ac adapter to plug your hp Jornada into external power whenever 
possible, especially when connecting to a desktop PC. Do not let the LED blink 
for a long time.  

  





 
 

 

2 | phone functions 

Your hp Jornada 920 series wireless digital assistant includes an 
integrated GSM/GPRS phone. This chapter includes two sections: 

• getting started with phone and wireless data functions tells 
how to set up your hp Jornada to use wireless phone and data 
functions, and how to interpret the phone display 

• using the phone tells how to make and answer phone calls and 
how to customize phone settings   
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getting started with phone 
functions 
The phone and wireless data functions on your hp Jornada use the Global 
System for Mobile Communications (GSM) and general packet radio 
service (GPRS). The following sections will help you establish an account 
with a GSM/GPRS service provider, install the SIM card that stores your 
account information, and turn the phone on and off.  

setting up an account with a GSM/GPRS service 
provider 
To use the phone and wireless data features of your hp Jornada, you must 
establish a subscription with a GSM/GPRS service provider. The features 
available to you depend on the services offered by the service provider 
and the details of your subscription. 

GSM voice services enable you to use your hp Jornada as a phone. You 
can make and receive calls and SMS messages to a number assigned by 
your service provider.  

installing the sim card 
When you register for a new account, your GSM/GPRS service provider 
will provide you with a SIM (subscriber information module) card. The SIM 
card contains your phone number, information about services to which you 
have subscribed, and other information that identifies your hp Jornada to 
the mobile phone network.  

You can copy information stored on a SIM card to your hp Jornada (to 
Pocket Outlook Contacts), but you cannot copy information from your hp 
Jornada to a SIM card. For more information, see “managing phone 
numbers” under “phone tips and advanced features” later in this chapter. 

You must install a SIM card in your hp Jornada before you can make or 
receive phone calls or use wireless data services. For more information, 
see “using your hp Jornada for the first time” in chapter 1.   
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If you remove or replace the SIM card, it is recommended that you turn off 
the phone and PDA functions before removing the SIM card. 

To remove or replace the SIM card 

1. In the command bar, tap  to turn off the phone. 
2. Press the power button to turn off the PDA. 
3. Slide the battery lock to the unlocked position  and remove the 

battery cover.  
4. Remove the replaceable battery. 
5. Slide the lock on the SIM card slot to the unlocked position. 
6. Lift the SIM card slot. 
7. Remove the SIM card and/or insert the new SIM card in the SIM 

card slot. 
8. Fold the SIM card slot down, and then slide the lock to the locked 

position. 
9. Replace the battery and battery cover and slide the battery cover 

lock to the locked position .  
 

turning the phone on and off 
You turn the phone on or off independently of your PDA. The phone 
functions must be on for you to make or receive incoming calls.  

To turn on the phone functions 

• Press and hold the End (red) button.  
–or– 
In the Command bar, tap , and then tap Turn phone on. 

 
You can turn off the phone to conserve battery power; however, you 
cannot receive incoming phone calls or text messages when the phone is 
off.  

To turn off the phone  

• Press and hold the End (red) button.  
–or– 
In the Command bar, tap , and then tap Turn phone off. 
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Removing the removable battery from your hp Jornada turns off the phone.  

 

phone display and status icons 
When you turn on the phone functions, the phone display shows the SIM 
card status:  
 
Icon Meaning 

 

When you first turn on the phone, the display shows 
the hp logo while phone functions are initializing. 

 

The phone is searching for a network.  

 

The call is being connected. 

 

Your phone is receiving an incoming call.  

The phone cannot find a network carrier.  

The SIM card is missing or has not been installed 
properly, the SIM card may be faulty, or your phone 
has been configured by your service provider to work 
only with specific SIM cards. If your SIM card is 
installed properly and you still see this message, 
contact your GSM service provider. 
The SIM card may be password protected. You may 
need to enter a personal identification number (PIN) 
to unlock the SIM card before you can use the phone. 
For more information, contact your service provider or 
see “using your hp Jornada for the first time” in 
chapter 1.  
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Icon Meaning 

 

While the call is being dialed, the phone display 
indicates the number dialed. If you have Caller ID 
service, the phone display also shows the numbers of 
incoming calls. 

 

If a number you have dialed corresponds to an entry 
in your Contacts database, the display shows the 
name of the contact. If you have Caller ID service, the 
phone display also shows the names of incoming 
calls. 

 
The phone display indicates the status of the phone and any recent activity 
using icons or text, as shown below.  
 
Icon Meaning 

 icon changes to show signal strength 

 data connection established.  

 phone is dialing or in a call. 

 call divert on 

 new SMS message received 

 new voice mail message received 

 new voice mail and SMS messages received

 phone ring is muted 

 phone vibrate is on 

 icon changes to show battery strength 
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using the phone  
There are three ways to make a call using your hp Jornada: 

• hands-free. The stereo headset includes a built-in microphone for 
hands-free calling. Connect the headset to the headset jack on your hp 
Jornada. 

• handheld. Hold the earpiece to your ear, and speak into the 
microphone. By default, this method works with the auto cover closed. 
Use the auto cover control panel to change the default settings. 

• speakerphone. Use the speaker located at the bottom right corner 
of the device. By default, this method works with the auto cover open. 
Use the auto cover control panel to change the default settings. 

 
Use the hp quick menu to switch between handheld and speakerphone 
modes, or use the hp auto cover control panel to change modes 
automatically. 

While you are in a call, use the volume/scroll control on the side of your 
hp Jornada to adjust the talk volume of the headset, earpiece, or speaker. 
Use the hp profiles application to adjust the ring volume. 
 

 
The appendix includes important information on phone safety. Read the safety 
information carefully before using the phone.  
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1. Headset jack 

2. Earpiece 

3. Antenna 

4. Send button 

5. Phone display 

6. End button 

7. Volume/scroll 
control 

8. On-screen 
keypad 

9. Microphone 
  

 If phone reception is weak, lift the antenna to improve reception.  
 

  

making a call 
There are several methods you can use to dial an outgoing call. You can 
use the Microsoft Phone application to dial a call manually. You can also 
make a call by using numbers in your speed dial list, by using the Send 
button (with the auto cover closed), or by using voice commands.  

To dial a call using the phone application 

1. Install your SIM card and turn on the phone, as described in 
previous sections. 
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2. Connect the stereo phone headset to the headphone jack, and put 
on the headset. 

3. On the Start menu, tap Phone to start the Microsoft Phone 
application. 

4. On the keypad displayed on your hp Jornada screen, tap the 
number, and then tap Talk. 

5. Use the volume/scroll control to adjust the headset volume. 

6. When you have finished the call, press the red End button. 
 

 
To place an international call, tap and hold 0 on the on-screen key-pad until a 
+ appears.  

 

 

To make a call using speed dial 

• In the Microsoft Phone application, tap Speed Dial, and then 
tap the number of the speed dial entry you want to call. 
–or– 
On the on-screen keypad, tap and hold the keypad number that 
corresponds to the Speed Dial entry. (To dial a two-digit speed 
dial number, tap the first digit, and then tap and hold the second 
digit.) 

 

To make a call using the phone buttons 

1. On the Start menu, tap Settings, and then tap the Phone 
Display icon.  

2. On the Call list tab, select the list you want to access (speed dial, 
incoming calls, or outgoing calls). 

3. Tap OK to close the Phone Display application. 
4. With the auto cover closed, press the Send button. The phone 

display shows the first item in the selected list. 

5. Use the volume/scroll button to scroll through the list of numbers. 

6. Press Send to dial the number displayed in the phone display. 
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using fonix voice dial 
Fonix Voice Dial is a voice-activated interface that enables you to use your 
voice to access contacts and dial the phone. Voice Dial does not require 
you to pre-record the voice commands.  
 

 For best results, use the headset provided with your hp Jornada 920 series 
wireless digital assistant while using Fonix Voice Dial.   
 

To launch Fonix Voice Dial 

• Press and release the record button. 
–or– 
Press and hold the Send button. 

  

 You can change the button used to launch Fonix Voice Dial. For more 
information, see “configuring hardware buttons” in chapter 4.   
 
Fonix Voice Dial launches in listening mode. While in listening mode, 
Fonix Voice Dial monitors sounds for detectable speech, waiting for you to 
speak a command. The available voice commands are listed on the Voice 
Dial screen. 
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You can use Fonix Voice Dial to place a call by saying the number you 
want to dial or by saying the name of a contact.  

To place a call by a number 

1. Say “dial a number.” Fonix Voice Dial will ask, “What number 
would you like to dial?” and then a beep will sound. 

2. Say the number you want to dial, one digit at a time. Fonix Voice 
Dial will speak the number and ask you if the information is 
correct. 
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3. Say “yes,” to dial the number.  
–or– 
Say “no,” to cancel the call and return to listening mode.  

 

To place a call by name 

1. Say “call,” and then say the first and last name of the contact you 
want to call. Fonix Voice Dial will display the name and number 
of the contact and ask you if the information is correct.  

2. If you have more than one number saved with the contact, you 
can say the location at which you want to reach the contact (for 
example, “Call Mary Smith at work.”).  

3. If the information displayed is correct, say “yes,” to dial the 
number.  
–or– 
Say “no,” to cancel the call and return to listening mode.  

 
Fonix Voice Dial maintains a list of recognized names. To call a contact by 
name, the name must be in this list. The list is generated from your Pocket 
Outlook Contacts database. To be sure the Voice Dial list includes all your 
contacts, update the list after you make change or add a contact in Pocket 
Outlook.  

To update contact information 

• Say “update contacts.”  
 

To exit Fonix Voice Dial 

• Say “quit” or “cancel.” 
 
Fonix Voice Dial will also shut down automatically if a period of time 
passes without any noise. 

For more details on using Fonix Voice Dial, see the Pocket PC Companion 
CD. 
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answering an incoming call 
Your phone must be on to receive an incoming call. When an incoming 
call is received, your hp Jornada plays the ringing sound or vibrates 
according to the options you have set for your alert profile. The phone 
display shows the Incoming call message. If you have a caller ID service, 
the caller’s telephone number is displayed; if the number is in your Pocket 
Outlook Contacts database, the caller’s name is displayed.  

To answer an incoming call 

• In the Microsoft Phone application, tap Answer 
–or– 
Press the Send button on your hp Jornada. 

 
If the phone rings while you are using Windows Media Player to listen to 
music on the PDA, Windows Media Player will pause the music. Play will 
resume after you end the call, or if you cancel the call without answering. 
 

 

If you answer a call while you are connected to GPRS, GPRS will be 
disconnected. After you end the call, you will need to manually reconnect to 
GPRS. If you do not want to end your GPRS session, ignore the incoming call. 

 

 

 
If you answer a call while you are in a WAP session, the session will suspend. 
After you end the call, the WAP session will resume automatically.  

 

  

deferred answering and local voice mail 
When you do not want to answer an incoming call immediately, your hp 
Jornada provides two options for deferred answering. You can play a 
recorded message asking the caller to remain on hold until you answer, or 
you can play a greeting that asks the caller to record a local voice mail 
message on your hp Jornada. 

To use deferred answering 

1. Press and hold the Send button on your hp Jornada.  

2. Release the Send button to answer the call. 
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When you place the call on hold, the caller hears a pre-recorded message. 
Your hp Jornada includes a pre-recorded default message, but you can 
also create a custom message by recording a voice note.  

To use a custom message 

1. Record your message. For more information, see “recording a 
message” in chapter 4. 

2. On the Start menu, tap Settings, and then tap the Phone icon to 
open the Phone Settings control panel.  

3. On the Answer tab, under Deferred Answering, tap the ... 
button, and then browse to select the .wav file you recorded. 

 

To activate local voice mail 

1. On the Start menu, tap Settings, and then tap the Phone icon to 
open the Phone Settings control panel.  

2. On the Answer tab, under Local voice mail, select the if not 
answered in check box. 

3. From the drop-down list, select how long you want the phone to 
ring before it is routed to voice mail.  

 
Your hp Jornada includes a pre-recorded greeting asking callers to leave a 
message. You can also create a custom greeting by recording a voice 
note.  

To use a custom voice mail greeting 

1. Record your message. For more information, see “recording a 
message” in chapter 4. 

2. On the Start menu, tap Settings, and then tap the Phone icon to 
open the Phone Settings control panel.  

3. On the Answer tab, under play this greeting, tap the ... 
button, and then browse to select the .wav file you recorded. 

 
After a voice mail message has been received, you will see the  in the 
Command bar. Voice mail messages are stored as wav files, named 
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VoiceMsgX.wav. You can listen to voice mail messages using the Pocket 
Outlook Notes application.  

To listen to local voice mail 

1. Tap the voice mail icon in the Command bar. A message appears 
stating that you have new voice mail.  

2. On the message that appears, tap Launch Notes. The Pocket 
Outlook Notes application starts. 

3. In Pocket Outlook Notes, tap the file that corresponds to the 
message.  

 
For information on SMS messages, see “sending and receiving e-mail and 
sms messages” in chapter 3. 

phone tips and advanced features 
Depending on the services offered by your GSM/GPRS service provider 
and the services you subscribe to, there are many advanced features of the 
phone you can use. Your phone supports features such as speed dial, call 
logs, ringing tones, caller ID, call forwarding, and others.  

using hp dialer 
hp Dialer enables you to dial the phone using the input panel, so you can 
make a call while another program or other information is displayed. 

To display hp Dialer 

1. Tap the arrow next to the input panel button on the Command 
bar.  

2. On the pop-up menu, tap hp Dialer. 
3. On the Command bar, tap the input panel button.  
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 To dial a "+" symbol, tap and hold 0 on the on-screen keypad until a + 
appears.   
 

managing phone numbers  
Your hp Jornada offers several ways to keep track of phone numbers. You 
can keep track of names and phone numbers using Pocket Outlook 
Contacts, and synchronize the list with your desktop PC. You can also 
create “speed dial” entries for the numbers you call most.  

You can also copy phone numbers that are stored on a SIM card to your 
Pocket Outlook Contacts. 

To copy phone numbers from a SIM card 

• On the Start menu, tap Programs, and then tap the SIM 
Contacts icon.  

 

dialing from Pocket Outlook 
You can dial a call directly from the Pocket Outlook Contacts list. For more 
information on creating entries in Contacts, see “Contacts: tracking friends 
and colleagues” in chapter 5. 
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To dial from Contacts 

1. In the Contact list, tap and hold the contact you want to call. 

2. On the pop-up menu, tap Call, and then tap the phone number 
displayed (for example, the contact’s work or home telephone 
number).  

 

using speed dial 
Speed dial allows you to store frequently dialed numbers for easy access. 

To create a speed dial entry �
��

�

1. In the Microsoft Phone application, tap Speed Dial. 

2. Tap New. Your Contacts list is displayed. 
3. Tap the contact you wish to add.  

4. Use the arrow buttons to select an available location.  
  

To delete a speed dial entry 

• Tap and hold the contact in the box to the right of the speed dial 
number, and then tap Delete on the pop-up menu. 

managing calls using the call log �
The Microsoft Phone application keeps track of calls you make, receive, or 
miss in the Call Log. The Call Log can also tell you when a call was 
initiated, how long it lasted, and provides easy access to any notes taken 
during the call. 

To access the call log 

• In the Microsoft Phone application, tap Call Log. 
 
The call log offers five views:  

• All Calls shows all calls made to and from the phone in 
chronological order.  

• Missed lists only calls that were not answered.  

• Outgoing only shows calls made from your phone.  
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• Incoming only shows calls made to your phone.  

• By Caller is categorized alphabetically according to caller.  
 
You can view information about your calls, for example, to track the 
number of minutes used in the current month. Options include– 

• show total time statistics  

• show total number of calls and total time since last time the call log 
was reset.  

• delete items older than a specified period of time.  
 

 Tap within the white area of a call log entry to display a tool tip showing the 
date, time, and duration of a call.   
 

 
If you use the phone while driving, it is recommended that you use the headset 
to allow hands-free operation. Some countries have laws that forbid using a 
mobile phone without a hands-free headset while driving.   

 

changing services settings  
The services settings allow you to access and configure any of the 
following services. The services you have depend on the services offered 
by your GSM/GPRS service provider and your subscription.  

To configure a service 

• Select the service, and then tap the Get Settings button to 
configure.  

 
The following services may be available: 

• caller ID. Allows you to choose whether you want your identity 
revealed to those you call.  

• call forwarding. Allows you to forward incoming calls to 
designated numbers either as a whole (all incoming calls) or you can 
choose to forward calls only if you are unavailable, busy, and/or you 
do not answer.  

• call waiting. Allows you to enable or disable call waiting.  
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• voice mail and SMS. Allows you to enter your voice mail access 
number and SMS service center number.  

• call barring. To bar outgoing calls from your hp Jornada, dial *33* 
[Password] #, and then press the Send button. Your GSM service 
provider will provide your password. To deactivate call barring, dial 
#33*[password]#, and then press the Send button. To check the 
status of call barring, dial *#33#, and then press the Send button. 

change phone settings �
To adjust your phone settings, tap Options on the Tools menu.  

• Ring Type & Ring Tone. These controls determine how your hp 
Jornada notifies you of an incoming phone call. You can choose from 
various ring tones, vibration, or a combination of ring and vibrate.  

 

 
 

 
To change ring volume for phone, use the Alert page of the hp profiles 
application. On the Start menu, tap Settings, and then tap hp profiles.  
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• Keypad. This option controls whether tones are played while using 
the dialer. If set to Tones, the tone is heard continuously for as long as 
the dialer button is depressed. If set to Beep, the tone is played only 
for a moment.  

• Other Settings. This will navigate to the Sounds and Reminders 
control panel, which allows you to set phone and system sounds.  

• Require PIN when phone is used. This checkbox enables you to 
prevent unauthorized use of your phone by locking your SIM card 
using a four-to-eight-digit PIN.  

• Change PIN. Tap to change your PIN, which must be between four 
and eight digits.  

adjust network settings  
You can specify how your phone chooses a wireless network, as there may 
be more than one network available. The selection you make remains 
active until you change it or change your SIM card. The availability of 
Network Settings may depend on the GSM features and services enabled 
by your GSM/GPRS service provider.  

• Current Network. Displays the current registered network. Tap 
Find Network to refresh your current connection.  

• Network Selection. You can choose to have your network selected 
automatically (your hp Jornada decides on the most appropriate 
network) or manually (your hp Jornada lists all available systems, and 
you select the network you want to use from the list). 

• Set Preferred Networks. Tap Set Preferred Networks to 
select your preferred network operator for voice and data use. 
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locking your hp Jornada remotely 
If you have set a password on your hp Jornada, a security feature enables 
you to remotely lock your hp Jornada by sending a special SMS message. 
This can be useful if you have lost your hp Jornada or if it contains 
sensitive information. When you find your hp Jornada, you can unlock the 
device by entering the preset password. 
 

 

You must have pre-set either a simple 4-digit password or a strong 
alphanumeric password with timeout feature. For more information on setting a 
password, see Settings Help on your hp Jornada. 

 

 

To remotely lock your hp Jornada using SMS 

• Send the following SMS message to the hp Jornada:  
HPREMOTELOCK:[password] 
For example, if the password is 1234, send the message: 
HPREMOTELOCK:1234 
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personalize the phone display 
Use the Phone Display application to personalize the information shown in 
the phone display. You can use the phone display to display a clock, a 
custom text message or a graphic that you choose.  

To open the Phone Display application 

• On the Start menu, tap Settings, and the tap the Phone Display 
icon. 

 
You can choose to display the name of your GSM network, a clock, your 
next appointment, or a custom text message or bitmap image. 

 

���������
�
�����	����������
������	�������������	��
���

�����������������������������
���������	�������������	��
���

   





 
 

 

3 | getting connected 

To get the most from your hp Jornada, you will want to get connect—to 
your desktop or notebook PC, as well as to the Internet or a corporate 
network. Your hp Jornada comes with everything you need to get 
connected, including a USB cradle and software for your desktop PC and 
built-in wireless connectivity for the Web or network. Using the wireless 
data functions of your hp Jornada, you can connect to the Internet and 
access a variety of wireless data services, such as email, wireless internet 
(Web/WAP), Short Message Service (SMS) and wireless access to a 
corporate network.   

This chapter includes seven sections: 

• connecting to your desktop pc describes how to connect to the 
desktop pc, so you can synchronize information on your hp Jornada 
with another computer. 

• wireless data services describes the text messaging and other 
wireless services, such as such as SMS, cell broadcast, and GPRS, that 
are available on your hp Jornada.  

• connecting to the internet or a network describes how to 
establish a network or Internet connection using the built-in wireless 
data functions.  

• browsing the web tells how to use Pocket Internet Explorer to 
browse the Web or a corporate network, and create mobile favorites 
for offline browsing. 

• sending and receiving e-mail tells how to send and receive e-
mail messages using Pocket Outlook Inbox.  

• hp MicroChaiVM includes instructions for using the hp 
MicroChaiVM virtual machine to download and run MIDP Java 
applications (MIDlets), such as games and messaging utilities offered 
by your GSM/GPRS service provider. 

• EzWAP tells how to browse WML sites using the EzWAP browser. 
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connecting to your desktop pc 
This section describes how to establish the connection between your hp 
Jornada and your desktop PC, and how to synchronize and transfer files 
between your hp Jornada and your desktop (or any PC that has Microsoft 
ActiveSync installed). In this section, you will learn to 

• install Microsoft ActiveSync on your desktop PC. 
• use ActiveSync to synchronize data between your hp Jornada and 

desktop PC. 
• connect your hp Jornada to your desktop PC using either the USB 

cradle or the infrared port.  

Microsoft ActiveSync  
Microsoft ActiveSync enables you to synchronize the information on your 
desktop PC with the information on your hp Jornada. In addition, you can 
back up data from your hp Jornada to your desktop PC and restore this 
data to your hp Jornada, and copy files between your hp Jornada and 
desktop PC.  

Before you begin synchronization, install ActiveSync on your desktop PC 
from the Pocket PC Companion CD. ActiveSync is already installed on 
your hp Jornada. 

After installation is complete, the ActiveSync Setup Wizard helps you 
connect your hp Jornada to your desktop PC, set up a partnership so you 
can synchronize information between your hp Jornada and your desktop 
computer, and customize your synchronization settings. Your first 
synchronization process will begin automatically when you finish using the 
wizard. 

synchronizing data 
Synchronization compares the data on your hp Jornada with your desktop 
PC and updates both computers with the most recent information. For 
example, you can 

• synchronize Microsoft Word and Microsoft Excel files between your 
hp Jornada and desktop PC. Your files are automatically converted to 
the correct format.  
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• synchronize e-mail messages in your hp Jornada Inbox with e-mail 
messages in Microsoft Outlook on your desktop PC. 

• copy favorite Web site addresses and any Web pages you have 
marked for offline viewing in Microsoft Internet Explorer to your hp 
Jornada.  

• keep your Pocket Outlook Contacts, Calendar, and Tasks databases 
up-to-date by synchronizing your hp Jornada with Microsoft Outlook 
data on your desktop PC.  

 

 Synchronization with Microsoft Outlook 2002 requires ActiveSync 3.5 on the 
desktop PC.   
 
After you synchronize, the information you have stored on your desktop PC 
is copied to your hp Jornada so you can take it with you when you go. Use 
ActiveSync options to select which information types are synchronized and 
to control how much data is synchronized. For example, if you choose to 
synchronize Calendar data, you can specify how many weeks of past 
appointments you want synchronized. By default, ActiveSync does not 
automatically synchronize all types of information. Use ActiveSync options 
to turn synchronization on and off for specific information types. 

After you have set up ActiveSync and completed the first synchronization, 
you can control when synchronization occurs by selecting a 
synchronization mode. For example, you can synchronize continually 
while your hp Jornada is in the cradle, or only when you choose the 
Synchronize command.  

To start synchronization from your hp Jornada 

1. Connect your hp Jornada to your desktop PC. For more 
information, see “connecting your hp Jornada,” below. 

2. On the Start menu, tap ActiveSync. 
3. Tap  to begin synchronization.  
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Tap to connect and synchronize.

View synchronization status.

Tap to synchronize via IR or
change synchronization settings.

View connection status.

Tap to stop synchronization.

 
For detailed instructions on setting ActiveSync options and using 
ActiveSync on your desktop PC, see ActiveSync Help on the desktop PC. 
For more information on using ActiveSync on your hp Jornada, see 
ActiveSync Help on your hp Jornada.  

synchronizing from a remote location 
You can also synchronize by dialing in to your desktop PC or connecting 
over a network. This can be useful if you need to synchronize files or PIM 
information while traveling. Before you leave, you must configure both 
your hp Jornada and your desktop PC. 

on your hp Jornada 

Create a partnership between your hp Jornada and the desktop PC using 
one of the direct connection methods (USB cradle or infrared connection) 
described in this chapter. You must also configure a connection on your hp 



chapter 3 | getting connected | 55 

 

 

Jornada, as described in “connecting to the internet or to a network“ later 
in this chapter. 

on your desktop PC 

Before you can synchronize remotely, the desktop PC or network server 
must be configured to allow your hp Jornada to connect. Depending on the 
version of Windows running on the desktop PC, you may need to install 
and configure Remote Access Services or Dial-Up Networking on the 
desktop PC.  

You must also ensure that ActiveSync is configured to allow a network 
connection. For more information, see ActiveSync Help on your desktop 
PC. 

Follow these steps to prepare your desktop PC before you leave: 

• if you are using a modem on your desktop PC, turn the modem on 
before you leave. 

• leave your desktop PC on, and be sure you logged on under the same 
user name that you used when you created the partnership. 

• ensure your PIM program and e-mail program (Microsoft Outlook or 
Microsoft Exchange) are running. 

 
If you receive an error message on your hp Jornada that states that an 
information type needs attention, or if unresolved items are reported after 
synchronization, you must synchronize directly with your desktop PC using 
the USB cradle, an infrared connection, or an optional serial cable. 

copying files between your hp Jornada  
and your desktop pc 
You can copy files between your hp Jornada and desktop PC by dragging 
icons to or from the Mobile Device window or by using the Cut, Copy, 
and Paste commands on the Edit menu.  

Files created on your desktop PC may need to be converted before you 
can use them on your hp Jornada, and files created on your hp Jornada 
may need to be converted before you can use them on your desktop PC. 
By default, ActiveSync automatically converts files to the appropriate type; 
however, you can choose not to convert files, or you can choose to specify 
the conversion for each type of file by changing options in ActiveSync.  
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backing up data with activesync 
To prevent loss of data, you should back up your hp Jornada frequently 
using either Microsoft ActiveSync or the hp backup application. When you 
back up your hp Jornada using ActiveSync, the backup file contains all the 
files, databases, PIM information, and RAM-based programs on your hp 
Jornada. The backup file is stored on your desktop PC.  
 

 

hp backup enables you to back up your PIM databases to an optional 
CompactFlash memory card. For more information on hp backup, see “backing 
up and restoring data” in chapter 4.  

 

 
If you have established a partnership between your hp Jornada and 
desktop PC, you can set ActiveSync to back up data automatically each 
time you connect. You can also back up your hp Jornada manually any 
time you want. ActiveSync lets you decide whether to back up all data 
each time, or only new and updated information.  

When you use the backup file to restore data to your hp Jornada, data on 
your hp Jornada is replaced with the data stored in the backup file. If you 
have created files on your hp Jornada since the last backup and do not 
want to delete these files during the restore process, move the files from 
your hp Jornada to your desktop PC before restoring data. You can restore 
data using ActiveSync or the hp backup application. 
 

 
Restoring data from ActiveSync replaces all data stored on your hp Jornada. 
Any data added after the backup file was created will be lost.  

 

 
For more information on backing up and restoring data using Microsoft 
ActiveSync, see ActiveSync Help on your desktop PC. 

connecting your hp Jornada 
You can connect your hp Jornada to a desktop computer in several ways: 

• using the USB cradle that is included with your hp Jornada. The USB 
cradle connects to a USB port on your desktop PC.  



chapter 3 | getting connected | 57 

 

 

• using the infrared port on your hp Jornada. You can connect your hp 
Jornada to an infrared-equipped desktop or notebook PC using the 
infrared port. Many notebook PCs have built-in infrared ports; 
however, you may need to purchase and install an infrared transmitter 
for your desktop PC. 

• over a network or dial-up connection. You can synchronize while 
connected to your desktop PC by a dial-up connection or over a local 
area network (LAN). 

• using a serial cable or cradle. If your desktop PC does not have a USB 
port or an infrared transmitter, or if your operating system does not 
support these connection methods, you can purchase an optional 
serial cable or serial cradle that enables you to connect your hp 
Jornada to a serial port. Instructions on establishing a serial 
connection are included with these accessories. Note that Windows 
95 and Windows NT® do not support USB or infrared connectivity. 

 

 Install ActiveSync on your desktop PC before connecting your hp Jornada by 
USB.   
 

connecting by usb cradle  
The USB cradle included with your hp Jornada provides a convenient way 
to connect to your desktop PC. In addition to enabling synchronization, the 
USB cradle charges the batteries on your hp Jornada. Keep your hp 
Jornada in the cradle when you are not carrying it with you, so it is always 
charged, synchronized, and ready to go. 
 

 
Do not shut down or restart your desktop PC while your hp Jornada is 
connected. Turn off your hp Jornada or remove it from the cradle before you 
shut down your desktop PC.  

  

 
Before you connect, be sure of the following: your desktop PC is on, you have 
installed ActiveSync on your desktop PC, and ActiveSync is configured to allow 
a USB connection.  
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To connect by USB cradle 

1. Connect the dc plug from the ac adapter to the dc jack on the 
cradle cable, and plug the ac adapter into a wall outlet.  

2. Connect the cable from the cradle to a USB port on your desktop 
PC. 

3. Slide your hp Jornada into the cradle. Your hp Jornada should 
start automatically and establish a connection to the desktop PC. 

 

 
Connecting to your PC 

 

 

When you remove your hp Jornada from the cradle, hold the cradle down with 
one hand, and gently lift the hp Jornada with the other to avoid putting stress on 
the connectors. 
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connecting by infrared 
The infrared port on your hp Jornada provides a convenient way to 
connect to an IrDA-equipped PC without using a cable or cradle. Many 
notebook computers have built-in infrared ports; however, you may need to 
install and configure an infrared port on a desktop PC. To install the port, 
follow the manufacturer’s instructions. More information about infrared 
drivers for Microsoft Windows is available on the Microsoft Mobile 
Devices Web site at www.microsoft.com/mobile/pocketpc. 

For complete instructions on connecting to your desktop PC by infrared, 
refer to ActiveSync Help on your desktop PC.  
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getting started with wireless data 
functions 
The wireless data functions on your hp Jornada use the Global System for 
Mobile Communications (GSM) and general packet radio service (GPRS). 
To use the wireless data features of your hp Jornada, you must establish a 
subscription with a GSM/GPRS service provider. The features available to 
you depend on the services offered by the service provider and the details 
of your subscription. 

Check with your GSM/GPRS service providers for a list of available 
wireless data services. Your service provider may charge additional fees 
for use of data services. Check with your service provider for more 
information on rates and availability of wireless data services with your 
subscription. 

Your hp Jornada supports the following wireless data services: 

• CBSMS (cell broadcast). Many GSM/GPRS service providers offer 
cell broadcast services, which transmit text-based information, such as 
news, stock updates, and weather reports to phones on their network.  

• GSM data transmission (circuit-switched data). GSM data 
services enable you to use the GSM component of your hp Jornada as 
a built-in modem. Connect to the Internet through an ISP or dial in to a 
corporate network to synchronize your hp Jornada, browse the Web, 
or send and receive e-mail.  

• GPRS data transmission. GPRS is a high-speed data-only service 
that enables you to transmit data over a mobile telephone network. 
Subscribing to a GPRS service allows you to transfer files, browse the 
Web, and receive streaming audio and video on your hp Jornada.  
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receiving cbsms messages 
Your hp Jornada is capable of receiving cell broadcast short message 
service (CBSMS) messages. CBSMS is a service provided by many mobile 
telephone service providers to transmit brief text messages to mobile 
phones on their system. Messages typically include general information 
such as news, financial data, and local weather reports. To receive 
CBSMS messages, you must have an account with a mobile telephone 
service provider that offers the CBSMS service.  

CBSMS messages are transmitted on channels. Each channel carries 
messages for a specific topic. Your hp Jornada will receive all channels 
broadcast by your service provider; you select which messages you want 
to receive on your hp Jornada by activating only the channels that interest 
you.  

If your service provider gave you a list of available channels and their ID 
numbers, you can activate channels by entering the ID numbers from this 
list. If you do not have a list of available channels, you will want to 
activate channel 000, which is the topic index. When the topic index is 
activated, your hp Jornada will receive a current list of channels. 

Many GSM/GPRS service providers broadcast SMS messages in more 
than one language. You can filter incoming messages by language, so you 
receive only messages in the language(s) you choose. Use the Cell 
Broadcast control panel to activate channels and to filter incoming 
messages based on language.  

To turn on CBSMS services 

1. On the Start menu, tap Settings. 

2. On the Connections tab, tap the Cell Broadcast icon.  

3. Next to Message reception, select On. 
 

To activate a channel (if you know the channel ID) 

1. On the Channels tab, tap Add Channel. 
2. In the Channel ID box, enter the ID number of the channel you 

want to subscribe to. In the Description box, enter a description 
of the channel content. 
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3. Select the Activate Channel check box. 

4. Tap OK to close the Cell Broadcast application.  
 
You may not receive messages right away; the frequency with which 
messages are transmitted depends on your mobile telephone service 
provider. 
 

 
Activate channel 000, topic index, to ensure you always have the current list of 
channels with you on your hp Jornada. 

 

 

To activate a channel from the topic list 

1. Tap the Index tab to see a list of available topics. 

2. Tap [+] next to a topic heading to see a lit of available channels 
for that topic.  

3. Tap a channel in the list to select it, and then tap Add Channel. 
 

 

If the topic index tab displays the “No topic index received” message, you must 
activate channel 000, or wait for the list to be transmitted by your GSM/GPRS 
service provider. 

 

 

To filter incoming messages 

• On the Language tab, select the check box next to the 
language(s) you want to receive.  
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connecting to the internet or to a 
network 
With built-in wireless connectivity, your hp Jornada enables you to connect 
to an Internet service provider (ISP) or to your corporate network, so you 
can access e-mail, browse the Internet, or retrieve files from a corporate 
network, whether you are at home or on the road. This section describes 

• the methods you can use to connect your hp Jornada to the Internet or 
to a network 

• the process of configuring your hp Jornada to connect to an ISP or 
network. 

 
Your hp Jornada gives you two options for connecting to an ISP or 
network. You can use the integrated GSM phone or subscribe to high-
speed GPRS services. Each of these methods requires that you have a 
subscription with a GSM/GPRS service provider or an ISP.  

connecting using the integrated GSM modem 
Your hp Jornada is capable of sending and receiving data via a mobile 
telephone network using the GSM protocol. If your GSM/GPRS service 
provider supports remote data connection, you can use the built-in phone 
functionality of your hp Jornada to connect to the Internet or to a remote 
computer. To send or receive data over a GSM network, you must have an 
account with a mobile telephone service provider that supports GSM data 
services, and the service provider must enable the data features on your 
account. The maximum data transfer rate of the GSM modem is 9.6 kbps.1 

Use a GSM modem connection to  

• send and receive e-mail messages by using Inbox. Before you can use 
Inbox, you need to provide the information it needs to communicate 
with the e-mail server. For specific instructions, see “connecting directly 
to an e-mail server,” later in this chapter. 

                                                      
1 Actual data transfer rates depend on the capabilities and services of the 
GSM/GPRS service provider and/or Internet service provider. Data transfer rates 
presented in this User’s Guide are theoretical maximums. 
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• synchronize data with a computer on the network. For more 
information, see ActiveSync Help on your desktop PC. 

 

configuring a GSM data connection (circuit-switched data) 
Before you can configure your hp Jornada to connect to a remote 
computer using the GSM modem, you must configure a connection. Ensure 
that you have a subscription to the circuit-switched data (CSD) network. 
Check with your service provider for details. You will need the following 
information:  

• the phone number or dial string of the ISP or remote computer  

• any port settings, TCP/IP settings, or the name of the Domain Name 
Server(s) (DNS), if required by the network you are connecting to 

• a user name and password provided by the ISP or account 
administrator 

 
In addition, you need an account with the ISP or corporate network you 
are connecting to, or access permission to dial in to a specific computer. 

If you plan to use the account to send or receive e-mail messages directly 
from your hp Jornada, you must also obtain the following information from 
your ISP or account administrator: 

• a user name and password for your e-mail account. (These may be 
different from the user name and password you use to connect.) 

• the name of the POP3 or IMAP4 server (for incoming messages). 
• the name of the SMTP server (for outgoing messages).  
 
Before you can connect to an ISP or dial in to a specific desktop PC, you 
must create a connection for that service on your hp Jornada. 
 

To configure your GSM connection (CSD) 

1. On the Start menu, tap Settings.  

2. On the Connections tab, tap the Connections icon.  

3. In the drop-down list, select New.  

4. Tap the Modem tab, and then tap New. 
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5. Enter a name for the connection. The name can be anything you 
want, but should be descriptive, for example “Office Dial-Up.” 

6. In the Select a modem list, tap Cellular Line.  

7. If your service provider or network administrator specified TCP/IP 
settings, port settings, or the IP addresses for your DNS servers, 
tap Advanced, and then enter this information on the 
appropriate tabs. Tap OK. 

8. Tap Next.  
9. Enter the phone number of the service or remote computer you are 

connecting to.  

10. Tap Finish.  
 

dialing a GSM connection  
Use Connection Manager to select the connection you want to use and to 
dial the connection.  

To dial a connection 

1. On the Start menu, tap Settings. 

2. On the Connections tab, tap the Connections icon. 

3. In the drop-down list, select the service that you want. 

4. Tap Connect.  
 

closing a GSM connection 
If you opened the connection from a program, such as Inbox or Pocket 
Internet Explorer, close that program first. Then, tap the Data Connection 
icon  in the Command bar of the Today screen, and then tap End.  
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connecting using GPRS 
Your hp Jornada is capable of receiving general packet radio services 
(GPRS), a high-speed data-only service that transmits data over a mobile 
telephone network. In addition, GPRS provides an “always on” 
connection.  

To use GPRS, you must have a subscription with a GSM service provider 
that supports GPRS, and the service provider must enable the GPRS 
features on your account.  

configuring a GPRS connection 
Before you can connect to a GPRS network, you must configure a 
connection. You will need the following information from your GPRS 
service provider:  

• the name of the Access Point Node (APN) used by your service.  

• the name of the Domain Name Server(s) (DNS), if required.  
 

To configure your GPRS connection 

1. On the Start menu, tap Settings.  

2. On the Connections tab, tap the Connections icon.  

3. In the drop-down list, tap New.  

4. Tap the Modem tab, and then tap New. 
5. Enter a name for the connection. The name can be anything you 

want, but should be descriptive, for example “My GPRS 
Connection.” 

6. In the Select a modem list, tap Cellular Line (GPRS).  
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 You do not need to make a selection under Baud rate. The baud rate is 
ignored when making a GPRS connection.  
 

7. If your GPRS service provider specified the IP addresses for your 
DNS servers, tap Advanced, and then tap the Name Servers 
tab. Select Use specific server addresses, and then enter the 
DNS addresses provided by your GPRS service provider. Tap 
OK. 

8. Tap Next.  

9. Under Access Point Name, enter the APN provided by your 
GPRS service provider.  

10. Tap Finish.  
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connecting to the GPRS network  
Use the hp GPRS application to set options for how your device attaches to 
the GPRS network. Your service provider can provide additional 
information on connecting to the Internet using GPRS. 

To start hp GPRS  

1. On the Start menu, tap Settings.  

2. On the System tab, tap hp GPRS. 

3. If you want your device to automatically attach and/or detach 
from the network, select the appropriate options under GPRS 
Settings. 

 
The GPRS application also displays the total number of bytes transferred 
and number of bytes transferred in the last context. Click Reset to reset the 
Total 

GPRS authentication  
You must choose the authentication method required to connect to your 
GPRS network. Check with your GPRS service provider to determine the 
authentication method used by your network. There are three methods 
available: 

• None - No authentication required 

• PAP- Password Authentication Protocol (PAP)  

• CHAP - Challenge Handshake Authentication Protocol (CHAP) 

get help on connecting 
More information on the procedures described here, as well as information 
on additional procedures, can be found in the following locations: 

• “sending and receiving e-mail,” later in this chapter 

• online Help on the your hp Jornada 

• ActiveSync Help on your desktop PC. 
 
For troubleshooting information, see the Pocket PC Web site at 
www.microsoft.com/mobile/pocketpc. 
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browsing the web (or a corporate 
intranet) 
After you are connected to an ISP or to a corporate network, you can 
browse the Internet or a corporate intranet. You can also use  Pocket 
Internet Explorer to browse Web content while you are not connected—by 
downloading mobile favorites and channels to your hp Jornada. 

using microsoft pocket internet explorer 
Use Microsoft Pocket Internet Explorer to view Web pages in either of 
these ways: 

• connect to an ISP or network and browse the Web. To do this, you’ll 
need to create the connection first, as described earlier in this chapter. 

• during synchronization with your desktop PC, download your favorite 
links and mobile favorites that are stored in the Mobile Favorites 
subfolder in Internet Explorer on the desktop PC. 

While you are connected to an ISP or network, you can also download 
files and programs from the Internet or intranet. 

To start Pocket Internet Explorer 

• On the Start menu, tap Internet Explorer. 
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The Pocket Internet Explorer home page 

To view mobile favorites and channels: 

1. Tap the Favorites button to display your list of favorites.  

2. In the list, tap the page you want to view.  
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You will see the page that was downloaded the last time you synchronized 
with your desktop PC. If the page is not on your hp Jornada, it will be 
dimmed in the Favorites list. You will need to synchronize with your 
desktop PC again to download the page to your hp Jornada or connect to 
the Internet to view the page. 

To browse the Internet 

1. Set up a connection to your ISP or corporate network as described 
earlier in this chapter. 

2. To connect and start browsing, do one of the following: 

• tap the Favorites button and then tap the favorite you want to 
view. 
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• tap View, and then tap Address Bar. In the address bar 
that appears at the top of the screen, enter the URL you want 
to visit and then tap Go. Tap the arrow to choose from 
previously entered addresses. 

 

the mobile favorites folder 
Only items stored in the Mobile Favorites subfolder in the Favorites folder 
in Internet Explorer on your desktop PC will be synchronized with your hp 
Jornada. This folder is created automatically when you install ActiveSync.  

favorite links 
During synchronization, the list of favorite links in the Mobile Favorites 
folder on your desktop PC is synchronized with Pocket Internet Explorer on 
your hp Jornada. Both computers are updated with changes made to either 
list each time you synchronize. Unless you mark the favorite link as a 
mobile favorite, only the link will be downloaded to your hp Jornada, and 
you must connect to your ISP or network to view the content. For more 
information on synchronization, see ActiveSync Help on your desktop PC. 

mobile favorites 
If you are using Microsoft Internet Explorer 5.0 or later on your desktop 
PC, you can download mobile favorites. Synchronizing mobile favorites 
downloads Web content to your hp Jornada so that you can view pages 
while you are not connected to your ISP or your desktop PC. 

Use the Internet Explorer 5.0 plug-in installed with ActiveSync to create 
mobile favorites quickly. 

To create a mobile favorite 

1. In Internet Explorer 5.0 on your desktop PC, click Tools, and then 
click Create Mobile Favorite. 

2. To change the link name, enter a new name in the Name box.  

3. Optionally, in Update, select a desired update schedule. 

4. Click OK. Internet Explorer downloads the latest version of the 
page to your desktop PC. 
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5. If you want to download the pages that are linked to the mobile 
favorite you just created, in Internet Explorer on the desktop PC, 
right-click the mobile favorite and then click Properties. On the 
Download tab, specify how many levels of links you want to 
download. To conserve memory on your hp Jornada, download 
only one level of links. 

6. Synchronize your hp Jornada and desktop PC. Mobile favorites 
that are stored in the Mobile Favorites folder in Internet Explorer 
5.0 are downloaded to your hp Jornada. 

 

 

If you do not specify an update schedule, you must manually download content 
to keep the information updated on your desktop PC and hp Jornada. Before 
synchronizing, in Internet Explorer on your desktop PC, click Synchronize on 
the Tools menu. You will see the last time content was downloaded to the 
desktop PC, and you can manually download content if needed. 

 

 

 
You can add a button to the Internet Explorer toolbar for creating mobile 
favorites. In Internet Explorer 5.0 on your desktop PC, click Toolbars on the 
View menu, and then click Customize.  

conserving memory 
Mobile favorites take up storage memory on your hp Jornada. Follow these 
tips to minimize the amount of memory used: 

• in the settings for the Favorites information type in ActiveSync options, 
turn off pictures and sounds or stop some mobile favorites from being 
downloaded to your hp Jornada. For more information, see 
ActiveSync Help. 

• limit the number of downloaded linked pages. In Internet Explorer on 
the desktop PC, right-click the mobile favorite you want to change, 
and then click Properties. On the Download tab, specify zero or 
one for the number of linked pages you want to download. 

using avantgo channels 
AvantGo is a free interactive service that gives you access to personalized 
content and thousands of popular Web sites. You subscribe to AvantGo 



74 | hp Jornada 920 series wireless digital assistant user’s guide  
 

 

channels directly from your hp Jornada. Then, you synchronize your hp 
Jornada with your desktop PC or connect to the Internet to download the 
content. For more information, visit the AvantGo Web site. 

To sign up for AvantGo  

1. In ActiveSync options on the desktop PC, turn on synchronization 
for the AvantGo information type. 

2. In Pocket Internet Explorer on your hp Jornada, tap the Favorites 
button to display your list of favorites. 

3. Tap the AvantGo Channels link. 

4. Tap the Activate button. 

5. Follow the directions on the screen. You will need to synchronize 
your hp Jornada with your desktop PC and then tap the My 
Channels button to complete the AvantGo setup. 

 
When synchronization is complete, tap the AvantGo Channels link in your 
list of favorites to see a few of the most popular channels. To add or 
remove channels, tap the Add or Remove link. 

sending and receiving e-mail and 
sms messages 
If you have an e-mail account with an ISP or on a corporate network, you 
can use Inbox to send and receive e-mail messages in two ways: 

• synchronize e-mail messages with Microsoft Exchange or Microsoft 
Outlook on your desktop PC. 

• send and receive e-mail messages by connecting directly to an e-mail 
server through an ISP or a network. 

synchronizing e-mail messages 
You can synchronize e-mail messages as part of the general 
synchronization process whenever you connect your hp Jornada to your 
desktop PC. First, you must enable Inbox synchronization in ActiveSync. 
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For information on enabling Inbox synchronization, see ActiveSync Help 
on the desktop PC. 

During synchronization, the following occurs: 

• messages are copied from the mail folders of Exchange or Outlook on 
your desktop PC to the ActiveSync folder in Inbox on your hp Jornada. 
By default, you will receive messages from the past 3 days only, the 
first 100 lines of each message, and file attachments of less than 
100 KB in size. 

• e-mail messages in the Outbox folder on your hp Jornada are 
transferred to Exchange or Outlook, and then sent from those 
programs. 

• e-mail messages in subfolders must be selected in ActiveSync on your 
desktop PC in order to be transferred. 

 

connecting directly to an e-mail server 
In addition to synchronizing e-mail messages with your desktop PC, you 
can send and receive e-mail messages by connecting to an e-mail server 
using GSM circuit-switched data (CSD).  

In addition to the creating a connection to a network or an ISP, you must 
set up an e-mail “service” in Inbox.  
 

 
The ISP or network must use a POP3 or IMAP4 e-mail server and an SMTP 
gateway.  
 

To set up an e-mail service 

• In Inbox, tap Services, and then tap New Service. Follow the 
directions in the New Service Wizard. 

 
You can use multiple e-mail services to receive your messages. For each e-
mail service you intend to use, first set up and name the e-mail service. If 
you use the same service to connect to different mailboxes, set up a 
separate service for each mailbox. 
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To connect to an e-mail service 

• In Inbox, tap Services, and then tap Connect. 
 
When you connect to the e-mail server, new messages are downloaded to 
the Inbox folder on your hp Jornada, messages in the Outbox folder are 
sent, and messages that have been deleted on the e-mail server are 
removed from the Inbox folder on your hp Jornada. 

Messages that you receive directly from an e-mail server are linked to your 
e-mail server rather than your desktop PC. When you delete a message on 
your hp Jornada, it is also deleted from the e-mail server the next time you 
connect based on the settings you selected in ActiveSync. 

You can work online or offline. When working online, you read and 
respond to messages while connected to the e-mail server. Messages are 
sent as soon as you tap Send, which saves space on your hp Jornada. 

When working offline, you should download new message headers or 
partial messages, and then you can disconnect from the e-mail server while 
you decide which messages to download completely. The next time you 
connect, Inbox downloads any messages you marked for retrieval and 
sends the messages in your Outbox folder. 

using the message list 
Messages you receive are displayed in the message list. By default, the 
most recently received messages are displayed first in the list. 
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When you receive a message, tap it to open it. Unread messages are 
displayed in bold. 
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When you connect to your e-mail server or synchronize with your desktop 
computer, by default, you will receive messages from the last five days 
only, the first 100 lines of each new message, and file attachments of less 
than 100 KB in size. The original messages remain on the e-mail server or 
your desktop PC. 

You can mark the messages that you want to retrieve in full during your 
next synchronization or e-mail server connection. In the message list, tap 
and hold the message you want to retrieve. On the pop-up menu, tap 
Mark for Download. The icons in the Inbox message list give you 
visual indications of message status. 
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You specify your downloading preferences when you set up the service or 
select your synchronization options. You can change them at any time: 

• change options for Inbox synchronization using ActiveSync options. 
For more information, see ActiveSync Help. 

• change options for direct e-mail server connections in Inbox on your 
hp Jornada. Tap Tools, and then tap Options. On the Service tab, 
tap the service you want to change. Tap and hold the service and 
select Delete to remove a service. 

composing messages 
You can use Inbox to compose both e-mail messages and SMS messages.  

To compose a message 

1. Tap New.  

2. In the To field, enter an e-mail or SMS address of one or more 
recipients—separating them with a semicolon, or select a name 
from the contact list by tapping the Address Book button. 
When you send SMS messages to contacts save in your Pocket 
Outlook Contacts database, be sure to use the number in the 
Mobile field. The contact must be selected (highlighted in blue) 
before it can be sent. 
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3. Compose your message. To enter preset or frequently used 
messages, tap My Text and select a message. 

4. If you are sending an SMS message and want to know if it was 
received, tap Edit, tap Options, and then select Request SMS 
text message delivery notification. 

5. Tap Send when you’ve finished the message. 
 
The message is placed in the Outbox folder on your hp Jornada and will 
be delivered in one of two ways: 
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• the message is transferred to the Outbox folder in Exchange or 
Outlook on your desktop PC and sent the next time you synchronize. 

• the message is transferred to your e-mail server the next time you 
connect. In Inbox, make sure the appropriate service is selected on the 
Services menu, and then tap the Connect button (or Connect on 
the Services menu). 

 

managing e-mail messages and folders 
By default, messages are displayed in one of five folders for each service 
you have created: Inbox, Deleted Items, Drafts, Outbox, and Sent Items. 
The Deleted Items folder contains messages that have been deleted on your 
hp Jornada. The behavior of the Deleted and Sent Items folders depends 
on the options you have chosen. In the message list, tap Tools, and then 
tap Options. On the Message tab, select your options. 

If you want to organize messages into additional folders, tap Tools, and 
then tap Manage Folders to create new folders. To move a message to 
another folder, in the message list, tap and hold the message and then tap 
Move to on the pop-up menu. 

The behavior of the folders you create depends on whether you are using 
ActiveSync, POP3, or IMAP4: 

• if you use ActiveSync, e-mail messages in the Inbox folder in Outlook 
will automatically be synchronized with your hp Jornada. You can 
select to synchronize additional folders by designating them for 
ActiveSync. The folders you create and the messages you move will 
then be mirrored on the server. For example, if you move two 
messages from the Inbox folder to a folder named Family, and you 
have designated Family for synchronization, the server creates a copy 
of the Family folder and copies the messages into that folder. You can 
then read the messages while away from your desktop computer. 
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• if you use POP3 and you move e-mail messages to a folder you 
created, the link is broken between the messages on the device and 
their copies on the mail server. The next time you connect, the mail 
server will see that the messages are missing from the device Inbox 
and delete them from the server. This prevents you from having 
duplicate copies of a message, but it also means that you will no 
longer have access to messages that you move to folders created from 
anywhere except the device.  

• if you use IMAP4, the folders you create and the e-mail messages you 
move are mirrored on the server. Therefore, messages are available to 
you any time you connect to your mail server, whether it is from your 
device or desktop computer. This synchronization of folders occurs 
whenever you connect to your mail server, create new folders, or 
rename/delete folders when connected. 
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hp MicroChaiVM 
hp MicroChaiVM, a small-footprint embedded virtual machine for running 
Java™ applications, allows you to extend the capabilities of your hp 
Jornada. In addition to running Microsoft Pocket PC applications, you can 
download on demand and run Java applications that are based on the 
Mobile Information Device Profile (MIDP) specification. You can download 
these applications via a GSM network or through a modem connection. 
With hp MicroChaiVM, your hp Jornada can now run many readily 
available MIDP applications, which are commonly referred to as MIDlets. 
 

 

A growing number of GSM service providers offer MIDP-based services. With 
hp MicroChaiVM, which complies with the public MIDP specification, you can 
take advantage of the mobile services, games, and messaging options offered 
by your service provider. 

 

 

To start hp MicroChaiVM 

1. On the Start menu, tap Programs. 
2. In the hp Applications folder, tap the hp MicroChaiVM icon. 

 

using hp MicroChaiVM 
The Application Manager screen, your interface with hp MicroChaiVM, 
has the following items in its menu bar: 

• Options enables you to view the version of hp MicroChaiVM that 
you are running and to customize hp MicroChaiVM by adjusting the 
settings of the virtual machine, HTTP proxy, and other display options. 

• Launch enables you to launch a MIDlet after it is installed. 
• Install enables you to install a MIDlet suite from a file system or from 

the Web. 
• Menu enables you to show, hide, and get information, and update or 

delete a MIDlet suite. 
 
Your hp Jornada includes a pre-installed a sample MIDlet for you to use as 
you explore the features of hp MicroChaiVM. 
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installing a MIDlet suite 
MIDP applications are packaged and distributed in MIDlet suites, which 
come in a standard format of a .jar file and a .jad file. Using hp 
MicroChaiVM, you can install a MIDlet suite from a file system or directly 
from the Web using HTTP. 
 

 

Installing a MIDlet suite is a two-step process. You first install the .jad file, which 
will automatically directs hp MicroChaiVM to the .jar file. You must install both 
the .jad and .jar files for the MIDlet to work. 

 

 

To install a MIDlet suite from a file system 

1. Transfer the .jad and .jar files for the desired MIDlet suite onto 
your hp Jornada. For example, use ActiveSync to place the files 
My Documents. For more information, see “connecting to your 
desktop pc” earlier in this chapter. 

 

 

If you install a MIDlet from a Compact Flash card, you must place the .jar and 
.jad files in the My Documents folder on the card. If necessary, create a My 
Documents folder on the Compact Flash card and place the .jar and .jad files 
in this folder or any of its subfolders. 

 

 
2. On the menu bar of the Application Manager screen, tap Install. 
3. On the Install Source screen, tap Select JAD file. 
4. Browse to select the .jad file for the MIDlet suite. 
5. If the Application Descriptor screen shows the MIDlet that you 

want to install, tap Yes. After a successful installation, a Success 
screen will be displayed. 

6. On the menu bar of the Success screen, tap Finish. The MIDlet 
will appear on the Application Manager screen. 

 

 

If you are using the File Explorer on your hp Jornada and find a JAD file with 
the hp MicroChaiVM icon, you can tap on the .jad file with the  icon to 
invoke hp MicroChaiVM and install the MIDlet suite. 
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To install a MIDlet suite from the Web 

1. Make sure your hp Jornada is connected to the Web. For more 
information, see “connecting to the internet or to a network” 
earlier in this chapter. 

2. If your device or desktop is behind a firewall, check that the HTTP 
proxy settings are correct. From the Application Manager screen 
menu bar, tap Options, and then select HTTP Proxy. 

3. In the menu bar of the Application Manager screen, tap Install. 
4. In the Install Source screen, tap Type URL. 
5. Use the soft keyboard to enter the URL of the MIDlet suite .jad file, 

and then tap Download. 
 

 
 

6. If the Application Descriptor screen shows the MIDlet that you 
want to download, tap Yes. After a successful download and 
installation, a Success screen will be displayed. 
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7. On the menu bar of the Success screen, tap Finish to complete 
the installation. The MIDlet will appear on the Application 
Manager screen. 

 

 

If you use Pocket Internet Explorer on your hp Jornada to browse a MIDlet Web 
site, you can simply click on a MIDlet’s .jad download link to invoke hp 
MicroChaiVM and install the MIDlet suite. 

 

 

troubleshooting wireless download errors 
If you are having problems downloading a MIDlet, the error may be due to 
the following: 

• GPRS connection not established. Make sure to have a GPRS 
connection before you begin downloading a MIDlet. 

• GPRS connection dropped. If you make a call while connected to 
GPRS, the connection is dropped when the other party answers the 
call. You must manually reconnect GPRS before downloading another 
MIDlet. 

For more information, see “connecting to the Internet or to a network” 
earlier in this chapter. 

To launch a MIDlet 

• In the hp MicroChaiVM Application Manager screen, tap the 
MIDlet you want to launch. 

 
If you tap and hold on the MIDlet, a pop-up menu will be displayed with 
the options to launch, delete, update, show suite information, and hide the 
highlighted MIDlet. 
 

 
If you are having problems launching a MIDlet, try adjusting the hp 
MicroChaiVM settings. Tap Options and select VM Settings. 
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To exit a MIDlet 

• In the MIDlet menu bar, tap Exit to return to the hp MicroChaiVM 
Application Manager screen. 
–or– 
If the MIDlet does not provide an Exit button, tap the vertical red 
bar to abort the MIDlet. 

 

To delete a MIDlet suite 

1. In the hp MicroChaiVM Application Manager screen, tap and 
hold on the MIDlet to be deleted. 

2. On the pop-up menu, tap Delete. The Delete MIDlet suite screen 
appears, displaying the information of the MIDlet that you want 
delete. 

3. If the information is correct, tap Yes. The Delete MIDlet suite 
screen appears, prompting you to confirm deletion of the MIDlet. 
–or– 
To cancel the deletion, tap Exit. 

4. In the Delete MIDlet suite screen, tap Yes if the information is 
correct. 
–or– 
tap Exit to cancel the deletion process.  

 
For detailed help and procedures about using hp MicroChaiVM, refer to 
online Help at http://devnet.hp.com. Information on how to download 
and install new versions of hp MicroChaiVM is available at the same 
location. 
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EzWAP 
The EzWAP application allows you to easily access mobile Internet 
information and services, connect to your Internet Service Provider (ISP), 
and browse Mobile Internet sites the same way you browse HTML sites 
using Pocket Internet Explorer. 

To start EzWAP 

• On the Start menu, tap Programs, and the tap the EzWAP 
icon. 

 
Before you can use EzWAP, you must configure your hp Jornada 
connection settings to enable communication with your GSM/GPRS service 
provider.  

To configure EzWAP 

1. In EzWAP, on the Tools menu, tap Options. 
2. Tap the General tab to edit the general settings: 
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• Under Connection, select the dial-up connection to be used. 
• If you want EzWAP to automatically activate the selected 

connection when needed, select the Connect automatically 
check box. 

• To change the default WML document that will load 
automatically as home page, enter a URL under Home 
page. 

3. Tap the Connection tab to select your connection type: 
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• If your mobile phone network operates a WAP gateway and 
you want to benefit from the additional services provided by 
your operator, select Gateway. For more information, 
consult your GSM/GPRS service provider.  

• For WAP gateway settings, enter the IP address of the 
gateway in the Address box. Enter the Port number in the 
Port box.  

• If the gateway works in connectionless mode, select the 
Connectionless gateway check box.  

• If the gateway uses the WTLS technology for enhanced 
security over the wireless network, select the WTLS secured 
connection check box. 

4. Under Timeouts, specify the Connection timeout in milliseconds 
and the number and timeout of connection retries. 

 
For information on advanced features, such as setting up a Proxy or Push, 
refer to the EzWAP user’s guide on the Pocket PC Companion CD. 



 
 

 

4 | getting started with  
pda functions  

This chapter will help you start using the PDA functions of your hp Jornada. 
The various sections cover the basics of working with documents and 
programs on your hp Jornada. This chapter also details ways you can 
optimize your hp Jornada using the Settings and the hp profiles application 
and describes ways you can expand features and functionality by adding 
programs and accessories. 

In this chapter you will learn to 

• navigate in Microsoft Windows for Pocket PC using the stylus. 
• use the Today screen to view your day at a glance. 
• switch programs using the Start menu, hp home menu, and hp task 

switcher. 
• enter information in a variety of ways. 
• find and organize information on your hp Jornada. 
• manage the memory on your hp Jornada. 
• configure display and alert profiles. 
• configure hardware buttons.  
• configure menus for easy access to programs and documents. 
• add or remove programs. 
• add functionality to your hp Jornada with optional accessories. 
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navigating in microsoft windows 
for pocket pc 
Your hp Jornada uses the Microsoft Windows for Pocket PC operating 
system. Navigating in Windows for Pocket PC is similar to navigating in 
Microsoft windows on your desktop PC, with features such as the Start 
menu, pop-up menus, and toolbars. 

using the stylus 
Use the stylus to navigate and select objects on the screen. 

• tap. Touch the screen once with the stylus to launch programs, open 
items, and select options. 

• drag. Hold the stylus on the screen and drag across the screen to 
select text and images. Drag in a list to select multiple items. 

• tap and hold. Tap and hold the stylus on an item to see a list of 
actions available for that item. On the pop-up menu that appears, tap 
the action you want to perform. 

aligning the touch screen 
 From time to time, you might notice that the accuracy of your stylus taps 
diminishes. When this happens, you can realign your touch screen using 
the Align Screen control panel.  

To launch the Align Screen control panel 

1. Press and hold the hp home menu hot key to display the hp quick 
menu.  

2. Using the navigation pad, highlight Align Screen on the hp 
quick menu, and then click the action button.  

3. Tap the targets as they appear at each new location to align the 
touch screen.  
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today screen 
When you turn on your hp Jornada for the first time each day (or after four 
hours of inactivity), you will see the Today screen. You can also display it 
by tapping  and then Today. On the Today screen, you can see at a 
glance important information for the day. 

 
 

 

 
You can customize the Today screen using themes, or display your own graphic 
as a background. For more information, tap Settings on the Start menu, and 
then tap Today.  
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switching programs 
Use the hp home menu application or the Start menu to quickly launch 
your favorite programs or open frequently used documents. You can also 
use hp task switcher to switch between running programs. 

To start or switch programs using the hp home menu 

1. Press the hp home menu hot key. 
2. Tap the button that corresponds to the program or document. 
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The hp home menu displays up to 10 pages of buttons and icons that 
represent the programs and documents on your hp Jornada. To change 
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pages, tap the name of a page in the drop-down list at the top of the hp 
home menu screen, or tap the arrows  or  to display the next or 
previous page.  
 

 The battery icon at the bottom of the hp home menu changes to indicate when 
power is low. Tap the icon to launch the Power control panel.  
 

To start or switch programs using the Start menu 

1. Tap  in the Navigation bar to display the Start menu. 
2. On the Start menu, tap the name of the program you want to 

switch to. 
–or– 
Tap one of the miniature icons at the top of the Start menu to 
switch to a recently used program. 

 

 
You can customize both the hp home menu and the Start menu to make it 
easier to access the programs you use most. For more information, see 
“configuring menus” later in this chapter.  

 

hp task switcher 
Use hp task switcher to switch to a program or to quickly close all running 
programs. hp task switcher offers two ways to display running programs: 
Icon pad mode displays running programs as icons on a pop-up menu (the 
Icon pad). Task bar menu mode lists running programs on a pop-up menu 
accessible from the Today screen. 

By default, hp task switcher is running in icon pad mode when you start 
your hp Jornada. You can also start hp task switcher by tapping the hp 
task switcher icon in the hp Applications folder. 

To switch between modes 

1. Start hp task switcher, and then tap About or tap the About hp 
task switcher icon. 

2. On the Settings tab, select either Icon Pad or Menu on task 
bar. If you select Icon Pad, set options for how long the Icon 
pad will be displayed. 
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When hp task switcher is running in Icon pad mode, the running programs 
are displayed as icons on a pop-up menu (the Icon pad).  
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The hp task switcher pop-up menu 

To display the hp task switcher icon pad 

• Press and hold the Inbox hot key. 
 to switch to a running program, tap the program icon on the 

icon pad. 
 to close a program, tap and hold the icon for the program 

you want to close, and then on the pop-up menu, tap Close. 
 to close all programs, tap the Close All icon on the icon pad. 

When hp task switcher is running in Task bar menu mode, the running 
programs are displayed in a list on a pop-up menu accessible from the 
Today screen.  

To display the hp task switcher pop-up menu  

1. On the Start menu, tap Today.  
2. Tap the hp task switcher icon in the Command bar.  

 switch to a running program by tapping the name of the 
program in the list.  

 close a single program by tapping Close Window, and 
then tapping the name of the program.  
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 close all programs by tapping Close Window, and then 
tapping Close All.  

 

 You cannot use hp task switcher to close phone applications.  
 

  

 
You can also use the navigation pad to select a program, and then the action 
button to switch to that program, or tap and hold the action button to close the 
program.  

 

navigation bar and command bar 
The Navigation bar is located at the top of the screen. It displays the active 
program and current time, and allows you to switch programs and close 
screens.  

Use the Command bar at the bottom of the screen to perform tasks in 
programs. The Command bar includes menu names, buttons, and the Input 
panel button. To create a new item in the current program, tap New. To 
see the name of a button, tap and hold the stylus on the button. Drag the 
stylus off the button so that the command is not carried out. 
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The Navigation bar and Start menu 

New button.

Menu
names.

Buttons.

Input panel button.

 
The Pocket PC Command bar 
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status icons 
When the Today screen is displayed, you may see status icons on the 
Command bar or Navigation bar. In most cases, you can tap a status icon 
to display the associated control panel or more information related to the 
item. For example, tap a battery status icon to launch the Power control 
panel.  
 

 
If there is not enough room to display all the status icons that need to be 
displayed, the Notification icon, , will appear. Tap the icon to view all status 
icons.  

pop-up menus 
With pop-up menus, you can quickly choose an action for an item. For 
example, you can use the pop-up menu in the Contact list to quickly delete 
a contact, make a copy of a contact, or send an e-mail message to a 
contact. The actions in the pop-up menus vary from program to program. 
To access a pop-up menu, tap and hold the stylus on the name of the item 
that you want to perform the action on. When the menu appears, lift the 
stylus, and tap the action you want to perform. Or tap anywhere outside 
the menu to close the menu without performing an action. 
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Tap and hold to display
the pop-up menu.

Lift the stylus and tap
the action you want.

Tap outside the menu
to close it without performing
an action.

 
 

alerts and notifications 
Your hp Jornada reminds you in a variety of ways when you have 
something to do. For example, if you have set up an appointment in 
Calendar, a task with a due date in Tasks, or an alarm in Clock, you will 
be notified in one or more of the following ways: 

• a message appears on the screen. 
• a sound, which you can specify, is played. 
• the blue LED blinks.  
• the device vibrates. 
 
Use hp profiles to choose reminder types and sounds for your hp Jornada. 
For more information, see “display and alert profiles” later in this chapter.  
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entering information  
You have several options for entering new information: 

• use the Input panel to enter typed text, either by using the soft 
keyboard or other input method. 

• write directly on the screen. 
• draw pictures on the screen. 
• speak into the microphone to record a message. 
 

entering text using the input panel  
Use the Input panel to enter information in any program on your hp 
Jornada. You can either type using the soft keyboard or write using the soft 
keyboard, Block Recognizer, Letter Recognizer, or Transcriber. In any 
case, the characters appear as typed text on the screen.  

To show or hide the Input panel, tap the Input panel button. Tap the arrow 
next to the Input panel button to see your choices. 

 
 

When you use the Input panel, your hp Jornada anticipates the word you 
are typing or writing and displays it above the Input panel. When you tap 
the displayed word, it is inserted into your text at the insertion point. The 
more you use your hp Jornada, the more words it learns to anticipate. 
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Tap here if this
is the right word.

 
 

 

To change word suggestion options, such as the number of words suggested at 
one time, tap Settings on the Start menu. On the Personal tab, tap Input, 
and then tap the Word Completion tab. 

 

 

block recognizer 
With Block Recognizer, you can use the stylus to input characters using 
strokes that are similar to the Palm™ Graffiti® method. 

To type with Block Recognizer 

1. Tap the arrow next to the Input panel button, and then tap Block 
Recognizer. 

2. Write a letter in the box. 
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When you write a letter, it is converted to typed text that appears on the 
screen. For specific instructions on using Block Recognizer, launch Block 
Recognizer, and then tap the question mark next to the writing area. 

soft keyboard 
The soft keyboard is an onscreen keyboard displayed at the bottom of the 
screen.  

To type with the soft keyboard 

1. Tap the arrow next to the Input panel button, and then tap 
Keyboard. 

2. On the soft keyboard that is displayed, tap the keys with your 
stylus. 

letter recognizer 
With Letter Recognizer, you can write letters using the stylus just as you 
would use a pen on paper. 

To type with Letter Recognizer 

1. Tap the arrow next to the Input panel button, and then tap Letter 
Recognizer. 

2. Write a letter in the box. 
 
When you write a letter, it is converted to typed text that appears on the 
screen. For specific instructions on using Letter Recognizer, launch Letter 
Recognizer and then tap the question mark next to the writing area. 

transcriber 
With Transcriber you can write anywhere on the screen using the stylus just 
as you would on paper. Unlike Letter Recognizer and Block Recognizer, 
you can write a sentence or more of information; then, you pause and let 
Transcriber change the written characters to typed characters. 

To type with Transcriber 

1. Tap the arrow next to the Input panel button, and then tap 
Transcriber. 
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2. Write anywhere on the screen. 
 
For specific instructions on using Transcriber, launch Transcriber and then 
tap the question mark in the lower-right corner of the screen. 

writing on the screen 
In any program that accepts writing—such as the Notes program and the 
Notes tab in Calendar, Contacts, and Tasks—you can use your stylus to 
write directly on the screen. Write the way you do on paper. You can edit 
and format what you have written and convert the information to text later. 

To write on the screen 

• Tap the Pen button to switch to writing mode. This action displays 
lines on the screen to help you write. 
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Tap the Pen button and use
your stylus like a pen.  

 

 

 Some programs that accept writing may not have the Pen button. See the 
documentation for that program to find out how to switch to writing mode.  
 
If you want to edit or format writing, you must select it first. 

To select writing 

1. Tap and hold the stylus next to the text you want to select until the 
insertion point appears. 

2. Without lifting, drag the stylus across the text you want to select. 
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If you accidentally write on the screen, tap Tools, then Undo, and try 
again. You can also select text by tapping the Pen button to deselect it and 
then dragging the stylus across the screen. 

You can cut, copy, and paste written text in the same way you work with 
typed text: tap and hold the selected words and then tap an editing 
command on the pop-up menu, or tap the command on the Edit menu. 

To convert writing to text 

• On the Tools menu, tap Recognize. 
 
If you want to convert only certain words, select them before tapping 
Recognize on the Tools menu (or tap and hold the selected words and 
then tap Recognize on the pop-up menu). If a word is not recognized, it 
is left as writing. 

Select the text you want
to convert and tap Recognize on the
pop-up menu.

The writing is turned into
text.  

 

If the conversion is incorrect, you can select different words from a list of 
alternates or return to the original writing. To do so, tap and hold the 
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incorrect word (tap one word at a time). On the pop-up menu, tap 
Alternates. A menu with a list of alternate words appears. Tap the word 
you want to use, or tap the writing at the top of the menu to return to the 
original writing. 

Or, tap the word you want
to use.

Tap to return to your
original writing.

 
 

Some tips for getting good recognition are listed below: 

• write neatly. 
• write on the lines and draw descenders below the line. Write the cross 

of the “t” and apostrophes below the top line so that they are not 
confused with the word above. Write periods and commas above the 
line. 

• for better recognition, use the Tools menu to increase the zoom level 
to 300%. 

• write the letters of a word close together and leave big gaps between 
words. 
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• hyphenated words, foreign words that use special characters such as 
accents, and some punctuation cannot be converted. 

• if you add writing to a word to change it (such as changing a “3” to 
an “8”) after you attempt to recognize the word, the writing you add 
will not be included if you attempt to recognize the writing again.  

drawing on the screen 
You can draw on the screen in the same way that you write on the screen. 
The difference between writing and drawing on the screen is how you 
select items and how they can be edited. For example, selected drawings 
can be resized, while writing cannot. 

To create a drawing 

• Cross three ruled lines on your first stroke. A drawing box 
appears. Subsequent strokes in or touching the drawing box 
become part of the drawing. Drawings that do not cross three 
ruled lines will be treated as writing. 
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The drawing box indicates
the boundaries of the drawing.

Pen button.  
 

 

 You may want to change the zoom level so that you can more easily work on or 
view your drawing. Tap Tools, and then choose a zoom level.  
 
If you want to edit or format a drawing, you must select it first. 

To select a drawing 

• Tap and hold the stylus on the drawing until the selection handle 
appears. To select multiple drawings, deselect the Pen button and 
then drag to select the drawings you want. 

 
You can cut, copy, and paste selected drawings by tapping and holding 
the selected drawing and then tapping an editing command on the pop-up 
menu, or by tapping the command on the Edit menu. To resize a drawing, 
make sure the Pen button is not selected, and then drag a selection handle. 
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recording a message 
In any program where you can write or draw on the screen, you can also 
quickly capture thoughts, reminders, and phone numbers by recording a 
message. In Calendar, Tasks, and Contacts, you can include a recording 
in the Notes tab. In the Notes program, you can either create a stand-
alone recording or include a recording in a written note. If you want to 
include the recording in a note, open the note first. In the Inbox program, 
you can add a recording to an e-mail message.  

To create a recording 

1. Hold the hp Jornada’s microphone near your mouth or other 
source of sound. 

2. Press and hold the record button. If the speaker is not muted, a 
beep indicates that your hp Jornada is recording. The LED shines 
steady amber while recording is in progress.  

3. While holding down the record button, speak into the 
microphone. 

4. To stop recording, release the record button. Two beeps will 
sound. The new recording appears in the note list or as an 
embedded icon. 

 

 
You can also make a recording by tapping the Record button on the Recording 
toolbar. 

 

 

To play a recording 

• Tap it in the list or tap its icon in the note. 
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Indicates an embedded
recording.

Tap to show or hide
the Recording toolbar.

Tap to begin recording.

 
 

recording formats 
Your hp Jornada supports several formats for voice notes. The formats vary 
in both the quality of the recording and the size of the sound file. When 
selecting a recording format, you should consider the quality you need as 
well as how much storage memory the recording will use on your hp 
Jornada. 

Not all recording formats are compatible with other software or computers. 
If you will share your recordings with others or transfer a recording to your 
desktop PC, be sure to choose a recording format that is supported by the 
software used to play recordings on the other computer.  

The PCM format offers the highest quality recording, and is compatible 
with all hp Jornada models, other Windows-powered mobile devices, and 
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desktop PCs that use Windows operating systems. The GSM 6.10 format 
is compatible with all hp Jornada models and other Windows-powered 
mobile devices, but may not work with desktop PCs.  

To select a recording format 

1. On the Start menu, tap Settings, and then tap the Input icon. 
2. On the Options tab in the Input control panel, select a voice 

recording format from the drop-down list.  
 
The list of recording formats on your hp Jornada indicates the sample rate, 
whether the format is stereo or mono, and how much storage memory is 
required per second of recording. You may need to experiment with 
different sample rates and formats to determine which format best suits 
your voice. 
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using my text 
When using Inbox or MSN Messenger, use My Text to quickly insert preset 
or frequently used messages into the text entry area. To insert a message, 
tap My Text, and then tap a message. 

Tap to select a
prewritten message.  

 

 

 After inserting a My Text message, you can add text to it before you send the 
message.  
 
To edit a My Text message, on the Tools menu, tap Edit, and then tap 
My Text Messages. Select the message you wish to edit and make 
desired changes. 
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finding and organizing information 
The Find feature on your hp Jornada helps you quickly locate information.  

To find a file 

• On the Start menu, tap Find. Enter the text you want to find, 
select a data type, and then tap Go to start the search. 

 

 
To quickly find information that is taking up storage space on your hp Jornada, 
select Larger than 64 KB under Type. 

 

 
You can also use the File Explorer to find files on your hp Jornada and to 
organize these files into folders. On the Start menu, tap Programs, and 
then tap File Explorer. 
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Tap the folder name
to open it.

Tap and hold to create
a new folder.

Select the sort order
for the list.

Tap to change folders.

 
 

 
You can move files in File Explorer by tapping and holding the item you want to 
move, tapping Cut or Copy on the pop-up menu, browsing to the new location,
and then tapping Paste.  

 

managing memory 
Files, settings, and data that you add to your hp Jornada are stored in 
RAM. The RAM on your hp Jornada is allocated between storage memory 
(memory used to store files and data) and program memory (memory used 
by running programs). The operating system automatically manages the 
allocation between storage and program memory; however, in some 
situations—such as when memory is low—it may not be able to adjust the 
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memory properly. If you receive a message stating that storage or program 
memory is unavailable, try the following solutions. 

To increase storage memory, you can 

• buy an optional CompactFlash Type I or Type I extended memory 
card, and move files from internal memory to the card. (For more 
information on using CompactFlash accessories, see “pda 
accessories,” later in this chapter.)  

• delete unnecessary files. 
• remove Web pages stored for offline viewing in Internet Explorer 

folders. 
• remove programs you no longer use. See “adding and removing 

Programs,” later in this chapter. 
• clear program memory. See the section below. 
 
To increase program memory, you can 

• use hp task switcher or the Memory control panel to stop programs 
you are not currently using. In most cases, programs automatically 
stop to free needed memory. However, in some situations, such as 
when a dialog box is waiting for a response, the program may not be 
able to stop automatically. 

• clear storage memory as described above. This will free some storage 
memory so that it can be reallocated as program memory. 

• reset your hp Jornada. Remove your hp Jornada from the cradle, 
remove the CompactFlash card (if installed), and follow the instructions 
in “resetting your hp Jornada” in chapter 6.  

To use the Memory control panel to stop programs  

1. On the Start menu, tap Settings. 
2. On the System tab, tap Memory, and then tap the Running 

Programs tab to check the state of your active programs. 
3. To stop a running program, select the program in the list, and 

then tap Stop. 
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To use hp task switcher to stop programs  

1. Press and hold the Inbox hot key to display hp task switcher. 
2. Tap the Close button 

–or– 
On the pop-up menu, tap Close Window, and then tap a 
program in the list or tap Close All. 

 

compactflash memory cards 
You can increase storage and program memory on your hp Jornada by 
purchasing an optional CompactFlash memory card. You can use 
CompactFlash memory cards for backup, storage, archives, or to transfer 
large files to other devices. Files stored on a CompactFlash card appear in 
a folder called Storage Card, listed under My Device in the File Explorer 
application. 
 

 
Data stored on a CompactFlash card will be saved, even if your hp Jornada 
loses power. To protect your data, use hp backup to back up regularly to a 
CompactFlash card.  

 
CompactFlash accessories can be purchased from a variety of third-party 
vendors. Your hp Jornada supports CompactFlash Type I or Type I 
extended accessories. In addition to CompactFlash memory cards, you can 
buy CompactFlash accessories that offer additional functionality, such as 
network interface cards, cameras, and other peripheral devices. For more 
information on installing and using CompactFlash accessories with your hp 
Jornada, see “pda accessories” later in this chapter.  
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backing up and restoring data 
To prevent loss of data, you should back up your hp Jornada frequently. 
Your hp Jornada comes with two programs for backing up data: 

• Microsoft ActiveSync.   ActiveSync enables you to back all data 
on your hp Jornada to your desktop PC. You can set ActiveSync to 
back up automatically each time you connect, or you can back up 
manually, whenever you choose. For more information, see 
ActiveSync Help on your desktop PC. 

• hp backup.   The hp backup application enables you to back up all 
data on your hp Jornada, or only your PIM databases and/or e-mail 
messages. You can save the backup file in RAM or on an optional, 
removable CompactFlash memory card.   

using hp backup 
The hp backup application gives you added flexibility in backing up your 
valuable data. With hp backup, you can back up all data or back up only 
your Calendar, Contacts, Tasks, and Inbox databases. You can save the 
backup file to internal memory or to an optional CompactFlash memory 
card, so you can safeguard your data even while you are traveling or 
away from your desktop PC.  
 

 

Although you can back up data to internal memory (RAM) on your hp Jornada, 
if you restore your hp Jornada to the factory default settings or accidentally lose 
power, the backup file will be erased. To ensure the safety of your data, it is 
recommended that you back up to a CompactFlash memory card (using hp 
backup) or to your desktop PC (using ActiveSync). 

 

 

To back up data using hp backup 

1. Use hp task switcher to close all running applications.  
2. Disconnect your hp Jornada from your desktop PC.  
3. On the Start menu on your hp Jornada, tap Programs. 
4. In the hp Applications folder, tap the hp backup icon. 
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5. On the Backup tab, choose what you want to back up by 
checking or clearing the check boxes. 

6. If you want to protect your backup file with a password, tap 
Backup Options, and enter a password using the Input panel, 
and then tap OK. 

7. Tap Back Up Now. 
8. In the Name box, enter a name for the backup file, and select a 

storage location from the Location and Folder drop-down lists.  
9. Tap OK. 

 

restoring data 
When you use the backup file to restore information, information on your 
hp Jornada is replaced with the information stored in the backup file. If 
you have created files on your hp Jornada since the last backup and do 
not want to delete these files during the restore process, move the files from 
your hp Jornada to your desktop PC or to an optional CompactFlash 
memory card before restoring information.  
 

 
Depending on the type of backup file, the restore operation replaces all 
information stored in your PIM databases or all data stored on your hp Jornada. 
Any data added after the backup file was created will be lost.   

 

To restore data with hp backup 

1. Use hp task switcher to close all running applications. 
2. Disconnect your hp Jornada from your desktop PC. 
3. On the Start menu on your hp Jornada, tap Programs. 
4. In the hp Applications folder, tap the hp backup icon. 
5. On the Restore tab, choose what you want to restore by 

checking or clearing the check boxes. 
6. Tap Restore Now. 
7. In the file list, tap the name of a backup file you want to restore. 
8. Remove the CompactFlash card (if installed), and reset your hp 

Jornada. See “resetting your hp Jornada” in chapter 6.  
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When you restore data, your hp Jornada must have the same regional settings 
that it had when you completed the backup; otherwise, you will not be able to 
restore the files. To change regional settings, on the Start menu, tap Settings, 
and then tap the Regional Settings icon on the System tab. Select your 
region from the drop-down list. 

 

 

display and alert profiles  
Use the hp profiles application to quickly configure the display and alert 
profiles with your preferences for brightness, backlight options, and alerts 
and notifications.  

To start hp profiles  

1. On the Start menu, tap Settings. 
2. On the Personal tab, tap the hp profiles icon. 

 

 

You can use pop-up menus to quickly apply display profiles and alert profiles. 
Press and hold the Contacts hot key to display the alert profile pop-up menu. 
Press and hold the Calendar hot key to display the display profile pop-up 
menu.  

 

 

 

When the PDA functions are off and the auto cover is closed, you can use the 
phone End button to apply an alert profile, to change the phone ringing options.
In the auto cover application, select Enable speed dial and profile 
selection. Then, with the auto cover closed, press the End button to display the 
alert profiles. Use the volume/scroll control to scroll the profiles. Press the Send 
button to select a profile.  

 

 

display profiles 
The screen of your hp Jornada uses ambient light to enhance the display. 
That is, the brighter the surrounding light, the better you will be able to see 
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the screen. If you are in a dark room, you can use the backlight to 
compensate for the low ambient light. 

Your hp Jornada includes a light sensor. You can set an option to turn on 
the backlight automatically whenever the light sensor detects that 
conditions are too dim to see the screen clearly. Use hp profiles to adjust 
the brightness of your hp Jornada screen, and set options for turning the 
backlight on and off.  

You can configure four display profiles for different environments or 
lighting conditions (for example, indoors or low power). Display profiles 
remember all of the display options for brightness and backlight.  

 
 

 To quickly apply a display profile, press and hold the Calendar hot key, and 
then select a profile from the pop-up menu.   
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alert profiles 
Alert settings control the type of alarms and notifications used by your hp 
Jornada. You can configure alert profiles for different environments, for 
example a Loud profile for noisy environments, or a Meeting profile that 
silences screen taps and uses vibration for most alerts.  

 
 

 
To quickly apply an alert profile, press and hold the Contacts hot key, and then 
select a profile from the pop-up menu.  
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adjusting other settings 
You can change many settings on your hp Jornada to suit the way you 
work. To see the available options, tap Settings on the Start menu, and 
then tap any of the icons on the Personal or System tabs. In particular, 
you might want to adjust the following: 

• Clock. Change the time and set alarms and reminders.  
• Owner Information. Enter the contact information you want to be 

displayed each time you turn on your hp Jornada.  
• Password. Limit access to your hp Jornada by requiring a four-digit 

password to be entered each time you turn on your hp Jornada.  
• Today. Customize the look of, and the information that is displayed 

on, the Today screen.  
 

configuring hardware buttons 
You can configure the hardware buttons on your hp Jornada to suit the 
way you work. Use the Buttons control panel to assign the hp hot keys and 
the record button to start any program.  

To assign a program to a hardware button 

1. On the Start menu, tap Settings, and then tap the Buttons icon. 
2. On the Program Buttons tab, select a button from the list. 
3. In the Button assignment list, select the program you want to 

assign to the button.  

To control the scroll speed  

1. On the Start menu, tap Settings, and then tap the Buttons icon. 
2. On the Volume/scroll Control tab, move the sliders to set the 

repeat rate and the delay before repeat. 
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configuring menus 
You can customize the menus on your hp Jornada to ensure you have easy 
access to programs or documents. 

hp home menu 
Use the hp home menu application to quickly launch your favorite 
programs or open frequently used documents. You can modify the buttons 
on the hp home menu by adding descriptions or by assigning them to 
other programs. You can also add pages that contain buttons for the 
programs or documents you use most. 
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To modify a button assignment 

1. Press the hp home menu hot key to launch hp home menu.   
2. Select the page you want to modify from the drop-down list of 

home menu pages. 
3. Tap and hold the stylus on the button you want to modify. 
4. On the pop-up menu, tap Assign, Rename, or Delete.  

• Tap Assign, and then browse to select the program or 
document you want to assign to the button. 

• Tap Rename, and then type a description to be displayed 
under the button. The description can be up to 10 characters 
long. The default description is the file name. 

• Tap Delete to clear the current button assignment. 
 

To add a page to the hp home menu 

1. Press the hp home menu hot key to display the hp home menu. 
2. On the Page menu, tap Add Page. 
3. Enter a name for the page, and then tap OK. 
4. On the new page, tap and hold a button to assign to a program 

or document. 
5. On the pop-up menu, tap Assign, and then browse to select the 

program or document you want to assign to the button. 
 

start menu  
You can add programs to the Start menu to make it easier to access the 
programs you use most.  

To add a program to the Start menu 

1. On the Start menu, tap Settings, and then tap Menus. 
2. On the Start Menu tab, select the check box for the program 

you want to add. 
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The Start Menu tab displays only the programs stored in the Start Menu 
folder on your hp Jornada. If you do not see a particular program listed, 
use File Explorer to move the program to the Start Menu folder. 

adding and removing programs 

adding programs 
You can add even more functionality to your hp Jornada by installing 
additional software and programs. A wide variety of software is available 
for Windows Powered Pocket PCs, ranging from custom business 
applications and system utilities to games and entertainment. Some 
programs are available on the Pocket PC Companion CD included with 
your hp Jornada. Other programs are available from software vendors or 
on the Web.  

In addition to running Microsoft Pocket PC applications, you can 
download on demand Java applications (MIDlets) that are based on the 
Mobile Information Device Profile (MIDP) specifications. Suites of MIDlets 
may be available from your GSM/GPRS service provider. For more info, 
see “hp MicroChaiVM” in chapter 3, or consult your GSM/GPRS service 
provider.  

 

Install only programs designed specifically to run on an hp Jornada wireless 
digital assistant and/or a Windows Powered Pocket PC. You cannot run 
programs designed for Windows on your hp Jornada. In addition, you may 
need a version of the program designed specifically for the StrongARM 
processor used by your hp Jornada. 

 

 
Install software to your hp Jornada by first loading the installation files onto 
your desktop PC, and then using ActiveSync or running the Application 
Manager.  
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To install a program using ActiveSync 

1. Download the program to your desktop computer (or insert the CD 
or disk that contains the program into your desktop computer). 
You may see a single *.exe file, a *.zip file, a Setup.exe file, or 
several versions of files for different device types and processors. 
Be sure to select the program designed for the Pocket PC and the 
StrongARM processor. 

2. Connect your hp Jornada to your desktop PC. 
3. If the program includes an installer program (typically named 

Setup.exe or Install.exe), double-click the installer program on the 
desktop PC. The installer program copies the necessary files to 
your hp Jornada. 
–or– 
If the program does not include an installer, use ActiveSync 
Explore to copy the program file to the Program Files folder on 
your hp Jornada. Refer to the Read Me file or documentation that 
came with the program to be sure you have copied the necessary 
file(s). For more information on copying files using ActiveSync, see 
ActiveSync Help. 

 

 

You can also use Pocket Internet Explorer to download some programs from the 
Internet directly to your hp Jornada. If the program includes a *.xip or *.exe 
file, a Setup.exe file, or a cabinet (*.cab) file for Pocket PC, you can download 
this file to your hp Jornada, and then tap the icon to install the program. 

 

 

removing programs 
To free storage memory on your hp Jornada, you can remove programs 
you no longer use. Only programs that are stored in RAM can be 
removed. Programs preinstalled programs in Flash ROM cannot be 
removed; however, these programs do not use storage memory. 

To remove a program 

1. On the Start menu, tap Settings.  
2. On the System tab, tap Remove Programs. 
3. Select the program in the list, and then tap Remove.  
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If the program does not appear in the list of installed programs, use File 
Explorer on your hp Jornada to locate the program, tap and hold the program, 
and then tap Delete on the pop-up menu. 

 

 

pda accessories 
By purchasing accessories for your hp Jornada, you can add functionality, 
replace lost parts, and protect your hp Jornada from accidental damage. 
Hewlett-Packard makes a variety of accessories designed specifically to 
enhance your hp Jornada. In addition, you can purchase CompactFlash 
card accessories from many vendors. 

hp accessories 
Many optional accessories are available from Hewlett-Packard. In addition 
to accessories described here, the Accessories Guide included with your 
hp Jornada includes a catalog of accessories designed to work with the hp 
Jornada 920 series wireless digital assistant. Check the Hewlett-Packard 
Web site at www.hp.com for updates to this list.  

• hp Jornada 920 series pocket keyboard. Auto cover with 
built-in keyboard for easy typing. 

• hp Jornada 920 series car dc adapter. Charges your hp 
Jornada while from an automobile cigarette lighter. 

compactflash accessories 
There are many CompactFlash Type 1 accessories that provide a range of 
wide range of expansion possibilities for of the hp Jornada. You can use 
CompactFlash memory cards for backup storage, archives, or to transfer 
large files to other devices. CompactFlash cards can be purchased from a 
variety of third-party vendors. 

If you cannot find a software driver for your card on the CD provided with 
the hp Jornada, consult the card's manufacturer first. Install software 
drivers as you would install any other software or program. For more 
information, see "adding or removing programs," earlier in this chapter. 
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The hp Jornada supports CompactFlash Type I or Type I extended cards. In 
addition to CompactFlash memory cards, you can buy cards that offer 
additional functionality, such as modems, network interface cards, 
cameras, and other peripheral devices. For more information, see 
“accessories” later in this chapter or visit the hp Web site at www.hp.com.  

To install a CompactFlash card 

1. Remove the dummy card from the CompactFlash card slot. 
2. If the card is a Type I extended card, remove the CompactFlash 

door. 
3. Align the card as shown in the diagram, and push it into the slot 

until it clicks into place. 
 

 
If the card is Type I extended, remove the door from the CompactFlash Type I 
extended card slot, as shown on the left. 





 
 

 

5 | pda programs 

Your hp Jornada includes Microsoft Pocket PC Software 2002 with phone, 
hp applications, and programs from other vendors. The software includes 
hp image viewer, Microsoft Pocket Word, Microsoft Pocket Excel, 
Windows Media Player for Pocket PC, and Microsoft Reader. Third-party 
programs include  CodeWallet Pro from Developer One. This section 
provides an overview of these programs and enough information to get 
you started. For complete instructions on using a program, refer to
 online Help for that program.  

In this chapter, you will learn about 

• Microsoft Pocket Outlook and hp month view 
• Microsoft Pocket Word 
• Microsoft Pocket Excel 
• Microsoft Windows Media Player for Pocket PC 
• Microsoft Reader 
• MSN Messenger 
• hp image viewer 
 • CodeWallet Pro from Developer One  
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microsoft pocket outlook 
Microsoft Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and 
Notes. You can use these programs individually or together. For example, 
e-mail addresses stored in Contacts can be used to address e-mail 
messages in Inbox.  

Using ActiveSync, you can synchronize information in Microsoft Outlook or 
Microsoft Exchange on your desktop PC with information in Pocket Outlook 
on your hp Jornada. Each time you synchronize, ActiveSync compares the 
changes you made on your hp Jornada and desktop PC and updates both 
computers with the latest information. For information on using ActiveSync, 
see ActiveSync Help on your desktop PC. 

In this section, you will learn to 

• schedule appointments and meetings using Calendar. 
• track calendar details using hp month view 
• keep track of friends and colleagues using Contacts. 
• keep a to-do list in Tasks. 
• capture thoughts and ideas with Notes. 
 
For details on using Inbox to send and receive e-mail messages, see 
“sending and receiving e-mail” in chapter 3.  

 

calendar: scheduling appointments and meetings 
Use Calendar to schedule appointments, including meetings and other 
events. You can check your appointments in one of several views (Agenda, 
Day, Week, Month, and Year) and easily switch views by using the View 
menu. 
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Tap to go to today.

Tap to display or edit
the appointment details.

Tap to create a new appointment.  
 

 

 You can customize the Calendar display (for example, change the first day of 
the week), by tapping Options on the Tools menu.  
 

To create an appointment 

1. In Day or Week view, tap the desired date and time for the 
appointment. 

2. Tap New. 
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Tap to select a date.

Tap to select a time.

Tap to return to the calendar
(the appointment is saved
automatically).

Tap to choose from
previously entered locations.

Tap to choose from
predefined text.

Notes is a good place
for maps and directions.

 
3. Using the Input panel, tap first to select the field, and then enter a 

description and a location.  
4. If needed, tap the date and time to change them. 
5. Enter other desired information. You will need to hide the Input 

panel to see all available fields. 
6. To add notes, tap the Notes tab. You can enter text, draw, or 

create a recording. For more information on creating notes, see 
“Notes: capturing thoughts and ideas,” later in this chapter. 

7. Tap OK to return to Calendar.  
 

 
If you select Remind me in an appointment, your hp Jornada will remind you 
according to the options set in the Sounds & Notifications control panel. 

 

using the summary screen 
When you tap an appointment in Calendar, a summary screen is 
displayed. To change the appointment, tap Edit. 
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View appointment details.

View.

Tap to change
appointment.  

creating meeting requests 
You can use Calendar to set up meetings with users of Outlook or Pocket 
Outlook. The meeting notice will be created automatically and sent either 
when you synchronize Inbox or when you connect to your e-mail server. 
Indicate how you want meeting requests sent by tapping Tools and then 
Options. If you send and receive e-mail messages through ActiveSync, 
select ActiveSync.  

To schedule a meeting 

1. Create an appointment. 
2. In the appointment details, hide the Input panel, and then tap 

Attendees. 
3. From the list of e-mail addresses in Contacts, select the meeting 

attendees.  
 
The meeting notice is created automatically and placed in the Outbox 
folder. 

For more information on sending and receiving meeting requests, see 
Calendar Help and Inbox Help on your hp Jornada. 
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hp month view: managing details by the month 
hp month view provides a monthly view of your calendar appointments 
with details and features for convenient management of calendar data.  

 

 

 

With hp month view you can: 

• view appointments and meetings on a monthly calendar. 
• easily move from one date to another by tapping the day. Jump to any 

month or year by tapping the month or year in the navigation bar to 
bring up a list. 

• move forward or backward one month at a time using the arrows in 
the navigation bar. 
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• customize the monthly calendar display to your preferences (initially, 
the calendar displays five-day weeks and automatically widens the 
column containing the selected day so the full text for appointments is 
shown). 

• zoom in on a day view to modify your calendar data. 
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hp month view works with the calendar data you enter in Microsoft Pocket 
Outlook.  
 

 Consider assigning hp month view to the calendar button on your hp Jornada. 
See "configuring hardware buttons" in chapter 4.  
 

date calculation 
You can also use hp month view to calculate the number of days between 
two dates, or to quickly identify a date that occurs a specified number of 
days in the future or past. 
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To calculate the number of days between two dates  

1. Tap the blue text displayed by Date1, and then select a date 
from the calendar. 

2. Tap the blue text displayed by Date2, and then select a date 
from the calendar.  
The difference between the two dates (in days and weeks) is 
shown under Difference.  

 

To find a date that is a specified number of days away  

1. Tap the blue text displayed by Date1, and then select the start 
date from the calendar. 

2. Under Difference, tap the blue text, and enter a number of days 
or weeks. 
The resulting date is displayed as Date2.  
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contacts: tracking friends and colleagues 
Contacts maintains a list of your friends and colleagues so that you can 
easily find the information you are looking for, whether you are at home or 
on the road. Using the hp Jornada infrared port, you can quickly share 
Contacts information with users of Pocket PCs and other mobile devices.  

Tap and enter part of a name to
quickly find it in the list.

Tap to display or edit
the contact details.

Tap and hold to display
a pop-up menu of actions.

Tap to see additional phone
numbers and e-mail addresses.

Tap to create a new contact.

Select the category of contacts
you want displayed in the list.

 
 

 

 To change the way information is displayed in the list, tap Tools, and then tap 
Options.  
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To create a contact 

1. Tap New. 

Notes is a good place
for maps and directions.

Tap to return to the contact
list (the contact is saved
automatically).

Scroll to see more fields.

 
 

2. Using the Input panel, enter a name and other contact 
information. You will need to scroll down to see all available 
fields. 

3. To assign the contact to a category, scroll to and tap Categories 
and select a category from the list. In the contact list, you can 
display contacts by category. 
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4. To add notes, tap the Notes tab. You can enter text, draw, or 
create a recording. For more information on creating notes, see 
“notes: capturing thoughts and ideas,” later in this chapter. 

5. Tap OK to return to the contact list. 

finding a contact 
There are four ways to find a contact:  

• on the Start menu, tap Find, enter the contact name, select 
Contacts for the type, and then tap Go.  

• in the contact list, enter a contact name in the box under the 
Navigation bar. To show all contacts again, clear text from the 
box or tap the button to the right of the box.  

• in the contact list, tap the category list (labeled All Contacts by 
default) and select the type of contact that you want displayed. To 
show all contacts again, select All Contacts. To view a contact 
not assigned to a category, select None.   

• to view the names of companies your contacts work for, in the 
contact list, tap View, and then tap By Company. The number 
of contacts that work for that company will be displayed to the 
right of the company name.  

 

using the summary screen 
When you tap a contact in the contact list, a summary screen is displayed. 
To change the contact information, tap Edit. 
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View contact details.

Tap to view notes.

Tap to change contact information.  
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tasks: keeping a to-do list 
Use Tasks to keep track of what you have to do.  

Tap to create a new  task.

Select the sort order
of the list.

Indicates high priority.

Select the category of tasks
you want displayed in the list.

Tap to display or edit
the task details.

Tap and hold to display
a pop-up menu of actions.

 
 

 

 To change the way information is displayed in the list, tap Tools, and then tap 
Options.  
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To create a task 

1. Tap New. 

Tap to return to the task
list (the task is saved
automatically).

Tap to choose from
predefined subjects.

Notes is a good place
for maps and drawings.

 
2. Using the Input panel, enter a description. 
3. You can enter a start date and due date or enter other information 

by first tapping the field. If the Input panel is open, you will need 
to hide it to see all available fields. 

4. To assign the task to a category, tap Categories and select a 
category from the list. In the task list, you can display tasks by 
category. 

5. To add notes, tap the Notes tab. You can enter text, draw, or 
create a recording. For more information on creating notes, see 
“Notes: capturing thoughts and ideas,” later in this chapter. 
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6. Tap OK to return to the task list. 
 

 To quickly create a task with only a subject, tap Entry Bar on the Tools menu, 
and then tap Tap here to add a new task. Enter your task information.  
 

using the summary screen 
When you tap a task in the task list, a summary screen is displayed. To 
change the task, tap Edit.  

View task details.

View notes.

Tap to show and hide additional
summary information.

Tap to change task.  
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notes: capturing thoughts and ideas 
Quickly capture thoughts, reminders, ideas, drawings, and phone numbers 
with Notes. You can create a written note or a recording. You can also 
include a recording in a note. If a note is open when you create the 
recording, it will be included in the note as an icon. If the note list is 
displayed, it will be created as a stand-alone recording. 

Tap to open a note or
play a recording.

Tap and hold to display
a pop-up menu of actions.

Tap to create a new  item.

Tap to change the sort
order of the list.

Tap to show or hide the
Recording toolbar.

Tap to record.

 
 

To create a note 

1. Tap New. 
2. Create your note by writing, drawing, typing, or recording. For 

more information about using the Input panel, writing and 
drawing on the screen, and creating recordings, see “entering 
information” in chapter 4. 
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microsoft pocket word 
Microsoft Pocket Word works with Microsoft Word on your desktop PC to 
give you easy access to copies of your documents. You can create new 
documents on your hp Jornada, or you can copy documents from your 
desktop PC. Synchronize documents between your desktop PC and your 
hp Jornada regularly so that you have the most up-to-date content in both 
locations.  

To use Pocket Word 

1. On the Start menu, tap Programs, and then tap the Pocket 
Word icon. 

2. Tap the name of a document in the file list. 
–or– 
Tap New to open a blank document.  

 

 

To open a template rather than a blank document, select a template for new 
documents. On the Tools menu, tap Options, and then browse to select the 
default template. When you tap New, the template appears with appropriate 
text and formatting already provided. 

 

 
You can open only one document at a time; when you open a second 
document, you will be asked to save the first. You can save a document 
you create or edit in a variety of formats, including Pocket Word (.psw), 
Rich Text Format (.rtf), and Plain Text (.txt). 

You can enter information in Pocket Word in four modes: writing, 
drawing, typing, and recording. Use the View menu to switch between 
modes. Each mode has its own toolbar, which you can show and hide by 
tapping the Show/Hide Toolbar button on the Command bar. 

• typing mode.   Use the Input panel to enter typed text into the 
document with either the soft keyboard or the Character Recognizer. 
For more information on entering typed text, see “entering 
information” in chapter 4. 
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• writing mode.   In writing mode, use your stylus to write directly on 
the screen. Ruled lines are displayed as a guide, and the zoom 
magnification is greater than in typing mode to allow you to write 
more easily. For more information on writing and selecting writing, 
see “entering information” in chapter 4. 

 

 
Written words are converted to graphics (metafiles) when a Pocket Word 
document is converted to a Word document on your desktop PC. 

 

 
• drawing mode.   In drawing mode, use your stylus to draw on the 

screen. Gridlines appear as a guide. When you lift your stylus off the 
screen after the first stroke, you will see a drawing box indicating the 
boundaries of the drawing. Every subsequent stroke within or touching 
the drawing box becomes part of the drawing. For more information 
on drawing and selecting drawings, see “entering information” in 
chapter 4. 

• recording mode.   Use recording mode to embed a recording into 
your document. Recordings are saved as .wav files. For more 
information on recording, see “entering information” in chapter 4. 

tips for working in pocket word 
• you can change the zoom magnification by tapping View and then 

Zoom. Then select the percentage you want. Select a higher 
percentage to enter text and a lower one to see more of your 
document. 

• if you are opening a Word document created on a desktop PC, select 
Wrap to Window on the View menu so that you can see the entire 
document. 
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microsoft pocket excel 
Microsoft Pocket Excel works with Microsoft Excel on your desktop PC to 
give you easy access to copies of your workbooks. You can create new 
workbooks on your hp Jornada, or you can copy workbooks from your 
desktop PC to your hp Jornada. Synchronize workbooks between your 
desktop PC and your hp Jornada so that you have the most up-to-date 
content in both locations. Pocket Excel provides fundamental spreadsheet 
tools, such as formulas, functions, sorting, and filtering, which enable you 
to create simple workbooks, such as expense reports and mileage logs.  

To use Pocket Excel 

1. On the Start menu, tap Programs, and then tap the Pocket 
Excel icon. 

2. Tap the name of a workbook in the file list. 
–or– 
Tap New to open a blank workbook.  

 

 

To open a template rather than a blank workbook, select a template for new 
workbooks. On the Tools menu, tap Options, and then browse to select the 
default template. When you tap New, the template appears with appropriate 
text and formatting already provided. 

 

 
You can open only one workbook at a time; when you open a second 
workbook, you will be asked to save the first. You can save a workbook 
you create or edit in a variety of formats, including Pocket Excel (.pxl) and 
Excel (.xls). 

tips for working in pocket excel 
• view in full-screen mode to see as much of your worksheet as possible. 

Tap View and then tap Full Screen. To exit full-screen mode, tap 
Restore. 

• if your workbook contains sensitive information, you can protect it with 
a password. To do so, open the workbook, tap Edit, and then tap 
Password. 
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• show and hide window elements. Tap View and then tap the 
elements you want to show or hide. 

• freeze panes on a worksheet. First, select the cell where you want to 
freeze panes. Tap View and then tap Freeze Panes. You might 
want to freeze the top and leftmost panes in a worksheet to keep row 
and column labels visible as you scroll through a sheet. 

• split panes to view different areas of a large worksheet. Tap View 
and then tap Split. Then drag the split bar to where you want it. To 
remove the split, tap View and then tap Remove Split. 

• show and hide rows and columns. To hide a row or column, select a 
cell in the row or column you want to hide. Tap Format, then tap 
Row or Column, and then tap Hide. To show a hidden row or 
column, tap Tools, then tap Go To, and then type a reference that is 
in the hidden row or column. Tap Format, then tap Row or 
Column, and then tap Unhide. 

 

microsoft windows media player 
Use Microsoft Windows Media Player for Pocket PC to listen to digital 
audio and video files, such as songs or movie clips. Media Player supports 
sound files recorded in Windows Media and MP3 formats. 

To start Windows Media Player 

• On the Start menu, tap Programs, and then tap the 
Windows Media Player icon. 

 

 

To save power, turn off the display while listening to music on your hp Jornada. 
To turn off the display, press and hold the hp home menu hot key to display the 
hp quick menu, and then tap Turn display off. (Press the power button to turn 
on the display.) 
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Indicates the progress
of the current track.

Tap to skip to
the next song.

Tap to play
a previous song.

Tap
to
stop.

Tap to play
or pause.

Tap to adjust volume.

 
 

 

You can copy music files to enjoy on your hp Jornada by converting or 
“ripping” files from your favorite audio CDs or by downloading songs from a 
Web site such as EMusic.com. The CD included with your hp Jornada has 
sample songs from Emusic.com and the MusicMatch JukeBox application, which 
can be used to record songs from your favorite audio CDs in a format that can 
be played on your hp Jornada. 
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Your hp Jornada is uniquely identified by a UUID (Universally Unique ID). Many 
publishers of digitally secured content, such as MP3 music files and electronic 
books (eBooks) use digital rights management that relies on the device’s UUID to
prevent unauthorized usage. After your hp Jornada has been serviced or 
repaired, you may be unable to access digitally secured content that you had 
downloaded prior to the service. In such cases, contact the content publisher for 
assistance. 

 

 

streaming audio and video 
You can use Windows Media Player to enjoy streaming audio and video, 
such as entertainment, news, music, and more.1 To see a list of available 
content, connect to the MSN Mobile site using Pocket Internet Explorer on 
your hp Jornada.  

To view streaming media 

1. On the Start menu, tap Internet Explorer. 
2. Tap MSN Mobile. 
3. On the MSN Mobile page, tap the link to MSN Mobile. 
4. Tap the link to Windows Media.com.  

working with audio files on a compactflash card 
Because songs and audio files can use a lot of storage memory, you might 
want to store them on a CompactFlash memory card. For more information 
on installing a CompactFlash card and working with files on the card, see 
“pda accessories” in chapter 4. 
 

                                                      
1 Access to streaming content requires a separate wireless data subscription from 
your service provider. 
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microsoft reader 
Use Microsoft Reader to read eBooks on your hp Jornada. Download 
books to your desktop PC from eBook Web sites. Then, use ActiveSync to 
copy the book files to your hp Jornada. The books appear in the Reader 
Library.  

Each book consists of a cover page, an optional table of contents, and the 
pages of the book. You can 

• page through the book by using the volume/scroll control on your hp 
Jornada or by tapping the page number on each page. 

• annotate the book with highlighting, bookmarks, notes, and drawings. 
• search for text and look up definitions for words. 
The Reader Guidebook is preinstalled on your hp Jornada, and contains 
all the information you will need to use Microsoft Reader. To open the 
Guidebook, tap Help on the Reader command bar. Or, on a book page, 
tap and hold on the book title, and then tap Help on the pop-up menu. 

To start Microsoft Reader 

• On the Start menu, tap Programs, and then tap Microsoft 
Reader.  

 

getting ebooks for your hp Jornada 
You can download book files from the Web. Just visit your favorite eBook 
retailer and follow the instructions to download the book files. Sample 
books and a dictionary are also included in the MSReader folder in the 
Extras folder on the Pocket PC Companion CD.  
 

 

Your hp Jornada is uniquely identified by a UUID (Universally Unique ID). Many 
publishers of digitally secured content, such as MP3 music files and eBooks, use 
digital rights management that relies on the device's UUID to prevent 
unauthorized usage. After your hp Jornada has been serviced or repaired, you 
may be unable to access digitally secured content that you had downloaded 
prior to the service. In such cases, contact the content publisher for assistance. 

 

 



154 | hp Jornada 920 series wireless digital assistant user’s guide  
 

 

using the library 
The Library is your Reader home page; it displays a list of all books stored 
on your hp Jornada or storage card. 

To open the Library 

• On the Reader command bar, tap Library.  
–or– 
On a book page, tap the book title and then tap Library on the 
pop-up menu. 

 

To open a book 

• Tap a title in the Library list. 
 

Tap to open a book.

Tap to scroll through
the Library list.

Tap to specify
the books you

want to display
in the list.

Tap to select
a sort order.

Tap here to
navigate to

other parts of
the Reader.

 

reading a book 
Each book consists of a cover page, an optional table of contents, and the 
pages of the book. Navigation options are listed in the bottom portion of 
the cover page.  
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The first time you open a book, you will probably want to go to the first 
page or to the table of contents, if there is one. Subsequently, whenever 
you open the book, you will be automatically taken to the last page you 
read. 

In addition to the text, each book page includes a page number and book 
title. 

Drag to select text and
then tap an option.

Tap arrows to turn
the page, or tap and
hold page # to bring
up page riffle.

Tap to select
a navigation

option.

 
You can also page through a book by using the volume/scroll control on 
your hp Jornada. 

using reader features 
Reading a book electronically gives you several options not available with 
paper books. These options are available from any book page. 

Select text by dragging across the text on the page. Then, tap an option on 
the pop-up menu, as described here: 
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• Search for text. Find text in a book by tapping Find on the pop-up 
menu. Enter the word you want to search for, and tap the desired 
Find option. Reader highlights the found text on the page. To close 
Find, tap outside the box. To return to your original page, tap the title 
and then tap Return on the pop-up menu. 

• Copy text. You can copy text from books that support this feature 
into any program that accepts text. On a book page, select the text 
you want to copy, and then tap Copy Text on the pop-up menu. The 
text can be pasted into the program of your choice. 

• Bookmarks. When you add a bookmark to a book, a color-coded 
bookmark icon appears in the right margin. You can add multiple 
bookmarks to a book. Then, from anywhere in the book, tap the 
bookmark icon to go to the bookmarked page. 

• Highlights. When you highlight text, it appears with a colored 
background.  

• Notes. When you attach a note to text, you enter the text in a 
notepad that appears on top of the book page. A Note icon will be 
displayed in the left margin. To show or hide the note, tap the icon. 

• Drawings. When you add a drawing, a Drawing icon appears in 
the lower-left corner of the page, and drawing tools appear across the 
bottom of the page. Draw by dragging your stylus. 

• Annotations. To see a list of a book’s annotations, including 
bookmarks, highlights, text notes, and drawings, tap Annotations 
Index on the book’s cover page. You can tap an entry in the list to 
go to the annotated page. 

removing a book 
When you finish reading a book, you can delete it to conserve space on 
your hp Jornada. If a copy of the book is stored on your desktop PC, you 
can download it again at any time.  

To remove a book from your hp Jornada, tap and hold the title in the 
Library list, and then tap Delete on the pop-up menu. 
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msn messenger 
MSN Messenger is an instant messaging program that lets you 

• see who is online. 
• send and receive instant messages. 
• have instant message conversations with groups of contacts. 
 
To use MSN Messenger, you must purchase and install an optional modem 
and have an account with an ISP. For more information, see “connecting 
to the internet or to a network” in chapter 3. 

In addition, you must have a Microsoft Passport account or a Microsoft 
Exchange e-mail account. You must have a Passport to use MSN 
Messenger Service. If you have a Hotmail® or MSN account, you already 
have a Passport. Once you have obtained either a Microsoft Passport or a 
Microsoft Exchange account, you are ready to set up your account. 
 

 Sign up for a Microsoft Passport account at http://www.passport.com. Get a 
free Microsoft Hotmail e-mail address at http://www.hotmail.com.  
 

To switch to MSN Messenger  

• On the Start menu, tap Programs, and then tap the MSN 
Messenger icon.  

setting up to use msn messenger 
Before you can connect, you must enter Passport or Exchange account 
information. 

To set up an account and sign in 

1. On the Tools menu, tap Options. 
2. On the Accounts tab, enter your Passport or Exchange account 

information. 
3. To sign in, tap the sign-in screen and enter your e-mail address 

and password. 
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If you already use MSN Messenger on your desktop PC, your contacts will 
show up on your device without being added again.  

 

 

working with contacts 
The MSN Messenger window shows all of your messenger contacts at a 
glance, divided into Online and Not Online categories. From this view, 
while connected, you can chat, send e-mail messages, block the contact 
from chatting with you, or delete contacts from your list using the pop-up 
menu. 

Tap and hold to display
a pop-up menu of actions.

Tap a contact to start a chat.
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 To see others online without being seen, on the Tools menu, tap My Status, 
and then tap Appear Offline.   
  

 
If you block a contact, you will appear offline but will remain on the blocked 
contact’s list. To unblock a contact, tap and hold the contact, then tap 
Unblock on the pop-up menu.   

 

chatting with contacts 
Tap a contact name to open a chat window. Enter your message in the text 
entry area at the bottom of the screen (or tap My Text to enter a preset 
message), and then tap Send. To invite another contact to a multi-user 
chat, on the Tools menu, tap Invite, and then tap the contact you want to 
invite. 
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To switch back to the main window without closing a chat, tap the Contacts 
button. To revert to your chat window, tap Chats, and then select the person 
with whom you were chatting.  

 

 

hp image viewer 
The hp image viewer application enables you to view and edit image files 
stored on your hp Jornada. You can view images in the JPG, BMP, 2BP, 
GIF, and PNG formats. 
 

 

The hp image viewer application works great with the optional hp Pocket 
Camera and pocket camera software, enabling you to take pictures and view 
them immediately on your hp Jornada. The pocket camera software is 
preinstalled on your hp Jornada. The hp Pocket Camera is available as an 
optional accessory. For more information, see the Accessories Guide, or visit 
the hp Jornada Web site at www.hp.com. 

 

 
You can view pictures on your hp Jornada in three ways: 

• browse mode shows small "thumbnails" of all the images on your 
hp Jornada, with a preview of the current image.  

• view mode displays a single image at full size.  
• slideshow displays images sequentially, resized to fit your screen.  

To start hp image viewer 

1. On the Start menu, tap Programs, and then tap the hp 
applications folder.  

2. Tap the hp image viewer icon. 
 
By default, hp image viewer starts in Browse mode and displays images 
that are saved in the My Documents folder on your hp Jornada.  

To view pictures in a different folder 

• On the View menu, tap Change Folder, and then select a 
folder from the drop-down list. 
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If you have an hp Jornada Pocket Camera, tap the camera icon in the 
Command bar (or tap Capture on the View menu) to switch to Capture 
mode. If the camera is not installed, switching to Capture mode will display the 
“no camera” icon, . For more information on the hp Jornada Pocket 
Camera, see the Accessories Guide, or visit the hp Jornada Web site at 
www.hp.com. 

 

 

browse mode 
Browse mode displays thumbnail views of the pictures in the current folder 
and information about the selected picture. 
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 Tap the picture in the Preview window to switch to View mode and view the 
picture at actual size.  
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From Browse mode, you can perform file actions (rename, copy, or delete) 
on selected images. You can also record sounds files to go with a specific 
images. 

renaming, copying, deleting, and rotating images 
Use the Edit menu to rename, delete, move, copy, and rotate images. 
When renaming an image, do not enter the file name extension (for 
example, .jpg) 
 

 

You can delete, move, and copy several images at once. Select multiple images 
by tapping the triangle in the upper left corner of the thumbnail images, or tap 
Mark on the Edit menu. 

 

 

recording sound files  
You can record sound files to go with your images. When you display an 
image with an associated sound file, the sound file is played (unless the 
Play review-related sounds option has been disabled). An image 
that has an associated sound file has a musical note icon on its thumbnail.  

To record a sound file to go with an image  

1. In Browse mode, select the image.  
2. Tap the Sound button on the menu bar to display the Recording 

toolbar.  
3. On the Recording toolbar, tap the Record button.  
4. Speak into the microphone or record the sound.  
5. When you have finished, tap the Stop button on the Recording 

toolbar. 
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view mode 
Use View mode to view a picture on your hp Jornada screen at actual 
size. 

To switch to View mode  

• Tap the picture in the Preview window. 
–or– 
On the View menu, tap Actual Size.  

 

To close hp image viewer  

• Tap OK. 
 
If the image is too large to fit on the screen, the Overview window in the 
lower-right corner of the image displays a thumbnail of the entire image. A 
black rectangle in the Overview window marks the area of the image that 
is displayed in the main window. Display other parts of the image by 
tapping an area in the thumbnail, by scrolling with the navigation pad, or 
by dragging the stylus on the screen. 

slideshow mode 
In Slideshow mode, pictures are resized (and/or rotated) to fit the screen 
of your hp Jornada. You can choose whether the slideshow automatically 
displays the next picture in sequence after a short delay, or whether you 
change the picture by pressing the navigation pad or the volume/scroll 
control.  

To start the slideshow  

• On the View menu, tap Slideshow.  
 

To stop the slideshow  

• Press the action button.  
 

To set slideshow options 

1. On the View menu, tap Options, and then tap the Slideshow 
tab.  
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2. Select from the following slideshow options:  
• Sequence. To automatically play the slideshow, select the order 

in which you want pictures displayed: Forward, Reverse, or 
Random. To control the slideshow manually (by rocking the 
action button to display the next picture), select Off.  

• Delay. Set the delay time (in seconds) you want the slideshow 
to wait before it automatically displays the next picture.  

• Wrap around. To repeat the slideshow after the final picture 
has been displayed, select the Wrap around check box. 
Clear the check box if you want the slideshow to stop after the 
last picture.  

• Auto-rotate. Select the Auto-rotate check box to rotate 
pictures if necessary to better fit the screen. Select either 
Clockwise or Anti-clockwise to determine the direction of 
rotation. 

• Show filename and Show date. Select Show filename 
and/or Show date to display information about the picture on 
the screen during the slideshow.  

• Play audio. Select Play audio to play any associated sound 
files when the picture is displayed.  

 

sending images  
You can also use hp image viewer to send images by e-mail, send images 
by infrared, or copy and paste images into Word documents and notes. 

To send an image as an attachment to an e-mail 
message  

1. In Browse mode, select the image that you want to send.  
2. On the Send menu, tap E-Mail.  

This will launch Pocket Inbox and open a new e-mail with the 
image as an attachment.  

 

To send an image to another PDA by infrared  

1. In Browse mode, select the image that you want to send.  
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2. On the Send menu, tap Infrared.  
3. Align the infrared ports on your hp Jornada with the infrared ports 

on the receiving device, and set the receiving device to receive 
the file.  

  

To send an image to an infrared-equipped printer or 
desktop PC  

1. In Browse mode, select the image that you want to send.  
2. On the Edit menu, tap Send IrOBEX.  
3. Align the infrared ports on your hp Jornada with the infrared ports 

on the receiving device.  
  

To copy an image to a document  

1. In Browse mode, select the image that you want to copy.  
2. On the Edit menu, tap Copy to Clipboard, and then choose 

the appropriate size.  
3. Switch to the document or note into which you will paste the 

image.  
4. On the Edit menu, tap Paste.  

 

adding comments to images 
You can add comments use image viewer to add comments to .jpg files.  

To add a comment to a .jpg file 

1. In hp image viewer, tap a .jpg image.  
2. On the Edit menu, tap Comments. An edit window appears, 

showing any currently embedded text in the image.  
3. Add or modify text in the edit window.  
4. Tap OK to save your changes. 

 

 Only modifiable JPEG image files allow the inclusion of comments. If another 
image format is selected, the Comments menu item is unavailable.  
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codewallet pro 
CodeWallet Pro allows you to easily store, organize, and retrieve personal 
information, such as credit card numbers, favorite URLs, and emergency 
phone numbers. CodeWallet includes information forms for your 
convenience, and stores your data in encrypted, password-protected files.  
 

 
CodeWallet Pro may not be included on some models of the hp Jornada.  

 

To start CodeWallet Pro 

• On the Start menu, tap Programs, and then tap the 
CodeWallet Pro icon. 

 
For detailed help and procedures about using CodeWallet Pro, refer to 
online Help or the CodeWallet Pro User’s Guide on the Pocket PC 
Companion CD. 



 
 

 

6 | troubleshooting 

If you encounter difficulty while using your hp Jornada, this chapter will 
help you find answers. If you need information about troubleshooting 
ActiveSync or connecting to your desktop PC, click Microsoft 
ActiveSync Help on the Help menu in ActiveSync. 

The information in this chapter will help you 

• reset your hp Jornada. 
• restore your hp Jornada to the factory default settings. 
• troubleshoot basic problems. 
• troubleshoot problems with remote connections. 
• troubleshoot problems with the display and touch screen. 
• troubleshoot phone problems 
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resetting your hp Jornada 
Occasionally, you may need to reset your hp Jornada; for example, you 
should reset after you restore data from your desktop PC or when the 
operating system stops responding. Resetting your hp Jornada is similar to 
restarting your desktop PC. It restarts the operating system and preserves 
any saved data, but you will lose any unsaved data. 

Reset after restoring data from a backup file or when your hp Jornada 
appears to be “frozen” or “locked up.” 
 

 
When you reset, you lose unsaved data in all open documents or programs. Use 
hp task switcher to close all open documents and programs before you reset.  

 

 

To reset 

1. Remove your hp Jornada from the cradle. 
2. Remove the CompactFlash card (if installed).  
3. Use the stylus to press the red reset button on the back of the hp 

Jornada, as shown in the following illustration. 
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restoring factory defaults 
In some cases, such as when your hp Jornada does not respond after 
being reset or when you forget your password, you may need to restore 
your hp Jornada to the factory default settings. This erases all data stored 
in RAM. All information you have entered, including all files, system 
settings, and programs you have installed, may be erased.  

To ensure the safety of your information should it be necessary to restore 
the factory defaults, you should regularly back up your data to your 
desktop PC (using ActiveSync), to a CompactFlash card (using the hp 
backup application). For more information on backing up data, see 
“backing up and restoring data” in chapter 4. 
 

 

Restoring the factory default settings erases all files, programs, and data stored 
in RAM. You can restore data from a backup file saved on your desktop 
computer or on a CompactFlash card. (For more information, see “backing up 
and restoring data” in chapter 4, or ActiveSync Help on your desktop 
computer.) 

 

 

To restore the factory defaults  

1. Remove your hp Jornada from the USB cradle and disconnect all 
cables, including the ac adapter, from your hp Jornada. 

2. Using the stylus, press and hold the reset button.  
3. While holding the reset button, press and release the power 

button.  
4. Release the reset button 
5. Press the power button.  

  
After you restore the factory defaults, you will need to complete the 
Welcome Wizard and re-establish a partnership with your desktop PC. 
You may also want to restore data to your hp Jornada from your most 
recent backup file. for more information, see “using your hp Jornada for 
the first time” in chapter 1, and “backing up and restoring data” in 
chapter 4. 
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basic problems 
If you have a specific problem, review the information below to see if you 
can quickly find the answer. Or, visit the hp Web site at www.hp.com for 
more information about common difficulties. 
 
Problem Diagnosis/Remedy 

hp Jornada does not turn 
on when not connected to 
ac power. 

Power is too low to run your hp Jornada. 
Connect to ac power, and then turn on 
your hp Jornada. (Charge the batteries 
regularly to avoid running out of battery 
power.)  

Batteries run out of power 
quickly. 

You are using your hp Jornada in ways 
that drain power quickly. Use external 
power to charge and power your device 
whenever possible, especially when 
listening to music or using CompactFlash 
accessories. Using wireless LAN, GPRS, 
and GSM functions can also drain the 
batteries very quickly. Turn off these 
functions when they are not in use.  

–or– 

Alerts and notifications are causing your 
hp Jornada to turn on, even when you are 
not using it. Check the “wake up sources” 
under When device is off in the Power 
Preferences page in hp profiles.  

For more information, see “managing 
power” in chapter 1. 
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Problem Diagnosis/Remedy 

hp Jornada automatically 
shuts down/suspends. 

Power is too low. When a critically low 
power condition is encountered, the hp 
Jornada initiates a safety shutdown. 
Connect to ac power and charge the 
batteries.  

–or– 

Auto-suspend activated. To conserve 
power, the hp Jornada auto-suspends if it 
is idle for one minute immediately after 
power is turned on. It also auto-suspends if 
it is continuously idle for five minutes. 

–or– 

hp Jornada is locked up. Connect to 
external power, and reset your hp 
Jornada. (See “resetting your hp Jornada” 
in this chapter.) (Caution: You may lose 
any unsaved data when you reset.) 

hp Jornada locks up when 
running applications, or it 
runs slowly. 

hp Jornada is locked up. Connect to ac 
power, and reset. (see “resetting your hp 
Jornada” in this chapter.) Note: Check to 
ensure that the device is not running low 
on power, and avoid running several 
applications at the same time. Use hp task 
switcher to close applications that are not 
in use. 

Phone ringing volume is 
too soft/loud. 

Ring volume not set properly. The phone 
ringing volume and the volume of PDA 
alerts and notifications are controlled 
separately. Use the Alert page of the hp 
profiles application to set the ringing 
volume for the phone. 
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Problem Diagnosis/Remedy 

Unable to send SMS. Messages not addressed to mobile phone. 
When you send SMS messages to contacts 
save in your Pocket Outlook Contacts 
database, be sure to use the number in the 
Mobile field. The contact must be selected 
(highlighted in blue) before it can be sent. 

hp Jornada does not turn 
on or display appears to 
be off, even though power 
is on.  

The display is off. Press the power button 
to turn on the display. 

–or– 

There is not enough light to see the 
display. Turn on lights or move to a room 
with more light. Use hp profiles to increase 
the brightness of the display. Change hp 
profiles to use the light sensor to 
automatically turn on the backlight in dark 
conditions.  

–or– 

The device has been reset. After a reset, 
the screen remains blank for 
approximately three seconds after pressing 
the power button. 

–or– 

hp Jornada has run out of power. Charge 
the device by connecting to ac power 
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Problem Diagnosis/Remedy 

Backup file created with 
the hp backup application 
on another hp handheld 
device cannot be restored 
to the hp Jornada.  

Only PIM data can be migrated to hp 
Jornada 920 series wireless digital 
assistants. Because the hp Jornada 920 
series wireless digital assistant uses a new 
version of the Pocket PC operating system, 
it is recommended that you restore PIM 
data from an older device by using 
Microsoft ActiveSync or Microsoft Outlook 
rather than hp backup. Synchronize your 
older hp handheld device with Microsoft 
Outlook on your desktop PC, and then 
establish a new partnership to transfer 
data to your new hp Jornada.  

Difficult to install or run 
software from previous hp 
handheld.  

Software that runs on previous hp 
handheld devices may not run on your hp 
Jornada 920 series wireless digital 
assistant. Because the hp Jornada 920 
series wireless digital assistant uses a 
different processor and a new version of 
the Pocket PC operating system, software 
built for previous-generation Pocket PCs 
(such as hp Jornada 430, 420, 520, 540, 
560, or 570 series) may not run on the hp 
Jornada 920 series. Check with the 
software vendor for an upgrade or newer 
version that will run on the hp Jornada 
920 series. 

Inaccurate response to 
stylus tap. 

The calibration of the touch screen may be 
off. Realign the touch screen. Press and 
hold the hp home menu hot key to display 
the hp quick menu, and then use the 
navigation pad and action button to 
launch the Align Screen control panel. 
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Problem Diagnosis/Remedy 

Unable to locate files in 
CompactFlash memory in 
applications.  

Files must be stored in the My 
Documents folder on the CompactFlash 
card. Create the My Documents folder 
using File Explorer, and move files into this 
folder. 

Data is lost. hp Jornada has run out of power. Restore 
data from a backup file on your desktop 
PC or a CompactFlash card.  

–or– 

Factory default settings have been 
restored. Restore data from a backup file 
on your desktop PC or a CompactFlash 
card.  

 

remote connections 
This section offers troubleshooting help for connecting your hp Jornada to 
other computers. For problems communicating with your desktop PC, see 
ActiveSync Help.  

able to dial out, but unable to make proper 
connection 
Make sure the network to which you are trying to connect supports Point-to-
Point Protocol (PPP). Your Internet service provider or network administrator 
can verify this. 

Verify that the dialing location is correct. On the Start menu, tap 
Settings, and then on the Connections tab, tap Connections. On the 
Dialing Locations tab, select the location you are dialing from and 
confirm that the settings are appropriate for that location. 
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GPRS connection is unreliable 
• GPRS connection not established. Make sure to have a GPRS 

connection before you begin downloading. 
• GPRS connection dropped. If you make a call while connected to 

GPRS, the connection is dropped when the other party answers the 
call. You must manually re-connect GPRS. 

unable to use infrared transfer between windows-
powered devices 
If you are unable to use infrared to transfer information between Windows-
powered devices, try the following: 

• transfer only one file, or no more than 25 contact cards, at a time. 
• position the infrared ports so that they line up and are less than 

one meter (three feet) but more than five centimeters (two inches) 
apart. 

• make sure nothing is between the two infrared ports.  
• adjust the room lighting. Some types of light interfere with infrared 

communication. Try moving to a different location or turning off some 
lights. 

 

 The hp Jornada 920 series do not support raw IR. 
 

 

network connection problems 
The following solutions may help if you encounter problems when using a 
network card for network connections. Additional troubleshooting 
information is available in Connections Help on the device and ActiveSync 
Help on the desktop PC.  

• verify that your NIC is compatible with the hp Jornada 920 series 
wireless digital assistant and that you have installed the proper drivers 
for the hp Jornada. 
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• in the properties for your network adapter, ensure that you have 
properly configured the IP settings, and the addresses of your DNS 
servers and/or WINS servers. Check with your network administrator 
to determine the proper settings. 

• verify that you have added necessary server information. On the Start 
menu, tap Settings. On the Connections tab, tap Network. Tap 
your installed adapter (usually your Ethernet card's name) and enter 
any necessary information. Most networks use DHCP to assign IP 
addresses dynamically; you should not have to change or enter an IP 
address settings unless your network administrator instructs you to do 
so. 

• if Network Connection is not listed as a connection method in the 
ActiveSync dialog box when starting synchronization, wait a few 
minutes and try again. Also, if synchronization does not start right 
away, the network is probably busy, and it may take a minute for your 
device to connect to the network.  

• verify with your network administrator that your user name and 
password are correct. 

• verify with your network administrator that the network you are trying 
to connect to is available, or try to connect to it from another 
computer.  

• you may need to change the device name if you are trying to connect 
to a network and cannot because another device with the same name 
is already connected. To change the device name, on the Start menu, 
tap Settings. On the System tab, tap About, and then tap the 
Device ID tab. 

 

cradle connection problems 
If you are having trouble connecting to your desktop PC using the USB 
cradle, try these possible solutions. For additional, up-to-date 
troubleshooting information, refer to ActiveSync Help on your desktop PC 
or to the Microsoft Mobile Devices Web site at 
www.microsoft.com/mobile/pocketpc.  
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• ensure you have installed the correct version of ActiveSync on your 
desktop PC. Install the version ActiveSync included with your hp 
Jornada 920 series wireless digital assistant.  

• ensure that your hp Jornada is on. 
• ensure that you do not have any other active connections. On the 

Start menu, tap Today. Tap  at the bottom of the screen, and then 
tap Disconnect. 

• ensure the cable is securely plugged into the USB port on the back of 
your desktop PC. Connect the USB cable directly to your desktop PC—
do not run the cable through a USB hub. 

• enable the USB connection on your hp Jornada. On the Start menu, 
tap ActiveSync. On the Tools menu, Options. Under Enable 
synchronization when cradled using, select USB connection 
from the drop-down list. 

• ensure the USB connection is enabled in ActiveSync on your desktop 
PC. Refer to ActiveSync Help on your desktop computer. If the USB 
connection is already enabled, disable the USB connection, close the 
Connection Settings window, and then reopen and re-enable the USB 
connection.  

• reset your hp Jornada before putting it in the cradle to connect. For 
more information, see “resetting your hp Jornada,” earlier in this 
chapter. 

• always disconnect your hp Jornada before you restart your desktop 
PC.  

• connect only one Pocket PC or wireless/personal digital assistant to 
your desktop PC at a time.  

display problems 
If you are having trouble viewing data on your hp Jornada screen, follow 
these suggestions. 

screen is blank 
Follow these steps if the screen remains dark or if the device does not 
respond when you briefly press the power button: 
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• press the power button to ensure that the display is on. 
• reset the device. After a reset, the screen remains blank for 

approximately three seconds after pressing the power button.  
• charge the device by connecting to ac power. 

display is difficult to see in dark rooms 
Use hp profiles to adjust the display brightness for optimal viewing. (See 
“display and alert profiles” in chapter 4.) In very bright light, select the 
Outdoor profile in hp profiles. In very dark conditions, apply the Low 
Power profile. In a dark room, you may also need to turn on the backlight 
or position a lamp so that the light shines directly on the screen. Use hp 
profiles to set the backlight to come on automatically in dark conditions. 

screen is difficult to read 
If you are having a hard time viewing a document in Notes, try changing 
the size of the view. To do this, tap a zoom percentage on the Tools 
menu. In Pocket Word and Pocket Excel, on the View menu, tap Zoom 
and then select a zoom percentage. In Pocket Internet Explorer, on the 
View menu, tap Text Size and then select a size. 

phone problems 

bad reception, or calls are dropped 
The phone sends and receives radio signals. As with all radio equipment, 
the quality of your reception depends on the strength of the signal in the 
area where you are using the phone. Signal strength will vary depending 
on your surroundings and your location relative to your GSM/GPRS 
service provider’s antenna relay. 

The  icon in the phone display indicates the signal strength. The  
icon indicates that the phone is not receiving a signal. To improve signal 
strength and improve reception, try these steps: 

• if you are in a building, move near a window, or go outside. 
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• if you are in a reinforced structure, such as an elevator or parking 
garage, wait until you are outside to try your call. 

• lift the antenna. 
 

sim card not detected 

 
If you receive an error message indicating that your SIM card is invalid, 
ensure that you have installed the SIM card correctly. Check the orientation 
of the SIM card, and be sure to lock the SIM card slot before re-installing 
the removable battery. If you see this message when the SIM card is 
installed properly, the SIM card may be faulty. Contact your GSM service 
provider for more information. 
 

cannot turn on phone, but can use pda functions 
• ensure that the removable battery is properly installed.  
• check battery power. If total battery power (both embedded and 

removable batteries) is low, or if the embedded battery is empty, you 
cannot use phone functions. 

• Reset your hp Jornada. For more information, see “resetting your hp 
Jornada” earlier in this chapter. 

• if you receive an error message indicating that your SIM card is 
invalid, ensure that you have installed the SIM card correctly. Check 
the orientation of the SIM card, and be sure to lock the SIM card slot 
before re-installing the removable battery. 

 





 
 

 

7 | support and service 

web site  
You can obtain product information as well as tips and hints on how to get 
more from the hp Jornada product at our Worldwide Web site. This 
service is provided free of charge; you pay only for telephone charges and 
Internet service fees. To connect to this Web site from a computer via the 
Internet, go to www.hp.com.  

customer support  
To ensure a fast response to your technical support questions, you should 
first contact your service provider or point of sale. If you have questions 
that the user’s guide or the Web site does not answer (after checking the 
contents and index), you can contact Hewlett-Packard Worldwide Support 
and Services for Handheld Products at the telephone numbers listed in the 
following table.  

If the device requires service, contact Hewlett-Packard for service 
information, shipping instructions, and out-of-warranty service charges 
before you send your device to hp for repair. In countries not listed in the 
table, contact the Hewlett-Packard authorized dealer or sales office.  

service  
For diagnostic instructions and other service information, contact one of the 
technical support numbers listed. Please do not ship your device for service 
without first contacting a Hewlett-Packard office. If your device qualifies for 
in-warranty service, be ready to supply a dated proof of purchase. In 
countries not listed in the following table, contact the Hewlett-Packard 
authorized dealer or sales office.  

Before you contact us for help, be sure to:  

1. Review the manuals whenever possible.  
2. Have the following information about the product:  

• model number  
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• serial number  
• purchase date  

3. Have your product ready to use. The support personnel may ask 
you to run tests and other operations.  

4. Organize your question or problem. The more detailed 
information you can provide, the quicker the support personnel 
can help you.  

 

contacting hewlett-packard 
worldwide  
You will be pleased to know that our commitment to quality does not stop 
at the sale. Our worldwide customer support network is available to give 
you personal telephone service should you need it.  

Country/Region   Telephone  

Algeria 213 (0)61 56 45 43 

Argentina 
Buenos Aires  
All other cities 

   
54-11-4778-8380 
54-0810-555-5520  

Australia  61-3-88778000  

Austria  43 (0)810 00 6080  

Bahrain 800 728 

Belgium (Dutch) 32-(0)2-6268806  

Belgium (French) 32-(0)2-6268807  

Brazil  
Sao Paulo 
All other cities 

 
55-11-3747-7799 
55-0800-157751 

Canada  1-905-2064663 
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Country/Region   Telephone  

Algeria 213 (0)61 56 45 43 

Chile  56-800-360999  

China  86-(0)10-65645959  

Czech Republic 42 (0)2 61 30 7310 

Denmark  45 39 294099  

Egypt 02 532 5222 

Finland  358-(0)20347288  

France  0836696022  
(€ 0.34/min)  

Germany  49-(0)1-805258143  

Greece  30 10 6073603 

Hong Kong  852-300-28555  

Hungary  36 (0)1 382 1111 

India  91-11-6826035  

Indonesia  62-21-3503408  

Ireland  353-(0)1-6625525  

Israel  972 (0)9 9524848 

Italy  39 02 26410350 

Japan  81-0570-000511  

Korea  
Seoul 
All other cities 

 
82-(0)2-32700700  
82-080-9990700 

Malaysia  60-(0)3-2952566  
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Country/Region   Telephone  

Algeria 213 (0)61 56 45 43 

Mexico  
Mexico City 
All other cities 

 
52-58-9922 
01-800-4726684 

Morocco 212 22404747 

Netherlands  31-(0)20-6068751  

New Zealand  64-(0)9-3566640 

Norway  47-22-116299  

Philippines  66-2-8673551  

Poland  48 22 8659800 

Portugal  351 21 3176333 

Romania 
Inside 
Outside 

 
01 315 44 42 
40 1 315 44 42 

Russian Federation 
Moscow 
St. Petersburg 

 
7 095 797 3520 
7 812 346 7997 

Saudi Arabia 800 897 14440 

Singapore  65-62725300  

Slovakia 421 2 68208080 

South Africa 
Inside  
Outside 

 
086 000 1030 
27 11 258 9301 

Spain  34 902 321 123 

Sweden  46-(0)8-6192170  
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Country/Region   Telephone  

Algeria 213 (0)61 56 45 43 

Switzerland  41-(0)-848-801111 

Taiwan  886-2-27170055  

Thailand  66-2-3539000  

Tunisia 216 1 891 222 

Turkey  216 1 891 222 

UK  44-870-608-3003  

Ukraine 7 (380 44) 490 3520 

United Arab Emirates 971 4 883 8454 

USA 208-323-2551 

Venezuela  

Caracas 

All other cities 

 

2-207-8488 

58-800-10111 

Vietnam 84-88234530 

Please visit www.hp.com/cposupport/loc/regional.html for updated 
telephone numbers and to access the hp customer care website in your 
local language. All Customer Care Centers are available during office 
hours. Pre-sales Information in the USA is available 24 hours per day, 7 
days per week. Support & Service in the USA can be contacted from 5 am 
to 5 pm Pacific Time, Monday through Friday. 

The information in this document and applicable conditions for hp phone 
support are subject to change without notice. Please check for the latest 
information and conditions on the Website indicated in this document. 

  





 
 

 

warranty 

Important: This is your hardware product warranty statement. Read it 
carefully.  

Warranty terms may be different in your country. If so, your authorized hp 
dealer or Hewlett-Packard sales and service office can give you details. 

one year limited hardware 
warranty 
Hewlett-Packard (hp) warrants this hardware product against defects in 
material and workmanship for a period of one year from receipt by the 
original end-user purchaser. 

If hp receives notice of the above-defined defects during the warranty 
period, hp will either, at its option, repair or replace products that prove to 
be defective. 

Should hp be unable to repair or replace the product within a reasonable 
amount of time, the customer's alternate exclusive remedy shall be a refund 
of the purchase price upon return of the product. 

limitation of warranty 
The above warranty shall not apply to defects resulting from: misuse; 
unauthorized modification; opening for any reason; operation or storage 
outside the environmental specifications for the product; in-transit damage; 
improper maintenance; or defect resulting from use of non-hp software, 
accessories, media, supplies, consumables, or such items not designed for 
use with the product. 

hp makes no other express warranty, whether written or oral, with respect 
to this product. 

Any implied warranty of merchantability or fitness for a particular purpose 
is limited to the one-year duration of this written warranty.  
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Some states, provinces, or countries do not allow limitations on how long 
an implied warranty lasts, so the above limitation or exclusion may not 
apply to you. 

This warranty gives you specific legal rights, and you may also have other 
rights that vary from state to state, province to province, or country to 
country. 

no warranty of data or backup files  
hp makes no warranty, express or implied, and no claim of responsibility 
or liability for end user data integrity or the integrity of backup files. It is 
the full responsibility of the end user to ensure data integrity, backup file 
integrity, and correct and successful backup procedures. hp makes no 
warranties or claims, express or implied relating to restoring or recovering 
end-user data. 

limitation of liability and remedies 
The remedies provided above are the customer's sole and exclusive 
remedies. 

In no event shall hp be liable for any direct, indirect, special, incidental, or 
consequential damages (including lost profit), whether based on warranty, 
contract, tort, or any other legal theory.  

Some states, provinces, or countries do not allow the exclusion or limitation 
of incidental or consequential damages—including lost profit—so the 
above limitation or exclusion may not apply to you. 

consumer transactions in australia, new zealand, 
and the united kingdom  
The preceding disclaimers and limitations shall not apply to consumer 
transactions in Australia, New Zealand and the United Kingdom, and shall 
not affect the statutory rights of consumers.  
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for consumers in australia  
The above warranty terms and any other warranty statement enclosed with 
this product, except to the extent lawfully permitted, do not exclude, 
restrict, or modify and are in addition to the statutory rights implied by the 
Trade Practices Act 1974 or any corresponding State or territory 
legislation applicable to the sale of this product to you. If you have any 
queries about your rights, contact the Hewlett-Packard Customer Care 
Center at 61-3-88778000.  

for consumers in new zealand  
The above warranty terms or any other warranty statement enclosed with 
this product, except to the extent lawfully permitted, do not exclude, restrict 
or modify and are in addition to the statutory rights implied by the 
Consumer Guarantees Act 1993 applicable to the sale of this product to 
you. If you have any queries about your rights contact the Hewlett-Packard 
End User Support line at 0800-733547. 

hp software product license 
agreement and hp software 
product limited warranty 
This hp product contains preinstalled software programs. Please read the 
hp Software Product License Agreement before proceeding.  

Important: Carefully read this License Agreement and the Limited 
Warranty statement before operating the equipment. The rights to the 
software are licensed, not sold. hp or its licensors continue to own all 
intellectual property rights to the software, and you will be granted certain 
rights to use the software upon your acceptance of this license. Rights in 
the software are offered only on the condition that you agree to all terms 
and conditions of the License Agreement. Operating the equipment 
indicates your acceptance of these terms and conditions. If you do not 
agree to the terms and conditions of the License Agreement, return the 
complete package for a full refund now. 
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hp software product license agreement 
The hp Software Product License Agreement shall govern the use of all 
software that is provided to you, the customer, as part of this hp product 
with the exception of Microsoft Software. Microsoft Products are licensed 
to you under the Microsoft End User License Agreement (EULA) contained 
in the Microsoft documentation. Any third-party software supplier's 
warranty terms that may be found online, or in any documentation or other 
materials contained in the product packaging, shall govern the use of that 
third-party software. 

The following License Terms govern the use of the software: 

use 
You may only use the software on a single computer. You may not reverse 
engineer, disassemble, or decompile the software. 

Transaction in European Union member states: The prohibition against 
decompilation shall be subject to Directive 91/250/EEC. 

copies and adaptations 
You may make copies or adaptations of the software (a) for archival 
purposes, or (b) when copying or adaptation is an essential step in the use 
of the software with a computer so long as the copies and adaptations are 
used in no other manner.  

You have no other rights to copy unless you acquire an appropriate license 
to reproduce which is available from hp for some software.  

You agree that no warranty, free installation, or free training is provided 
by hp for any copies or adaptations made by you.  

All copies and adaptations of the software must bear the copyright 
notice(s) contained in or on the original.  

ownership 
You agree that you do not have any title to or ownership of the software, 
other than ownership of the physical media. You acknowledge and agree 
that the software is copyrighted and protected under the copyright laws. 
You acknowledge and agree that the software or part thereof may have 
been developed by a third-party software supplier named in the copyright 



warranty | 191 

 

 

notice(s) included with the software, who shall be authorized to hold you 
responsible for any copyright infringement or violation of this or their own 
License Agreement.  

transfer of rights in software 
You may transfer rights to the software to a third party only as part of the 
transfer of all your rights and only if you obtain the prior agreement of the 
third party to be bound by the terms of this License Agreement. Upon such 
a transfer, you agree that your rights to the software are terminated and 
that you will either destroy all your copies and adaptations or deliver them 
to the third party. Transfer to a U.S. government department or agency or 
to a prime or lower tier contractor in connection with a U.S. government 
contract shall be made only upon prior written agreement to terms required 
by hp.  

sublicensing and distribution 
You may not lease, sublicense the software, or distribute copies or 
adaptations of the software to the public in physical media, by 
telecommunication or at all without the prior written consent of hp.  

termination 
hp may terminate this software license for failure to comply with any of 
these terms, provided hp has requested you to cure the failure and you 
have failed to do so within thirty (30) days of such notice.  

updates and upgrades 
You agree that the software does not include updates and upgrades that 
may be available from hp under a separate support agreement. 

export clause 
You agree not to export or re-export the software or any copy or 
adaptation in violation of the U.S. Export Administration regulations or 
other applicable regulations.  
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U.S. government restricted rights  
The Software and Documentation have been developed entirely at private 
expense. They are delivered and licensed as “commercial computer 
software” as defined in DFARS 252.227-7013 (Oct 1988), DFARS 
252.211-7015 (May 1991) or DFARS 252.227- 7014 (Jun 1995), as 
“commercial item” as defined in FAR 2.101 (a), or as “Restricted computer 
software” as defined in FAR 52.227-19 (Jun 1987) (or any equivalent 
agency regulation or contract clause), whichever is applicable. You have 
only those rights provided for such Software and Documentation by the 
applicable FAR or DFARS clause or the hp standard software agreement 
for the product involved. 

hp software product limited warranty 
Important: This hp Software Product Limited Warranty shall cover all 
software that is provided to you, the customer, as part of the hp product, 
including any operating system software. Any third-party software 
supplier's warranty terms that may be found on-line, or in any 
documentation or other materials contained in the product packaging shall 
supersede the hp Software Product Limited Warranty with regard to that 
third-party software. 

ninety-day limited software warranty 
hp warrants for a period of NINETY (90) DAYS from the date of purchase 
that the software product will execute its programming instructions when all 
files are properly installed. hp does not warrant that the software will be 
uninterrupted or error free. In the event that this software product fails to 
execute its programming instructions during the warranty period, your 
remedy shall be replacement or refund only. Return the media to hp for 
replacement. Should hp be unable to replace the media within a 
reasonable amount of time, hp shall refund the purchase price upon return 
of the product and all copies. 

removable media (if supplied) 
hp warrants the removable media, if supplied, upon which this product is 
recorded to be free from defects in material and workmanship under 
normal use for a period of NINETY (90) DAYS from the date of purchase. 
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In the event the media proves to be defective during the warranty period, 
your remedy shall be replacement or refund only. Return the media to hp 
for replacement. Should hp be unable to replace the media within a 
reasonable amount of time, hp shall refund the purchase price upon return 
of the product and destruction of all other non-removable media copies of 
the software product. 

notice of warranty claims 
You must notify hp in writing of any warranty claim not later than thirty 
(30) days after the expiration of the warranty period. 

limitation of warranty 
hp makes no other express warranty, whether written or oral, with respect 
to this product. 

Any implied warranty of merchantability or fitness for a particular purpose 
is limited to the 90-day duration of this written warranty. Some states, 
provinces, or countries do not allow limitations on how long an implied 
warranty lasts, so the above limitation or exclusion may not apply to you. 
This warranty gives specific legal rights, and you may also have other 
rights that vary from state to state, province to province, or country to 
country. 

limitation of liability and remedies 
THE REMEDIES PROVIDED ABOVE ARE YOUR SOLE AND EXCLUSIVE 
REMEDIES. IN NO EVENT SHALL hp BE LIABLE FOR ANY DIRECT, 
INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES 
(INCLUDING LOST PROFIT), WHETHER BASED ON WARRANTY, 
CONTRACT, TORT, OR ANY OTHER LEGAL THEORY. Some states, 
provinces, or countries do not allow the exclusion or limitation of incidental 
or consequential damages—including lost profit—so the above limitation 
or exclusion may not apply to you. 

In no case shall hp's liability exceed the purchase price for the software 
and/or product. The limitations set forth above will apply regardless of 
whether you accept the software. 
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Consumer transactions in Australia and the United Kingdom: The 
disclaimers and limitations above shall not apply and shall not affect the 
statutory rights of a Consumer.



 
 

 

glossary  

AC adapter. An external power supply that converts ac power from a 
standard household electrical outlet to the low-voltage dc power required 
to operate your hp Jornada. 

Backup. A duplicate copy of your hp Jornada files and data that is stored 
on your desktop PC or on a CompactFlash card. 

Cell broadcast. A wireless data services that transmits text-based 
information, such as news, stock updates, and weather reports to phones 
on a GSM network. 

CompactFlash. A removable media for high-performance memory cards 
and other accessories such as modems and NICs. 

Cradle. A desktop base for your hp Jornada that allows instant 
connectivity to a desktop PC. The cradle remains connected to your 
desktop PC, even when you remove your hp Jornada. 

DHCP (Dynamic Host Configuration Protocol). A protocol that 
assigns a dynamic IP address to your hp Jornada each time you connect to 
a network. 

Dial-up connection. A connection between your hp Jornada and 
another computer by modem. You can have a dial-up connection with an 
ISP, a network, or with a modem attached to a PC. 

Direct connection. A connection between your hp Jornada and another 
computer by means of the cradle or infrared port.  

DNS (Domain Name System). An Internet service that translates 
domain names into IP addresses. For example, the domain name 
www.jornada.com might translate as 198.125.247.4. 

Driver. A control program that enables a computer to work with a 
specific peripheral device. 

Flash ROM. See ROM. 

GPRS (General Packet Radio Service). A packet-based wireless 
data service that enables mobile phones, computers, and PDAs to connect 
to the Internet. 
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GSM (Global System for Mobile communication). A digital 
mobile telephone system that is widely used in Europe and other parts of 
the world. 

IMAP4 (Internet Messaging Access Protocol v4). A protocol that 
enables a computer to retrieve messages from a mail server. 

Infrared port. A communication port that uses optical (infrared) signals 
rather than wires or cables to transmit data.  

Internet. A worldwide network of computers offering services such as e-
mail, the Worldwide Web, FTP, Usenet news, and others. 

Intranet. A network that offers services similar to the Internet, but usually 
accessible only to users within a single company or organization. 

IP (Internet Protocol). The standard by which packets of information 
are transmitted over the Internet.  

IrDA (Infrared Data Association protocol). An established standard 
for infrared communications between computers and other peripherals and 
devices. 

ISP (Internet service provider). A commercial business that provides 
Internet access to individuals or businesses, usually for a fee. 

Java™. A high-level programming language used to create small 
applications that can be downloaded over the Web. 

LAN (local area network). A group of computers, usually in close 
proximity (either in the same building or in buildings in close proximity), 
that are linked together to share files and exchange data. 

MIDlet. A Java™ application that conforms to the MIDP standard. 

MIDP (Mobile Information Device Profile). A set of Java 
programming interfaces that define how applications work with phones 
and other mobile devices. 

Modem. A communication device that enables a computer to transmit 
data over telephone lines. 

NIC (network interface card). A card installed in a computer so that 
it can be connected to a network. NICs can provide a dedicated, full-time 
connection to a network. 

Partnership. An established relationship between your hp Jornada and 
your desktop PC for the purpose of synchronizing and transferring data.  
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PDA (personal digital assistant). A handheld device that combines 
computer, telephone, personal information manager, and networking 
features. 

PIM (personal information manager). An application or set of 
applications that organizes information such as addresses, appointments, 
and notes. 

POP3 (Post Office Protocol v3). A protocol that enables a computer 
to retrieve messages from a mail server. 

PPP (Point-to-Point Protocol). The default method your hp Jornada 
uses to communicate with an ISP or network server. 

Proxy server. A server that sits between a client computer or Web 
browser and the Internet. A proxy server provides security by filtering 
requests and can improve performance by storing local copies of 
requested information. 

RAM (random access memory). Volatile memory that can be read 
and written. Data stored in RAM is retained only while power is 
maintained.  

Remote connection. A connection between your hp Jornada and a 
remote computer or server. 

Reset. The process of restarting your hp Jornada and reinitializing the 
operating system. Performing a reset erases any unsaved data in open 
documents, but preserves data that has been saved. 

Restore. To return your device to the state it was in when data was last 
backed up. This involves copying your backup data to your hp Jornada. 

ROM (read-only memory). Nonvolatile flash memory that contains the 
Microsoft Windows for Pocket PC operating system and preinstalled 
programs. 

Serial connection. A cable connection between your hp Jornada and a 
serial (COM) port on your desktop PC. 

SIM (subscriber information module) card. A card supplied by a 
GSM/GPRS service provider that contains a mobile phone number, 
information about account services, and other information that identifies a 
mobile device to the mobile phone network. 

SLIP (Serial Line Internet Protocol). A method of connecting to the 
Internet. Similar to PPP, but older and simpler.  
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SMS (Short Message Service). A service for sending short text 
messages to mobile phones.  

SMTP (Simplified Mail Transport Protocol). A protocol for sending 
e-mail messages between computers on the Internet.  

Stylus. A pen-like utensil designed for navigating on a touch screen. 

Synchronization. The process of comparing the files or data on two 
computers to ensure that they contain exactly the same information.  

Touch screen. A touch-sensitive screen that allows you to open files, 
launch programs, and select text by touching or tapping the screen with 
the stylus. 

USB (Universal Serial Bus). A newer standard for connecting 
peripheral devices. USB supports relatively fast data transfer rates and can 
be used to connect multiple devices to a single computer. 

Virtual machine. A self-contained computer environment that allows 
Java applications to run without interacting with the Pocket PC operating 
system. 

VPN (virtual private network). A network that is constructed by 
using the Internet to connect nodes. VPNs typically include security to 
ensure that only authorized users can access the network. 

WAP (Wireless Application Protocol). A secure specification that 
allows handheld wireless devices to access information over the Internet.  

WDA (wireless digital assistant). A personal digital assistant (PDA) 
that includes wireless voice and/or data functions.  

WML (Wireless Markup Language). A markup language used to 
specify content and user interface for WAP devices.  



 
 

 

appendix:  
phone safety 

driving 
Do no use your hp Jornada wireless digital assistant while driving a 
vehicle. If you must use your hp Jornada, park the vehicle first.  

Always secure your hp Jornada while driving; do not place your hp 
Jornada on the passenger seat or where it can break loose in a collision or 
sudden stop. 

For vehicles equipped with an airbag, remember that an airbag inflates 
with great force. Do not place your hp Jornada in the area over the airbag 
or in the airbag deployment area.  

Check the laws and regulations on the use of phones in the areas where 
you drive. If you are going to use your phone while driving,  

• give full attention to driving. 

• use a phone headset. Laws in many countries requires the use of a 
hands-free solution when driving a vehicle.  

• pull off the road and park before making or answering a call if driving 
conditions so require. 

 
Radio frequency (RF) energy emitted by your hp Jornada may affect 
electronic systems in your vehicle. For more information, see the following 
section.  

radio interference with electronic 
devices 
Your hp Jornada is a radio transmitter and receiver. When the phone is 
turned on, it receives and transmits RF energy. The system that handles 
your call when you are using your phone controls the power level at which 
your phone transmits. Most modern electronic equipment is shielded from 
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RF signals; however, some electronic equipment may not be shielded 
against the RF signals from your hp Jornada. 

pacemakers  
Pacemaker manufacturers recommend that a minimum separation of 20 cm 
(6 inches) be maintained between a handheld wireless phone and a 
pacemaker to avoid potential interference with the pacemaker. These 
recommendations are consistent with the independent research by and 
recommendations of Wireless Technology Research. Persons with 
pacemakers  

• should always keep the hp Jornada more than 20 cm (6inches) from 
their pacemaker when the phone is on 

• should not carry the hp Jornada in a breast pocket; 

• should use the ear opposite the pacemaker to minimize the potential 
for interference. 

If you have any reason to suspect that interference is taking place, switch 
off the phone functions of your hp Jornada immediately. 

hearing aids 
Some digital wireless phones may interfere with some hearing aids. If you 
experience such interference, you may want to consult your service 
provider. 

other medical devices 
Operation of any radio transmitting equipment, including your hp Jornada, 
may interfere with the functionality of inadequately protected medical 
devices. If you use any other personal medical device, consult a physician 
or the manufacturer of a medical device to determine if it is adequately 
shielded from external RF energy or if you have any questions.  

Turn off the phone functions of your hp Jornada in healthcare facilities 
when any regulations posted in these areas instruct you to do so. Hospitals 
or healthcare facilities may be using equipment that could be sensitive to 
external RF energy. 
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vehicles 
RF signals may affect improperly installed or inadequately shielded 
electronic systems in motor vehicles (for example, electronic fuel injection 
systems, electronic anti-skid/anti-lock braking systems, electronic speed 
control systems, airbag systems, and stereos). Check with your vehicle 
manufacturer’s representative to be sure that your hp Jornada will not 
affect the electronic systems in your vehicle. You should also consult the 
manufacturer of any equipment that has been added to your vehicle. 

operating environment 
Remember to follow any special regulations in force in any area. Always 
turn off the phone functions of your hp Jornada when it is forbidden to use 
it, or when it may cause interference or danger.  

potentially explosive atmospheres 
Turn off the phone functions of your hp Jornada when you are in an area 
with a potentially explosive atmosphere. Obey all signs and instructions. 
Sparks in such areas could cause an explosion or fire resulting in bodily 
injury or even death. 

Switch off the phone when at a refueling point (service station). Observe 
restrictions on the use of radio equipment in fuel depots (fuel storage and 
distribution areas), chemical plants or where blasting operations are in 
progress.  

Areas with a potentially explosive atmosphere are often—but not always—
clearly marked. They include below deck on boats; chemical transfer or 
storage facilities; vehicles using liquefied petroleum gas (such as propane 
or butane); areas where the air contains chemicals or particles, such as 
grain, dust, or metal powders; and any other area where you would 
normally be advised to turn off your vehicle engine. 

vehicles 
Do not store or carry flammable liquids, gases, or explosive materials in 
the same compartment as your hp Jornada, its parts or accessories. 
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aircraft 
Use of wireless telephones in an aircraft may be hazardous to safe aircraft 
operation, disrupt the wireless telephone network, and may be illegal.  
Please follow the instructions of your flight crew regarding the use of your 
hp Jornada on board aircraft. 

blasting areas 
To avoid interfering with blasting operations, turn off the phone functions 
of your hp Jornada when you are in a blasting area or any area posted 
“Turn off two-way radio.” 

emergency calls 
Like any wireless phone, your hp Jornada wireless digital assistant 
operates using radio signals, wireless, and landline networks as well as 
user-programmed functions, which cannot guarantee connection in all 
conditions. Therefore, you should never rely solely upon a wireless phone 
for essential communications (e.g., medical emergencies). 

Remember: to make or receive any calls the phone must be switched on 
and in a service area with adequate signal strength. Emergency calls may 
not be possible on all wireless phone networks or when certain network 
services and/or phone functions are in use. Check with local service 
providers. 

If certain features are in use (call barring, fixed dialing, closed user group, 
system lock, keypad lock, etc.), you may first need to turn those features off 
before you can make an emergency call. Consult this document and your 
GSM/GPRS service provider. 

When making an emergency call, remember to give all the necessary 
information as accurately as possible. Remember that your hp Jornada 
may be the only means of communication at the scene of an accident. Do 
not end the call until given permission to do so. 
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A 
ac adapter, 2, 19, 21–22, 27, 32, 

58, 195 
accessories, 16, 128 

Accessories Guide, 2 
CompactFlash, 27, 116, 128, 170 
hp Pocket Camera, 160, 161 
pocket keyboard, 6 
serial cable or cradle, 57 

action button, 14 
ActiveSync, 2–4, 7, 52–57, 73, 75, 

76, 81, 118, 127, 132, 135, 153, 
167, 174–177 

adding programs. See programs 
alarm, 100, 122, 123 
alert profiles, 6, 11, 13, 40, 120, 122 
alerts, 27, 100, 134, 170 

incoming call, 40 
LED. See LED 

aligning touch screen, 6, 13, 19, 92, 
173 

answering a call, 11, 40 
antenna, 35 
appointments 

adding notes to, 134 
alarm for, 100 
changing, 134 
creating, 133 
reminders, 134 
Summary Screen, 134 

audio files 
formats, 150 
playing, 150, 170 
ripping, 151 
secured content (UUID), 152 

auto cover, 2, 11, 34 
removing, 14 
settings, 15, 23, 25, 34 

AvantGo, 73 

B 
backing up data 

about hp backup, 5 
to CompactFlash card, 118 
to desktop PC, 56 
using ActiveSync, 56, 118, 169 
using hp backup, 56, 117, 118, 

169 
backup file, 56, 118, 173, 195 
batteries 

about, 20 
charging, 20, 21, 22, 57, 128, 

170, 171 
embedded, 2, 20 
expected life, 20 
removable, 1, 2, 10, 18, 20, 179 
status, 22, 24 
warnings, 21 

Block Recognizer, 101, 102 
books online. See Reader 
browser 

WAP. See EzWAP 
Web. See Pocket Internet Explorer 

browsing 
the Web, 69 
WAP sites, 88 

buttons. See hardware buttons 

C 
calculator. See Calendar 

about, 7, 132, 136 
adding notes to, 134 
alarm for, 100 
backing up, 5, 118 
creating an appointment, 133 
customizing display of, 133 
hot key, 13, 120 
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meeting requests, 135 
Summary Screen, 134 
synchronizing, 53 

call barring, 46 
call forwarding, 45 
call log, 44 
call waiting, 45 
caller ID, 45 
calls 

answering, 11, 40 
deferred answering, 40 
ending, 11, 36 
making, 34, 35, 36 

cell broadcast, 7, 60, 61 
Character Recognizer, 147 
chat. See MSN Messenger 
closing programs. See programs 
CodeWallet Pro, 8, 131, 166 
Command bar, 97 
CompactFlash card 

about, 117, 128, 195 
for backup, 5, 56, 118, 119, 169 
installing, 129 
memory, 116–118, 169, 174 
power usage, 27, 170 
slot, 129 
storing audio files, 152 

connecting 
by infrared, 59 
by LAN, 54 
by USB cradle, 57 
to a network, 63, 175 
to desktop PC, 57, 59 
to Internet, 63 

contacting hp, 182 
Contacts 

about, 7, 132, 139 
adding notes to, 141 
backing up, 5, 118 
categorizing, 140 
copying from SIM card, 30, 43 
creating, 140 
customizing display of, 139 
dialing a call, 43 

finding, 141 
hot key, 13, 122 
Summary Screen, 141 
synchronizing, 53 
viewing, 141 

converting files, 55 
cover, 192, See auto cover 
cradle. See USB cradle 
customer service. See technical support 

D 
dc jack, 58 
deferred answer, 40 
DHCP protocol, 195 
dial-up connection, 195 
direct connection, 195 
display 

backlight, 6, 14, 26, 121, 172, 
178 

brightness, 6, 178 
cleaning, 16 
radiated interference, 16 
touch screen, 6, 13, 92, 173 
troubleshooting, 172, 177 
turning off, 13, 26, 150 
turning on, 14, 26 

display profiles, 5, 13, 120 
DNS, 195 
drawings 

adding to book text, 156 
creating, 108 
resizing, 109 
selecting, 109 
zooming, 109 

drivers. See software drivers 

E 
eBooks. See Reader 
e-mail 

adding recordings to, 110 
configuring services, 75 
folder behavior, 81, 82 
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reading messages, 78 
receiving attachments, 78 
sending, 74 
synchronizing, 53, 74 

embedded battery. See batteries, 
embedded 

EMusic.com, 151 
End button, 11, 23, 31 
Exchange, 55, 132, 157 
EzWAP, 8, 88 

F 
factory default settings, 169 
File Explorer, 114, 126, 128, 174 
files 

converting, 55 
transferring, 55 

Find feature, 114 
Flash ROM, 5, 197 
Fonix Voice Dial, 8, 12, 37 

G 
GPRS, 6, 30, 40, 60, 63, 66 

configuring, 66 
connecting to network, 68 

GSM, 4, 30, 47, 60, 63, 83, 126, 
197 
audio file format, 112 
closing a connection, 65 
data connection, 63, 64, 75 
dialing a connection, 65 
service provider, 17, 23, 30, 42, 

45, 60, 83 

H 
hardware buttons 

about, 10 
configuring, 123 

headset, 34, 199 
hp backup. See backing up data 
hp Dialer, 42 

hp home menu, 5, 94, 124, 125 
hp home menu hot key, 13, 94 
hp hot keys, 12, 13, 23, 25, 123 
hp image viewer 

about, 5, 131 
adding comments to images, 165 
adding images to a document, 165 
adding recordings to an image, 

162 
Browse mode, 161, 162 
changing folders, 160 
file formats, 160 
sending images, 164, 165 
Slideshow mode, 163 
starting, 160 
View mode, 163 

hp Jornada 
caring for, 16 
hardware features, 9 
package contents, 2 
registering, 16 
turning off, 22 
turning on, 22 
warranty, 187 

hp Jornada user’s guide online version, 
4 

hp MicroChaiVM, 6, 51, 83 
hp month view, 5, 136 
hp Pocket Camera, 6, 160, 161 
hp pocket keyboard, 6 
hp profiles, 27, 120, 122, 178 

power preferences, 25 
hp quick menu, 6, 13, 34, 150 
hp settings, 120, 172 
hp task switcher, 6, 13, 94, 95, 116, 

117, 118, 119, 168, 171 

I,J,K 
images. See hp image viewer 
IMAP4 protocol, 64, 75, 82, 196 
Inbox, 118 

about, 7 
My Text, 113 
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synchronizing, 53 
Inbox hot key, 13 
infrared port, 27, 52, 54, 55, 57, 59, 

139, 164, 165, 175, 196 
Input panel, 101, 147 
installing programs. See programs 
instant messages. See MSN Messenger 
interference, radiated, 16 
Internet, 196 

Pocket Internet Explorer, 69 
Web browsing, 69 

intranet, 69, 196 
IP protocol, 196 
IrDA protocol, 59, 196 
ISP, 196 

L 
LAN, 57, 196 
LED, 11, 27 

blinking blue, 11, 100 
steady amber, 11, 22, 110 
steady blue, 11, 22 

Letter Recognizer, 101, 103 
light sensor, 121 
locking your hp Jornada, 48 

M 
mail. See e-mail 
Media Player. See Windows Media 

Player 
meeting requests, 135 
memory 

managing, 116 
program, 115, 116 
storage, 111, 112, 115, 116 

microphone 
headset, 2 

Microsoft Exchange. See Exchange 
Microsoft MSN Messenger. See MSN 

Messenger 
Microsoft Outlook. See Outlook 
Microsoft Passport. See Passport 

Microsoft Phone application, 35 
Microsoft Pocket Excel. See Pocket 

Excel 
Microsoft Pocket Internet Explorer. See 

Pocket Internet Explorer 
Microsoft Pocket Outlook. See Pocket 

Outlook, Calendar, Contacts, Notes, 
Tasks, Inbox 

Microsoft Pocket Word. See Pocket 
Word 

Microsoft Reader. See Reader 
MIDlet, 83 

deleting, 87 
exiting, 87 
installing, 84 
launching, 86 

mobile favorites, 72 
viewing, 53 

modem, 196 
MP3 files, 8, 150, 152 
MSN Messenger 

about, 7, 157 
blocking contacts, 159 
chatting, 159 
contacts, 158 
My Text, 113 
setup, 157 
starting, 157 

MusicMatch JukeBox, 151 
My Text, 113 

N,O 
Navigation bar, 97 
navigation pad, 14 
network. See LAN 
network interface card, 175, 196 
Notes 

about, 7, 132, 146 
adding to books, 156 
creating, 146 
drawing, 108 
inputting text, 101 
recording, 110 
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writing on-screen, 104 
zooming, 178 

notification icon, 99 
notifications. See alerts 
online chat. See MSN Messenger 
online Help, 2, 3, 4, 131, 166 
Outlook, 2, 53, 55, 81, 132, 135 
owner information, 123 

P 
partnership, 52, 54, 56, 169, 173, 

196 
Passport, 157 
password, 48, 64, 123, 149, 169, 

176 
phone, 23, 32 

PCM file format, 111 
personal identification number 

for phone SIM, 23, 32 
phone 

answering a call, 11, 40 
antenna, 35 
call barring, 46 
call forwarding, 45 
call log, 44 
call waiting, 45 
caller ID, 45 
deferred answering, 40 
display, 49 
ending a call, 11, 36 
handheld mode, 34 
hands-free mode, 34, 199 
hp Dialer, 42 
making a call, 34, 35, 36 
ring options, 46 
settings, 46 
speakerphone mode, 34 
speed dial, 36, 44 
turning off, 11, 23, 31 
turning on, 11, 23, 31 
voice dial, 37 
voice mail, 40 

Phone Display, 49 
phone safety, 34, 199 
pictures. See hp image viewer 
PIM (personal information manager), 

5, 54, 55, 56, 118, 119, 173, 
197 

Pocket Excel 
about, 7, 131, 149 
customizing display of, 150 
file formats, 149 
opening spreadsheets, 149 
passwords, 149 
starting, 149 
synchronizing, 149 
templates, 149 
zooming, 149, 178 

Pocket Internet Explorer, 7, 69, 127, 
178 

Pocket Outlook, 1, 53, 132, 135 
Pocket Outlook Inbox, 13 
Pocket PC Companion CD, 2, 3, 52, 

126, 153, 166 
Pocket Word 

about, 7, 131, 147 
drawing mode, 148 
file formats, 147 
opening documents, 147 
recording mode, 148 
starting, 147 
synchronizing, 147 
templates, 147 
typing mode, 147 
writing mode, 148 
zooming, 148, 178 

POP3 protocol, 64, 75, 82, 197 
pop-up menus, 99 
power 

about, 20 
ac adapter, 22, 27, 32 
checking remaining, 24 
conserving, 25, 26, 150 
loss of, 5, 20, 118 
low power indicator, 95 
Power control panel, 23, 25 
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turning PDA on or off, 14, 22, 23, 
27 

power button, 14, 22, 23, 26, 27, 
172, 177, 178 

Power preferences, 25 
PPP protocol, 174, 197 
profiles 

alert, 6, 11, 13, 40, 120, 122 
display, 5, 13, 120 
Loud, 122 
Low Power, 178 
Meeting, 122 
Outdoor, 178 

program memory, 115, 116 
programs 

adding to Start menu, 125 
additional, 8 
closing, 116, 117 
from hp, 5 
from Microsoft, 7 
from third parties, 8, 131 
help for, 4 
installing, 3, 8, 84, 126, 127, 173 
Java, 83 
MIDlets, 83 
preinstalled, 5 
removing, 5, 116, 127 
switching, 94, 95, 97 

proxy server, 197 

R 
radiated interference, 16 
RAM, 197 
Reader 

about, 153 
adding drawings to text, 156 
adding notes to text, 156 
annotations, 156 
bookmarks, 156 
copying text, 156 
getting books for, 153 
Guidebook, 153 
highlighting text, 156 

Library, 154 
removing a book, 156 
searching for text, 156 
secured content (UUID), 153 
starting, 153 

record button, 12, 25, 123 
recording 

about, 110 
adding to a note, 110 
adding to an e-mail message, 110 
adding to images, 162 
creating, 110 
file formats, 111, 112 
in Pocket Word, 148 
playing back, 110 
starting, 12 
status indicator, 110 
stopping, 12 

removable battery. See batteries, 
removable, See batteries:removable 

removing programs. See programs 
reset button, 168 
resetting, 168, 171, 172, 178, 197 
restoring data, 52, 56, 118, 119, 

120, 168, 169, 173, 174, 197 
restoring factory defaults, 118, 169, 

174 

S 
safety information, 34, 199 
screen protector, 16 
security, 48 
Send button, 11 
serial connector, 55 
short message service, 46, 51, 61, 

74, 79 
delivery notification, 80 
locking device remotely, 48 

SIM card, 1, 23, 30, 31, 47, 179, 
197 
copying contacts from, 30, 43 
installing, 17 
locking or unlocking, 23, 32 
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PIN, 47 
status, 32 

SLIP protocol, 197 
SMS. See short message service 
SMTP protocol, 198 
soft keyboard, 101, 103, 147 
software drivers 

about, 195 
infrared, 59 
NIC, 175 
portable keyboard, 6 

Software License Agreement, 190 
sounds 

alert profile, 120 
alert profiles, 122 
choosing, 100 
turning off, 27 

speakerphone, 34 
speed dial, 11, 35, 36, 42, 43, 44, 

120 
Start menu, 95, 125 
status icons, 99 

batteries, 21 
phone, 32, 33 

stereo headset, 2 
storage memory, 73, 111, 112, 115, 

116, 127, 152 
streaming media, 152 
suspend, 27 
switching programs. See programs 
synchronizing 

about, 7, 52, 53, 132, 198 
e-mail messages, 53, 74 
Excel files, 52, 149 
from a remote location, 54, 55 
help for, 3 
mobile favorites, 53 
Outlook, 53 
schedule, 53 
starting, 53 
troubleshooting, 176 
Word files, 52, 147 

T 
Tasks 

about, 7, 132 
adding notes to, 144 
alarm for, 100 
backing up, 5, 118 
categorizing, 144 
changing, 145 
creating, 144 
customizing display of, 143 
due date, 144 
start date, 144 
Summary Screen, 145 
synchronizing, 53 

technical support, 181 
temperature, operating, 16 
templates 

Pocket Excel, 149 
Pocket Word, 147 

Today screen, 4, 25, 93, 99, 123 
to-do list. See Tasks 
touch screen 

aligning, 6, 13, 19, 92, 173 
touch screen  See also display, 198 
Transcriber, 101, 103 
transferring files, 55 
troubleshooting, 167 

basic problems, 170 
connections, 4 
display, 177 
infrared, 175 
network connections, 175 
remote connections, 174 
USB cradle, 176 

U,V,W 
USB, 56–58, 177, 198 
USB cradle, 2, 21, 52, 54–58, 195 
videos, 150 
viewing images 

at actual size, 163 
in a slideshow, 163 
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in hp image viewer, 160 
voice dialing. See Fonix Voice Dial 
voice mail, 40, 46 
voice notes. See recording 
volume/scroll control, 12 
warranty 

software, 189 
WAV files, 148 

Welcome Wizard, 19, 169 
Windows Media Player, 8, 40, 131, 

150 
wireless data. See GSM or GPRS 
WMA files, 8 
WMV files, 8 
writing on the screen, 104 
WWW. See Web 

 
 


